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Note to Instructor

PURPOSE OF THIS BOOKLET

This guide is designed to accompany structured and guided ProFile training as provided by recognized learning institutions. It
also serves as a companion document to the PowerPoint presentation files to be used by teaching professionals. This
document is, therefore, focused in its scope and it is not intended as a self-study training guide.

CHAPTER COMPOSITION

Tax is all-encompassing. Software cuts a wide swath. Each in its own right can be presented and discussed at a
rudimentary level or all the way up to a granular level that digs deep down into the most arcane of discussions.
Put the two together and the range of discussion increases exponentially. As such, many chapters in this document
introduce features at a basic level or at a more advanced level. The hope is that, depending on your teaching
objectives, this guide will be able to help you meet your requirements.

ADDITIONAL RESOURCES

In addition to this document, Intuit provides numerous resources to accounting professionals. Refer to these sites to explore
additional tutorials and training opportunities:

e http://accountant.intuit.ca/professional-accounting/index.jsp
e http://profile.intuit.ca/professional-tax-software/index.jsp
e  http://profile.intuit.ca/professional-tax-software/training.jsp




Introduction

Intuit ProFile Tax software is reliable and easy-to-use, and it offers sophisticated features that help tax preparers
experience a more productive tax season. The following paragraphs summarize the key components of Intuit
ProFile Professional Tax software

ProFile T1 imports and converts data created by competing software products. Whether you carry files forward
individually or in batches, you will find the process quick and convenient. Using ProFile’s WYSIWYG (what you
see is what you get) forms, you can view and edit federal T1 and Québec TP1 forms in either French or English.
You can also print all tax forms in either language at the click of a button.

ProFile T2 is designed for professional preparation of corporate tax returns in all provinces and territories. ProFile
T2 includes:
e Federal T2 returns, including T2 RSI (for 2006-2009 and earlier) and Corporation Internet Filing
e Provincial corporate tax returns for Alberta (including AT1 RSI), for Ontario returns with taxation
years ending prior to January 1, 2009 (including CT23 disk filing) and for Quebec (CO-17).
e Provincial capital tax returns for Manitoba, Saskatchewan and British Columbia

ProFile T3 prepares Trust income tax returns and supporting schedules, including T3 and TS slips that the trust
receives. Simply enter slip information on intuitive income-reporting screens and ProFile T3 automatically
transfers the amounts to the appropriate forms. ProFile T3 also integrates business and rental income statements.
In addition to T3 slips, the software allows you to prepare NR4 slips for non-resident taxpayers (including the
NR4 summary).

ProFile FX (Forms Expert) gives you more than 80 of the most commonly-used CRA forms which supplement
the form-sets in Intuit’s other tax applications. Here are a few highlights of ProFile FX:

Customizable options help you complete and file the forms you need.

Automatic form selection facilitates form printing.

Audit and review features help pinpoint potential errors

Forms flexibility lets you print facsimile forms on plain paper or directly onto pre-printed CRA forms.
ProFile FX also prepares magnetic media files for T4, T4A, T5, T5018 and NR4 slips, as well as for the
RL1, RL2, RL3 and RL4.

e Import identification from an existing ProFile T1 or T2 data file minimizes potential data entry errors.



Benefits of Using ProFile

ProFile is powerful, efficient and secure tax software that helps you get your work done fast and efficiently.
Here’s how you benefit by using Profile:

e With phone, email or in-product live chat support, you have year-round access to knowledgeable
Canadian technical experts

e With its comprehensive set of forms and schedules, ProFile lets you handle just about every tax
scenario in any jurisdiction, including Québec

e  With a built-in auditor that runs up to 2,800 diagnostic checks of your tax returns, ProFile has your
back

e Flexible Licensing means you can install ProFile on more than one personal computer without having
to pay additional licensing fees

e Work with QuickBooks? So does ProFile! There’s no need for manual data entry because you can now
export data from QuickBooks directly into ProFile

Plus, with ProFile you enjoy a consistent level of advanced features that include:

e Customizable client correspondence
e Database queries and reporting
e Online tools to quickly and easily stay in touch with your clients




Chapter 1: All About Taxation

CHAPTER 1 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:

The history of taxation

How tax dollars are raised and disbursed

The role of the Canada Revenue Agency (CRA)

A taxpayer’s filing options

Taxpayer responsibilities

What the Canada Revenue Agency (CRA) does;
How to get information to help you file a tax return;
How to access and use CRA electronic services.



WHAT ARE TAXES?

Tax is a mandatory payment made by individuals and corporations to government. Tax is levied upon various
transactions that include income, property, and sales. Taxes are used to support the government, and the programs
and services it provides.

Different levels of government collect tax. For example, in Canada individuals pay:

o federal taxes used for programs such as National Defence, Old Age Security, Canada child tax benefit, and
transfers to provinces and territories

e provincial and territorial taxes used for services such as bridges and highways, education, hospitals, and
wildlife conservation, and

e municipal taxes for services such as police, ambulance and fire services, libraries, parks and playgrounds,
public transportation, and garbage and recycling collection

Without a tax system, government would not have the revenue it needs to provide services. Citizens support the tax
system by paying their fair share of taxes. In return, they benefit from the programs and services provided by the
government.

How are your tax dollars spent?

Many of the benefits you enjoy today are made possible through taxes. The government collects taxes to pay for
the facilities, services, and programs that it provides. Canada's tax system contributes to programs and
disbursements that include:

e roads

e public utilities

e education

e health care

e economic development

e cultural activities

e defence

e law enforcement, and

e other programs and services

Tax revenue also helps redistribute wealth to benefit lower-income families, students, seniors, and people with
disabilities. Tax revenue funds social programs such as:

e old age security

e employment insurance

e (Canada child tax benefit

e universal child care benefit, and
e working income tax benefit

The tax system also supports businesses and boosts the economy in other ways.

Here is the Canadian government’s distribution of expenditures for the 2016-2017fiscal year.




Major transfers to

other lewels of Major transfers to

govemment persons
22.1% 29.2%
Other transfer
payments
13.4%

Public debt charges
7.7%

Consolidated Crown

corporations
2.7% Operating expenses of
National Defence departments and agencies
8.2% (excluding National Defence)
16.7%

More information on government expenditures for 2016-2017 is contained in the Annual Financial Report of the Government
of Canada. http://www.fin.gc.ca/afr-rfa/2017/report-rapport-eng.asp# Toc492557458




Characteristics of a tax system

A tax system is defined by six characteristics:

who pays the tax

the tax base

the rates to be applied to the base

general exemptions

general deductions, and

other measures, such as how tax is to be paid

A

These characteristics determine how much revenue is produced, how fair the tax system is, and its ability to produce
economic growth.

A tax system needs to benefit all and it should be flexible, so the government can use it to achieve specific social
and economic objectives. Finally, the process for administering the tax system has to be practical, efficient and fair.

In Canada, the federal government follows these guidelines when it develops new tax legislation:

e Fairness - the tax system needs to ensure that all taxpayers share the tax burden equally. People with similar
financial circumstances should receive the same tax treatment. In other words, all high-income earners
whether they are individuals or corporations, should pay their fair share of tax. Also, similar products should
be subject to the same rate of sales tax

e Stability - the federal government needs a stable and dependable source of tax revenue so it can manage
the country's economy

e Canadian priorities - the tax system helps meet the national/provincial/territorial and economic needs that
are priorities for most Canadians

e Consultation - the federal government is committed to consulting Canadians before making final
legislative proposals for tax amendments

Canada's tax system has evolved over many years to accommodate the needs of an increasingly complex society.
However, the guiding principle has always been the same: our elected Parliament must have ultimate control over
tax legislation.

Canada's tax system is based on the self-assessment principle, which means that taxpayers complete their tax return

each year to report their income and to calculate whether they owe tax or receive a refund. It is considered the most
economical and efficient way to collect income tax.

An abridged history of tax

Many people assume that taxes are a recent development and that our ancestors did not have to pay them. This,
however, is not the case.

Of course, in the past, people did not always pay with money. Instead, most paid their tax bill with goods they
produced or raised, such as grain, fish, minerals, or animals.




History of taxes in the world

Tax as we know it today, existed in various forms in different societies throughout civilization. Kings, queens,
chiefs, rulers, and people in authority were responsible for imposing and collecting taxes from the people they ruled.
What was taxed, when it was taxed, and how much tax was imposed varied from society to society.

The French and Latin of the 13th century were credited with the first use of a word similar to tax. The French had
Taxer and the Latin used Taxare to describe the following tasks: to estimate, to assess, or to access repeatedly.

Canadian taxation before Confederation

The colonial governments collected taxes and sent them to the two mother countries, England and France. The
colonial governments usually collected revenue by charging customs duties. In 1650, Louis XIV of France imposed
the first recorded tax in Canadian history—an export tax of 50% on beaver pelts and 10% on moose hides that were
leaving his colonies.

In 1867 The British North America Act was passed, allowing the Canadian government to raise money by taxation.
Over the next 50 years, the federal government used only indirect taxes such as customs duties and excise taxes to
raise the money it needed. Direct taxation was only levied in the four Canadian provinces of Ontario, Quebec, Nova
Scotia, and New Brunswick.

The Fathers of Confederation divided the governmental responsibilities of this new country between the federal and
provincial governments. The most expensive areas of responsibility—railways, roads, bridges, and harbours —were
the responsibility of the federal government. The provincial governments were responsible for education, health,
and welfare.

Canadian taxation after Confederation

On August 4, 1914 Britain declared war on Germany and, as a British colony, Canada joined Britain in the Great
War. The pressures of financing World War I soon brought major changes to the Canadian tax system.

In 1916 the Canadian government used a new method of direct taxation by imposing a corporation tax known as
the business profit war tax. It affected corporations only if their profits were more than a certain percentage of their
invested capital. Although this was not income tax as we know it today, it was a milestone in the history of Canadian
taxation.

It was in 1917 that the federal government, led by Sir Robert L. Borden, introduced the Income War Tax Act. "1
have placed no time limit upon this measure . . . a year or two after the war is over, the measure should be definitely

reviewed," stated Sir Thomas White, Minister of Finance.

In July 1917, the federal government imposed a general tax on corporate and personal income that was collected by
the Department of Finance.

Other key changes to the Canadian tax system included:
1927 - The Department of National Revenue was created.
1952 - For the first time, the Department of National Revenue became involved in an area other than income tax

when it began to collect old age security tax on personal and corporate income. The department assessed this tax
under the Old Age Security Act.



January 1, 1991 - The federal government replaced the federal sales tax with the goods and services tax (GST).

May 2007 - The Government of Canada introduced the Taxpayer Bill of Rights, which outlines what a taxpayer
can expect from the CRA.

Common Canadian taxes

In Canada, there are various taxes, tariffs, and duties. In this section, we will briefly explain the following common
Canadian tax and salary deductions:

e Income tax;

e employment insurance (EI) premiums;

e (Canada Pension Plan (CPP) contributions;

e provincial sales taxes (PST); and

e goods and services tax/harmonized sales tax (GST/HST).

Source deductions
All individuals pay income tax to the federal, provincial, and territorial governments. The amount of income tax is
based on the taxable income (total earnings minus allowable deductions) earned during the tax year.

Income tax is collected in various ways. The most common method, commonly called Source Deductions, sees
employers deduct income tax from each employee’s pay cheque and remit it directly to the Canada Revenue Agency
on the employee’s behalf.

If an employee did not have enough tax deducted through source deductions, she may have tax owing when she
files her tax return. Individuals who regularly have a balance owing may have to pay their income taxes by
instalments.

Employment insurance (EI) provides temporary financial assistance to unemployed Canadians who, through no
fault of their own, have lost their job. EI, therefore, assists them while they look for work or upgrade their skills.
Canadians who are sick, pregnant, or caring for a newborn or adopted child, as well as those who must care for a
family member who is seriously ill with a significant risk of death, may also be assisted by EI.

Like income tax, EI premiums are deducted at source by an employer from an employee’s wages. In addition to the
amount deducted on an employee’s pay cheque, employers also contribute to the EI pool, usually at a rate of 1.4
times the amount deducted from all employees.

The Canada Pension Plan (CPP) provides contributors with a stipulated amount when they lose income because
of retirement, death, or disability. In the event of death, the plan provides benefits to the contributor's survivors.
With very few exceptions, every employed person in Canada over the age of 18 pays into the Canada Pension Plan.
CPP, as with income tax and employment insurance, is also deducted by an employer at source. In addition,
employers also contribute to CPP at a rate equal to the amount deducted from all employees. For employees in
Quebec, the employer deducts Quebec Pension Plan (QPP) contributions instead of CPP contributions.




Refunds
It can happen that an individual is entitled to a refund of the taxes that were deducted at source. Refunds can be
triggered if an individual:

e had too much tax withheld during the year
e paid more tax instalments than necessary, or
e isentitled to claim more refundable tax credits than the total taxes paid. Examples of these credits include:
o Canada Pension Plan (CPP) overpayment;
o employment insurance (EI) overpayment;
o working income tax benefit (WITB); and
o provincial or territorial credits, which vary depending on the province or territory where you live.

In addition to getting a refund, individuals may also want to file an income tax return to receive certain credits and
benefits paid throughout the year, or to report amounts that can reduce the amount of tax that must be paid in the
future.

Other taxes

Provincial sales tax (PST) is a tax that most provinces levy on the sale of goods and services. PST is generally
added to the sales price of an item being purchased. The items that are taxed and the tax rate vary from province to
province.

Goods and services tax (GST) is a federal tax that is charged on the sale of most goods and services in Canada at
a consistent rate of 5%. It is important to note that the federal government, though, does not tax essentials such as
groceries, prescription drugs, residential rent, health care and dental care.

In some provinces, the GST is combined with the PST and the two are collected together at a combined rate. This
is known as harmonized sales tax (HST).



ABOUT THE CANADA REVENUE AGENCY (CRA)

The CRA’s mission is to administer tax, benefit, and related programs, and to ensure compliance on behalf of
governments across Canada, thereby contributing to the ongoing economic and social well-being of Canadians. It
does this by:

e collecting taxes and administering tax laws for the federal government and most provinces and territories
e delivering credit and benefit programs to Canadians such as:
o Canada child benefit (CCB)
o goods and services tax/harmonized sales tax (GST/HST) credit, and
o working income tax benefit (WITB)
e collecting Canada Pension Plan (CPP) contributions and employment insurance (EI) premiums, and
e administering Canada's international tax agreements with other countries

In carrying out its mission, the CRA affects the lives of many Canadians on a daily basis.

Getting information from the CRA
The CRA offers all of its services, (including Internet, telephone, and correspondence services), to Canadians in
both official languages.

CRA Web site
The CRA Web site https://www.canada.ca/en/services/taxes/income-tax.html is a valuable resource if you need tax
information, or information on programs and services.

The best way to navigate the site is to start in the section for Individuals. Menus throughout this section offer
information sorted by topic or client group (such as information for students or employees).

Forms and publications

CRA guides, forms, pamphlets, interpretation bulletins, information circulars, and other publications, provide
details on tax topics and can help you to understand the tax system. To get forms and publications, go to
https://www.canada.ca/en/revenue-agency/services/forms-publications.html or call 1-800-959-8281.

If you are blind or partially sighted, you can get publications in braille, large print, e-text, or MP3 by going to
www.cra.gc.ca/alternate. You can also get publications and personalized correspondence in these formats by calling
1-800-959-8281.

Here are some examples of the programs administered by the Canada Revenue Agency (CRA):

Goods and services tax’harmonized sales tax (GST/HST) credit
The GST/HST credit is a tax-free quarterly payment that helps individuals and families with low or modest incomes
offset all or part of the GST or HST that they pay.

If you turn 19 before April 1, 2018, you can apply for this credit on your 2017 income tax and benefit return. You
have to file a return to apply, even if you have no income.




Examples of CRA programs

Canada child benefit (CCB)

The government’s 2016 budget introduced the Canada Child Benefit, a key initiative of the Government to

strengthen the middle class and help those working to join it. There is no need to apply if you already get child

benefits, but you and your spouse or common law partner have to file a tax return every year to continue to

receive it.

The Canada Child Benefit is:
simple — most families receive a single payment every month

tax-free — families don't have to pay taxes on payments received when they file their tax returns

targeted to those who need it most — low and middle-income families get higher payments, and those with the

highest incomes (generally over $150,000) receive less than under the previous system

generous — on average, families benefitting from the CCB receive about $6,800 in CCB payments annually.

¢ Find out ifyou are eligible for benefits and credits

00
¢y o W

Married or
Married or common- Single with common-law
law with children children under with no
under 18 years old 18 years old children
Canada child benefit Yes Yes No
Goods and services Yes Yes Yes
tax/harmonized sales
tax (GST/HST) credit
Provincial and Yes Yes Yes
territorial

benefits and credits

Tuition amounts

The tuition, education, and textbook amount is a non-refundable tax credit available to students to reduce the amount

of income tax they have to pay.

If you do not have to pay tax, you can carry forward or transfer all or part of your unused tuition, education, and
textbook amounts. To carry forward the credit to use in a future year, you must file a tax return and attach a

completed Schedule 11.

Registered retirement savings plans (RRSPs)

Single and 19
or older with
no children

No

Yes

Yes

Money that you contribute to an RRSP can be used to reduce the amount of tax you have to pay.

The amount of RRSP contributions that you can deduct on your tax return is determined by your RRSP deduction

limit. This is often called your "contribution room".



The RRSP deduction limit is calculated based on the income you report on your tax return and on the carry-forward
of unused amounts from previous years.

You may want to file a tax return to begin building up your RRSP contribution room and have a greater deduction
limit available for use in future years.

CRA electronic services

The CRA's electronic services are quick, easy and secure, and they allow you to view, change and manage your
personal tax information. Some of the most widely used services are:

Child and family benefits calculators — Estimate the amount of CCB, GST/HST credit and other provincial and
territorial benefits that you may be entitled to receive.

Direct deposit — You can have your income tax refund, CCB, and GST/HST credit deposited directly into your
account at your financial institution in Canada.

Electronic payments — Make your payment online using the CRA's My Payment service or using your financial
institution's telephone or Internet banking services.

My Account — This is a secure, convenient, and time-saving way to access and manage your tax and benefit
information online, seven days a week. If you are not registered with My Account but need information right away,
use Quick Access to get fast, easy, and secure access to some of your information.

Tax Information Phone Service (TIPS) — For personal and general tax information by telephone, use the
automated service, TIPS, by calling 1-800-267-6999.

How the CRA gets information
The CRA not only gets information from your tax return, but from other sources as well. Other individuals and
organizations have a responsibility to report payments and send deductions to the CRA. They include:

e employers;

e financial institutions;

e organizations that pay interest or dividends; and

e those making payments to non-residents of Canada.

Compliance with tax laws
The CRA is responsible for collecting taxes owed and for discouraging tax avoidance. To do this, CRA may carry
out a more detailed post review after your tax return has been assessed.

Review of your tax return

Each year, the CRA conducts a number of review activities that promote awareness of and compliance with the
laws it administers. These reviews are an important part of maintaining the integrity of and Canadians' confidence
in the Canadian tax system.

Three of CRA review programs are the:
e Pre-assessment review program




e Processing review program, and
e Matching program

Under these programs, CRA compares the information on a tax return to that provided by employers or financial
institutions. By reviewing a number of deductions and credits on the return, CRA ensure that various income

amounts have been correctly reported.

If the CRA makes changes to your return after a notice of assessment has been sent, they will send you a notice of
reassessment that explains any changes.

FILING A TAX RETURN

If you earned income during the year you have to complete an income tax return and send it to the CRA. Generally,
income tax returns are due by April 30, and the CRA begins processing returns in mid-February.

The Income Tax and Benefit return is the form you use to report income and to apply for benefits such as the Canada
child tax benefit (CCTB), the goods and services tax / harmonized sales tax (GST/HST) credit, and the working
income tax benefit (WITB).

The T1 General, Income Tax and Benefit Return covers all tax situations. It is available by going to
https://www.canada.ca/en/revenue-agency/services/forms-publications.html

Filing options

The CRA encourages all Canadians to file their taxes electronically. Electronic filing helps to reduce costs, achieve
greater accuracy and faster processing, and it also is environmentally friendly. The CRA's electronic tax-filing
services are known as NETFILE and EFILE.

NETFILE is a fast, easy and secure service that allows you to send your return directly to the CRA from mid-
February to the end of November using the Internet. Internet-filed returns must be prepared using one of the
commercial tax preparation software packages or Web applications certified by the CRA to meet its system
requirements. Intuit’s TurboTax is an example of a CRA-approved software package.

EFILE is an automated system that allows registered electronic tax-filing service providers (professional
accountants and tax preparers) to send income tax information to the CRA electronically. To use this service, an
individual must take her documents to a tax preparation service provider who will prepare the electronic return,
using software such as Intuit’s ProFile, and send it to CRA under its EFILE system.

Using CRA’s T General, Income Tax and Return form, individual taxpayers can also prepare their own tax return
and mail it to their CRA tax centre. Because it is a manual process, calculating the correct amounts for line on the
tax return can be a complex process, and the probability of omissions and errors is very high.

Here is the first page of CRA’s T1 General, Income Tax and Return as it would appear if it were hand-written. We
will explore this form in more detail in Chapter 4.



el S~ e T1 GENERAL 2016

Income Tax and Benefit Return

Step 1 - Identification and other information

Print your name and address below SIS 44444 4442

Frst rame anc s Yew  WVor Day
Marianne Enter your cate of birth 1979 12| 13

Cast rame

Your language of comespon Erger Frargas

St Laurent Vi langas o eammopndensa t X O

Vi accress. AGt NG - Stoet No Steet name
..g'iMHMStM - Is this return for a deceased person?

1 this return is for a deceased Yew Mot Day
person, enter the date of death: | |

Postal coce

Cay Prov/Ten.
Anytown. Lon| [M4alzAR ]

Tick the box that apples 10 your maital status on
e D3 20e
| understand that by providing an emal accress, | am regiet p- 1D vames 2 Lving commonew 3] Widowes
| have read anc | accept the terms and conditions on page 17 of ¥ X X

o a0 oworcee 5[] Separmtec 8 snge

Enter an emall addvess: wm_aST0121@gmail.ca

[Enter your provinge or teeritory of .
rescerce on December 31,2016, OWtario

Enter e proviece o leriory where
you currently resice f & is not the
same 48 your Masing accress above

1 be & resident of Canada for income Lax purposes

I you became cr ceased
In 2016, enter the cate of.

Mot Day Morth  Day
ey | 4 | | o cepanwee |, | |
28 |octions Canada (For more inlormation, see page 19 n the guide)
A) Do you have Canadian citizenship?. ves[X1 no[J2

Answer the lolowing question only if you have Canadian citizenship
8) As a Canadian citizen, do you authorize the Canada Revenue Agency 1o give you name,

address, date of birth, and ciszenship to Elections Canada to update the National Register of Electors? vesX]1 No[ ]2
Your authorization is valid until you file your next tax retum. Your information will only be used for purposes permitted under the Canada

Elections Act. which inciude sharing the information with provincialerritorial election agencies, members of Parkament. registered
poiical parsies. and candidates at election tme.

T I —— T T T ]
[ [z P m |

socon

After you file

It usually takes about four to six weeks to process paper returns and two weeks to process returns filed using
NETFILE and EFILE.

After the CRA processes a tax return, the agency will send you a notice of assessment showing any changes or
corrections made (such as identifying and correcting a math error). The notice will indicate that you either are
entitled to a refund or that you have a balance owing.

If you overpaid your taxes during the tax year, the CRA will issue a refund cheque attached to your notice of
assessment, or it will directly deposit the funds into your account at a financial institution in Canada.

On the other hand, if you have a balance owing because you paid less taxes than you should have, and you did not
attach the payment to your return when it was filed, the notice of assessment will contain instructions on how to
pay the balance owing to avoid any interest charges.




Taxpayer Roles and Responsibilities

As a taxpayer, you have certain obligations. You are responsible for:

e filing an income tax and benefit return by the deadline

e paying the correct amount of tax

e giving the CRA the necessary information to assess your return

e giving the CRA up-to-date information, in order to receive accurate benefits, and to avoid unnecessary
delays in sending the benefits, and

e getting help when necessary

Self-assessment

Earlier in this chapter, we learned that Canada has a self-assessment tax system. This means that taxpayers
complete their tax return to report their annual income and to calculate whether they owe tax or are entitled to
receive a refund.

Under the self-assessment system, Canadian residents and non-residents with Canadian income are responsible
for making sure they have paid their taxes according to the /ncome Tax Act (the Act). Income and deductions are
listed on the income tax and benefit return so both the taxpayer and the CRA can calculate the taxes the taxpayer
has to pay.

In this way, taxpayers can check to make sure they are receiving fair and equal treatment under the Act. At the
same time, the CRA can properly administer the tax laws.



Chapter 1 Quiz

Question 1: True or False: Taxes are a new concept and have only been collected since 1950

Correct answer is False

Question 2: The tax revenue collected by the government is used to:

Transfer funds amongst the provinces

Pay interest on the public debt

Pay for programs such as national defence
All the above

oCawy»

Correct answer is D

Question 3: True or False: Goods and services tax (GST) is applied to all goods and services sold in Canada

Correct answer is False

Question 4: True or False: If you are 18 years old or over and working, you may have to make contributions to
the Canada Pension Plan

Correct answer is True

Question S: True or False: The Canada Revenue Agency is responsible for creating all of the tax laws in Canada

Correct answer is False

Question 6: True or False: If you do not owe income tax, you do not have to file a tax return

Correct answer is False

Question 7: The various types of taxes include which of the following?

Income tax
Provincial sales tax
Federal sales tax
All the above

oawy

Correct answer is D
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Question 8: True or False: The term Source Deductions is used to describe amounts that employers deduct from
their employees’ pay cheques

Correct answer is True

Question 9: The Canada Revenue Agency’s mission is to:

Collect taxes and administer tax laws on behalf of the federal government

Deliver credit and benefits programs such GST/HST credits

Collect Canada Pension Plan (CPP) and Employment Insurance (EI) premiums from taxpayers
All the above

cawy

Correct answer is D

Question 10: As a taxpayer, your role and responsibilities include:

A. Filing an income tax return
B. Giving CRA the necessary information so that it can accurately assess your tax return
C. Use a self-assessment method to report and remit the correct amount of tax

D. All the above

Correct answer is D




Chapter 2 Installation and Set-Up

CHAPTER 2 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
How to install and activate ProFile

How to manage ProFile licenses

How to set up EFILE credentials

How to use ProFile’s Options menu

A Proper Setup

With its multifaceted installation options and its depth of features, it is important to fully grasp the various ways
in which you can install and setup ProFile. The options discussed in this chapter range from a set-up for a one-
person tax office to a large-scale set-up for a team of tax preparers working in a networked environment. No
matter the scenario, the objective remains the same: maximizing efficiency and understanding the needs of the tax
preparer(s) who will be using ProFile.

Before diving into the various installation options, it is important to note the following specifications and system
requirements:

ProFile Specifications

e Internet connectivity is required for licensing and auto-update
Windows servers software is not supported
Network/workstation install UNC path is not supported
.NET 4.5.2 installation & registration are required
Apple products are not supported

System Requirements
e Processor: 1GHz or faster processor
0S: Windows 7 ™ with service pack 1, Windows 8/8 ™ or Window 10 ™
Memory: 2 GB minimum; 4 GB recommended
Hard Drive: 900 MB free hard drive space for download and 1.5 GB for installation
Printer: Windows compatible
Display: 1024 X 768 minimum resolution; 16 bit or higher colour
Internet: IE 11 or higher and high-speed connection
Other: eReview feature requires a MAPI email client and a PDF reader application (for example:
Adobe PDF Reader®)

SINGLE-USER INSTALLATION

This sequence of instructions explains how to install ProFile on the local (C:\) drive of your personal computer:
e Start by visiting ProFile’s website (profile.intuit.ca) and download the gpsetup.exe file
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<
gpsetup.exe
e Double click gpsetup.exe and follow the installation prompts
ProFile - InstallShield Wizard X

Welcome to the InstallShield Wizard for ProFile

The InstallShield Wizard will install ProFile on your computer. To continue, dick Next.

Instali5tield

e During installation, make sure that you choose the Program Files folder of your local drive (usually
drive C:\) as the file destination
e Follow the prompts to complete the installation

ProFile - InstallShield Wizard X
Choose Destination Location
Select folder where setup will install files.

. Install ProFile to:
C:\Program Files (x86)\ProFile\ Change...




ProFile activation

After installing ProFile, you must activate it by entering your license information. Follow these steps to activate

ProFile:
e Launch ProFile

¢ In the window that opens, enter your software Product Code and License Key

[y 4 ProFile License Activation

INTUIT ProFile

Activate ProFile

To activate ProFile, please enter your Product Code and License Key.

Product Code License Key

Where do | find this information?

Activate

Finding your licensing information

Read on if you’re not sure where to find the licensing information required for the window above.
e After purchasing ProFile, you will receive an emailed receipt containing the product information to be

entered in this window

e Ifyou purchased ProFile through Intuit’s Web Store, you will find the codes at the very bottom of the

receipt

ProFile Québec Tax Suite License (1-4)

Required to activate your product(s):
Product Code: 496-998

License Key: 5612018834-

$325.00

Sub-total:

$325.00

$2,355.00

e  Ifyou placed your order by telephone, the codes will appear in the Order Details section
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ORDER DETAILS

Quantity ItemId Unit Price  Ext Price

1 423452 $1,680.00 $1,680.00
FR PROFILE TY14 QUEBEC SUITE

1 423522 $325.00 $325.00
FR ProFile TY14 Quebec Suite License (1-4)

Required to activate your product:
Product Code:496-998 License Key:9059-8678-95 2l

e After entering the license and activating the software, a green checkmark will appear indicating that the
product is ready to go.

v 4l ProFile License Activation X

INTUIT ProFile

Success!
You're All Set.

Quick Tips:

Free ProFile training
Tips & Tricks
Community Forums

Please try ProFile Review

You can access online features by clicking on the icon in the top bar.

Managing Your Licences

e Keeping track of your ProFile licenses is an easy yet important part of the installation and set-up
process. Start by clicking Help > Manage Licenses



Help
F ProFile Help F1
s What should we build next? s
QuickStart...
Support >
Live Chat
Live Community
Privacy Policy

Suspend Licenses

e Click on Details

License - [m] X

You are currently licensed for

T T1TYTP1 License

T2  T2License - Expires On 2017-12-31
T3 T3T3/TP646 License

FX  FXFX/QLicense

e Ifyou purchased additional licenses or modules (T2, T3, etc.) click on Add New License

License

‘You have the following active [k For assi please call C Care at 1-800-452-9970 or visit
Intuit Technical Suooort.
Product . Expiry Tax g
C License Key Date Year m T2 [ T3 [ FX +T2-EF
818902 [8158 20171231 [2016 [Lic+QC [Lic LictQC |LictQC
|818902  [5015™ 1201712:31 2016 |LictQC Lic  Lic+QC LictQC |
< Add New License

e Enter the new Product Code and License Key
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/4 ProFile License Activation X

Activate ProFile

To activate ProFile, please enter your Product Code and License Key.

Product Code License Key

Product Code License Key Activate

Where do | find this information?

OnePay customer? > Free Trial Activation > 2011 or older license? >

e Toremove licenses—those that are old or outdated, for example—return to the License window, select
the license to remove

o Click on Delete Selected License a

License X

You have the following active license(s). For assistance, please call Customer Care at 1-800-452-9970 or visit
Intuit Technical Suooort.

Product . Expiry Tax
X +T2-EF
Code License Key Date Year m T2 T3 F 2-E
1 818902 8158 2017-12-31  |2016 LictQC Lic LictQC LictQC
818902 5015 2017-12-31 | 2016 Lic+tQC Lic Lic+QC LictQC

This license code is inactive, because itis overridden by the other license cod

Add New License

u Delete Selecled Li
d

PROFILE WORKSTATION INSTALLATION

In a network environment, where an office has multiple tax preparers, you may not want to install ProFile on each
individual computer. In other words, you’ll want a workstation installation. Here’s how to do it:
e Ensure that your network is properly setup and configured. You may require an IT professional or
Network Administrator for guidance on how to best proceed with this setup
e Perform a full installation of ProFile on the server and restart the server
e From the workstation, map the drive in which ProFile was installed by following these steps:
e Click on Computer, then choose Map network drive



Q\; 1% » Computer » v|$

Organize » System peoperties Uninstall of change a program Map network drive Open Contn
¢ Favorites + Hard Disk Drives (1)
Ml Desktop Local Disk (C2)
& Downloads "  em— —

Recent Places

o Enter the address of the server by browsing to the target location (example: G:\my-server)

s
) @ Map Network Drive

What network folder would you like to map?
Specify the drive letter for the connection and the folder that you want to connect to:
Drive: Z -
Folder v Browie...

Example \\server\shace

¥ Reconnect at logon

Connect using different credentials
2 Yieh ste that you <an yse 1o store your documents a0d pectures.
Cancel

¢ In the mapped network folder where ProFile was installed, right-click on Workstation Install and select
Run as administrator

e Follow the installation wizard

e  When completed, a ProFile Workstation icon will appear on the workstation’s desktop

Configuring Your Workstation Licenses

There are two ways to configure workstation licenses. The first method is to configure the license codes for all
users. Modify the startup.ini file that is installed on your network server where ProFile is installed. The startup.ini
file has the following format:
e [License]
e ProductCode=
e Code=
e Name=
To have a common code used by all client computers, enter the ProFile product code after ProductCode= and
enter the license key after Code=
e The second method is used when your system administrator wants to limit individual users to specific
modules.
e Under this method every user has their own access code (instead of everyone using the same
centralized code). It is recommended to leave the startup.init file in the location where ProFile is
installed
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e After you update the registry and complete the installation process, you are now configured to use
ProFile. To run ProFile next time, double-click the ProFile icon that was created on your desktop or
select ProFile from the Start menu.

PROFILE FLEXIBLE LICENSING

If you have more multiple computers and need to access ProFile from any one of them, then Flexible Licensing is
for you. Flexible Licensing temporarily suspends a ProFile license on one computer and activates that same
license on another computer. With Flexible Licensing, there’s no need to constantly delete the license on one
machine and then enter it manually on another machine.

e To enable this feature, click the Help menu and then select Configure Flexible Licensing

Help

ProFile Help F1
= What should we build next?
QuickStart...

Support >
Live Chat

Live Community

Privacy Policy

Configure Flexible Licensing

Send Feedback
About

o Click Enable flexible licensing on this computer then select the mode of your choice. You can choose a
Manual mode that requires you to confirm you would like to suspend the license on a given computer,
or you can choose an Automatic mode that will suspend and activate the licenses for you. We
recommend choosing Automatic mode

e After choosing your option, click Save

4 ProFile Flexible Licensing Settings

Flexible Licensing Settings

You can update your settings for Flexible Licensing below. Click save to update your settings.

Flexible licensing allows you to temporarily suspend your tax year 2016 ProFile license from one
computer so you can use it on another computer. Learn More

[v] Enable flexible licensing on this computer

Manual - This option will require you to confirm that you would like to suspend your ProFile
licenses when you close ProFile.

t me »se ProF e Don't mpt doitma

® Automatic - This option will automatically suspend and activate your licenses when you
open and close ProFile.

You can access these settings by clicking the Help > Configure Flexible Licensing menu item above.
Please Note: In order for this functionality to work your computer must be connected to the internet.




¢ In automatic mode, ProFile will confirm your computer’s license status whenever you log in and out of
the application

Your licenses have been enabled on this computer.

Welcome back!

Your licenses have been successfully suspended on this
computer.

See You Later!

ProFile will now close ..

Maximum license warnings

When activating a ProFile license, you may see this warning: ProFile has been activated the maximum number of
times permitted for this license. This message appears either because a license is being used more times than there
are units available for use, or because it was not removed from an older machine before being transferred to a new
one.

What’s a unit? If you purchased one license, you will receive an extra license unit for an unforeseen situation that
may trigger the need to reactivate your license. This means you have two units available. If you then try to
activate your license on more than two computers, you will receive the “Maximum activation error” message
described above.

To correct this issue, try deleting a license from an unused computer before activating it on a new machine.

e On the old machine, open ProFile and click Help > Manage License
e Click on Details =
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4 PROFILE
File Goto Form Options EFILE Online Training Window Help

v 38~ « - ProFile Help F1
What should we build next?
QuickStart...

Support >
Live Chat
Privacy Policy

Suspend Licenses

Configure Flexible Licensing License _ O X
1 Manage Licenses %

Send Feedback You are currently licensed for

About Tl TI1TVTP1 License

T2  T2Llicense - Expires On 2018-12-31
T3 T3T3/TP646 License

FX  FXFX/QLicense

Add New License E

e Click the license you’d like to delete. ProFile displays a message that the license is valid and active
e So that you can enter it on the new machine, make note of this license =1

e Click on Delete selected license to deactivate ProFile on the old machine =
e You can now activate the license on your new computer

License X

You have the active For please call Customer Care at 1-800-452-9970 or visit
Intuit Technical Suoport.
Product . Expiry Tax
+T2-]
Code License Key Date Year m T2 T FX T2-EF
2018-12-31 2017 LictQC Lic LictQC LictQC
1 = 20171231 |2016  |Lic+QC |Lic LictQC LictQC

Add New License This license code is valid and active.
Delete Selected Li

A BASIC SETUP

In this section, you will learn how to quickly set up the minimum number of options that are required to get
ProFile up and running. Once these options are enabled, you can immediately begin working in ProFile.
Later in this chapter, we will describe how to delve into more advanced and more sophisticated options.

EFILE Options

Every professional tax preparer receives bespoke EFILE credentials from CRA. It is important, therefore, to enter
and save those credentials in ProFile. Follow these steps to record your credentials:
e Click EFILE > Options



e In the left-hand window, click EFILE Internet

e Enter your On-line Number and EFILE password as provided to you by CRA [e]

Electronic Filing Options

General
m

Common

EFILE Intemet
' TP1 Intemet
T2

T2EFILE
T2AT1 NetFile

T3/FX
Transmitter
Contact information
MRQ Slip Numbers
Internet File

T2 C0-17 Intemnet Filing

LCRA |dentification

EFILE On-Line Number 41339 EFILE Online Password

[Case Sensitive)
Options

Retain EFILE Log
[] Prompt for Session Type before connecting to CRA
Show Print Prompt at End of Session

T1/TP1 Wizard Cancel

Help

e In the same window, select 72 EFILE and you should see your credential appear there as well

Electronic Filing Options

General

m
Common
EFILE Intemet

T2 C0O-17 Intemet Filing
T3/FX

Transmitter

Contact information

MRQ Slip Numbers

Intemnet File

CRA |dentification
EFILE Number £1339 EFILE Password
[Case Sensitive)

EFILE Directory

[C:\Users\MichaeI\Documenls\My ProFile Data\T2 Returns\EFILE

EFILE Web Service (For Technical Support Only)
@ Default
QO URL

T1/TP1 Wizard 0K

Cancel

Help

Environment Options

Under the Options menu, you will find a host of ProFile preferences. While all preferences are arguably
important, there are some that are considered mandatory. Here, therefore, are the options you should set under a

basic scenario.

It’s important to note that if you’re unsure about the functionality of any option, click the Question Mark icon at
the top right of the Environment window and then click on any function. ProFile will then display tab-specific,
context-sensitive help that will guide you in configuring your settings.

vironment Options

?

Edit  Display File  Preparer Discounter Trustee Audit System HyperDocs PDF  Notifications

Office Info Setup wizard
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File Tab

e Click Options > Environment and then select the File tab.

e Under the File tab, ProFile lets you set and/or confirm the default location for all your tax files. By
default, Profile creates a general folder called My ProFile Data and, within that folder, ProFile
establishes sub-folders to store files for each specific tax year and module (for T1, T3 and FX files).
Unless you have specific file-location requirements (a server environment, for example), you should
accept ProFile’s default folder settings

Environment Options ? X

Edit Display File Preparer  Discounter Trustee Audit  System HyperDocs PDF  Notifications

Preferences
Multiple Open Files Keep Backup
Save Desktop [ &llow Password
Save Prompt Update Documents Folder
[[] Esc Closes Window [[] Discounter Info Dialog
[C]File Protection [ File Verification
FA Magimum Open Tabs Auto save files every
S tabs > minutes
Default File Type (module): l Most Recently Used v

Recently Used Files

O ok E < entries

(@ Attach to Reopen menu item
O Attach to File menu Clear

File Directories

Module Directory Lock i]
2017 T C:A\Documents\My ProFile Data\2017T1 v
2016 T1 C:\Documents\My ProFile Data\2016T1 _] v
2015 C:ADocuments\My ProFile Data\2015T1 v
20141 C:A\Documents\My ProFile Data\2014T1 v
2013 T C:A\Documents\My ProFile Data\2013T1 v
21211 C:ADocuments\My ProFile Data\2012T1 v L]
Office Info Setup wizard Cancel Help
e To change a folder’s default location, just click the menu for each module and tax year
File Directories
Module Directory ock i!
2017 M C:\Documents\My ProFile Data%2017T1 v
2016T1 C:\Documents'My ProFile Data\2016T1 v
2015T C:\DocumentsMy ProFile Data\2015T1 v
2014 C:\Documents'My ProFile Data\2014T1 v
2013 T C:\Documents\My ProFile Data\2013T1 v
2012 C:\Documents\My ProFile Data\2012T1 v LI

Clicking the “Lock” checkbox to the right of each folder location ensures that ProFile always saves files to that
location, and always looks in that location when opening files.

In addition to selecting the file location for all your tax files, you also choose, under the File tab, usability
preferences such as the ability to concurrently display multiple tax files; allow password protection and display a
list of recently used files.



Preparer Tab

The Preparer tab of the Options > Environment window, allows tax preparers to enter their firm’s address and
contact information, as well as their Business Number and Rep or Group ID as determined by CRA. From the

Preparer tab, you can also:

e Keep track of the workflow by entering preparer and partner initials
e Enter Québec preparer credentials

Environment Options

Preparer

Edit Display File Preparer Discounter Trustee Audit

System HyperiDocs PDF

? X

Notifications

Name:

Firm:

Street:

City:

l
J
|
|
l

Province:

Phone:

l Fax:

l
l
\
FOBoxRR: |
l
{
\
Email l

Initials

Preparer: ‘

Quebec

Partner: l

Quebec enterprise number (NEQ):

Identification Number:

T1013/RC53

Professional Representative Number:

[ ]
[ ]
[

ReplD

l Business Number l_

GroupID |G

I

Office Info Setup wizard

Cancel Help

Next steps

After setting up the basic options just described, you can jump ahead to Chapter 3 and begin working in ProFile.

A prudent tax preparer, though, might want to explore the more advanced preferences discussed in the next

section.

AN ADVANCED SETUP

This section described the more advanced features and preferences that you might want to consider when
personalizing ProFile. These options help streamline the workflow and save time during a busy and hectic tax

s€ason.

Note that the following preferences are all accessed via the Options > Environment menu.
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Edit Tab

The Edit tab lets you set preferences that enable fixed decimals data-entry (ProFile automatically places the
decimal point to the left of the last two digits entered in a field). Here you can also ask ProFile to capitalize every
word on a tax return or just the first letter in every word. From this tab you can also:

Manually override a calculated value on the tab return

Use the Ditto key to quickly copy and paste the same information in adjacent fields
Allow data to be dragged and dropped from one field to the next

Ensure that every Social Insurance Number entered in ProFile is valid
Double-click on a field in a tax return to jump to a related field

Right-click to enable Cut, Copy and Paste

Edit

Environment Options ? X

Display File Preparer Discounter Trustee Audit  System HyperDocs PDF  Notifications

Preferences
Automatic Override [JRight Button Highlighter
M Audible Override Double Click Opens Links

Flyover Memos and Tapes Default Tape Descriptions
Restack Tabs on Open Close tape on total
[[JFixed Decimal Entry Continuous Forms
[JUse Timer [[]Form Explorer Checklist
[JAllow Ditto Key Right Click Cut Copy Paste
[ Allow Drag and Drop [ Auto Insert Memo Date Stamp
Predictive typing Capitalization
M Enabled [ Sortltems O Normal

. ) = O All Uppercase
Meximum Entries - (® Smart Capitalization
Validation

[J Active Validation
M Validate SIN

Office Info Setup wizard Cancel Help

Display Tab
The display tab lets you personalize your on-screen views. From the Display tab, you can:

Enable on-screen page breaks

Use brackets for negative numbers

Display zeroes for all NIL values

Automatically zoom the displayed tax file to full screen width



Office Info Setup wizard

Environment Options

Edit  Display File  Preparer Discounter Trustee Audit System HyperDocs PDF

Preferences

[[] Page Breaks [[]Zoom ta Screen Width

[ Bracket Negative Numbers Data Monitor

[ Zeroes in NIL fields Enable Font Scaling (requires ProFile restart)
[ Line Decimal Separators

M Tablcons

Concel

?

Notifications

Help

X

System Tab

To ensure that you always have the most recent release, click the Systems tab and review the Automatic Update

settings. Here can establish the frequency in which ProFile checks for updates and you can also indicate whether
you want ProFile to notify you before downloading and installing an update. Form the System tab, you can also:

Enable ProFile’s forum-like Live Community
Enable or disable ProFile’s online features

Environment Options

Edit  Display File

? X

Preparer Discounter Trustee Audit  System HyperDocs PDF  Notifications

Security File

[JFile l C:\ProgramD ata\GreenPoint\profile\S ecurity log.txt ‘ Browse
Shared Folders
Counters: l C:\ProgramD ata\GreenPoint\profile\FormNumber\ ‘ Browse

Invoice: [

Browse

[ Enable automatic
Check every

Live Community

PDF417 Bitmap

Automatic Check for Updates

[ Notify before connecting to the Interet
[~ Notify before downloading

[4 Enable Live Community [ Show on startup

check for updates

7 v Dayls) v sometime after |12 AM v

Transmission Coding

Privilege Elevation

Click the Register button to register the Privilege .
Elevation libraries on this system. 9 fiogtet
ProFile Online For Technical Support Only
[[] Disable Online Features [ Static Logs
Office Info Setup wizard Cancel Help
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PDF Tab
You can use the PDF tab of the Environment Options to set personalized parameters for your client’s PDF files.

Here, you can also set file-naming conventions, as well as file location and password protection for all your PDF
tax returns.

Environment Options ? X
Edit Display File Preparer Discounter Trustee Audit System HyperDocs PDF D
PDF Name

T1:O Custom 4+ - (@ Same as TaxFile Name
T2:O Custom 4+ . (@ Sameas TaxFile Name
T3:O Custom 4+ - (@ Sameas TaxFile Name
Fx:O Custom 4+ - (@ Sameas TaxFile Name

PDF Archive Directories

[ Specify Default Custom Directory for PDF Archive Files

\\WMac\Home\Documents\My ProFile Data\Archives\ Browse Advanced

Module Custom Directory | &l
201771 ' o
2016 T1 With Tax File
2015T1 r With Tax File
201411 r With Tax File -

PDF Security

SetUser Passwcrd (Raad and Prit Ory)

Set Owner Password

®
- R N Protects the PDF document from being
(et  SHENTANEN e s
O RO —
O Jrar
Office Info Setup wizard Cancel Help

Other Environment Settings

The Options->Environment window features other tabs including settings for establishing Discounter and Trustee
credentials, and for enabling more advanced features such as Audit and HyperDocs settings. We will revisit some
of these settings later.

Options>Module

ProFile’s Module options let you fine-tune the way ProFile works with each individual tax year and module (T1,
T2, T3 and FX). This granular level of detail lets you determine the tax settings that ProFile will choose on new
files, and on files you are carrying forward from a previous year. In this window, you can also establish your
language preference, and you can set variance thresholds for comparing a client’s current and previous year’s tax
file. The paragraphs below describe the Module options you should immediately set.

v| 320152017 T2 w | [ 52016 TH/TP646 w | (&3 82016 F ¢

General Datalocking Variance Disclaimer T1/TP1 Review

& Cany forward files ~ Langua»ge
B Carry forward slip descriptions @® English
B Carry forward donation descriptions O French

B Cary forward free form notes
[ Cany forward preparer initials




General Tab

Scroll down this window to set defaults for new and carried-forward file. These defaults include RC 59 and
T1013 authorization levels, pre and post-assessment review settings, and slip descriptions for carried-forward
files. In this window, you can also:

Carry forward Elections Canada and foreign property questions, and T1DD information
Set defaults for language of correspondence and preparer information

Set client letter and invoice defaults

Establish naming conventions for your tax files

Choose form colours for client and spouse tax returns

General DataLocking Variance Disclaimer T1/TP1 Review

& Cany forward files A
B Carry forward slip descriptions
B Cary forward donation descriptions
B Carry forward free)
[ Carry forward pre

General Datalocking Variance Disclaimer T1/TP1 Review

[ Canyforward parf | € New Files A
O Carry forward revi Default preparer initials
B Carry forward auth X Default partner initials
X Carry forward Ele [ Defaultto discounted General Datalocking Variance Disclaimer T1/TP1 Review
O cany forward fore) & Language of correspond ;
O Cany forward fileg ® Blank ® FEr;Balsasnissment review ”
O Carry forward invd Q English
[ carry forward T10 Q French O Contact preparer by meil
6 RC59 online acc & RC59 online access defd © Contact client .
S mana o . . 6 Post-assessment review
% QO RC59 defaultindividy O Blank
Q© RC59 default group g )
QO RC59 default firm onl O Contact preparer by mail
® None ® Contact client
& Salutation
& RC59 default level autho
A e e . ® Formal
= Q Casual
& Options
[ Update preparer information on Info form (using the informati
[ Complete preparer information on T1 jacket v
< ' o >
Data Locking Tab

This tab lets you enable a warning that prevents you from accidentally creating a tax file. You can also lock a
file—and prevent additional data entry—once the Client and EFILE status that you indicate in this window is
selected on a tax file. For example, if you click the Completed checkbox in the Client Status column, then ProFile
will lock a tax file once a tax preparer indicates that the tax file has been completed.
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Module Options ? X
12017 T1/TP1 v |l 320152017 T2 w | [ 52016 T3/TPE46 v | @ 82016 Fx ¢ |
File Template
|| I Browse
General Datalocking Variance Disclaimer T1/TP1 Review
[JWarning on file creation Language
Client Status EFILE Status @®English
O Unknown [JUnknown OFrench
[ Canied forward OINoteligible
[JWork in process OJEligi
[JWaiting for client Eligible ]
[CJin preparer review [JReady to transmit
[CJin partner review [ Transmitted
Sﬁﬁﬁgﬁ D[ [JAccepted
[ Completed [INot acr."epted
[JNotfiling [JPaperfiled
Cancel
Help

Setting a client status

e Toseta file’s Client Status, open a tax file and then go to File > Properties.

e Click the Client Status dropdown and select the desired status

¢ Note the checkbox, to the right of the Client Status dropdown, that lets you toggle file locking on and
off
\y 4 2016 T1/TP1 File properties ? X

1. Sanio. Martina

Sanio. Martina (999999998)

Client Status: IS Completed v| [Llocked
0. Unknown

EFILE Status: |1 carried forward -
SEND Status: |2 Woyk in process
3. Waiting for client

TP1 Status 4. In preparer review ~
6. In partner review
T1186 Status. |6. Ready to print i
DCN 7. Printed
Invoice 9. Not filing :
[Discounted?  [JCRA Emors 2139
Date Preparer  Action  Elaps . Module Ver )
17-12-15 ... MDL Created 201702
17-12-16 ... MDL Modffied 201702 v
Preparer.  |MDL Partner
File Name

\IMactHome\DocumentsiMy ProFile Data\2016 T11Sanio. Martina 16T
Online Backup Disabled

Activate Online Backur

Cance

Help Advanced >>




Disclaimer Tab

You may want to add a standard business disclaimer to your tax files to alert readers as to your involvement with

the information contained therein. ProFile lets you set two different disclaimers.

e A general disclaimer, which will appear on the last page of the tax jacket, for the tax return as a whole

e A business disclaimer that will appear on business-type forms such as the T2125 schedule for self-

employed individuals

General Datalocking Variance Disclaimer T1/TP1 Review

Standard Disclaimer

[] |Prepared without audit based on information provided by the
taxpayer.

Business Disclaimer

[ |Prepared without audit based on information provided by the
taxpayer.

Options > Templates

ProFile includes pre-formatted letters that you can print as part of your client’s T1 package. Here is an excerpt of

one such letter.

Jane and Javier Cosan
12 Main St

Anytown, ON

M4A 1A2

Dear Ms Cosan:

We have d your return el to Canada Revenue Agency (CRA) using the EFILE system. The
enclosed copy of your 2016 income tax retum is for your records. We have prepared your return based on the
information you provided to us. Keep all information slips, receipts, and other documents for six years, in case CRA
asks to see them.

Your return shows a refund of $1,761.96.

YOﬁ‘BBSP‘educhon limit for 2017 E 32;}84 - NPPODEA

All of ProFile’s preformatted letters are saved in a templates subfolder within the My ProFile Data folder. To

view and edit any template, follow these steps:
e Click on Options>Templates

¢ Find and double-click the desired template, for example, Letter
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/4 Template Editor ? X

i 12017 T1/TP1 v|id3ems2017 T2 v | (@ 52016 THTPE46 v | @ 22017 FxQ v
Base Template Directory
[iMaciHome\DocumentsiMy ProFile DataTemplates Browse
Name Language  Description Type Filename ~
Aftach English Attachments Default: 2017 T1 Attachments RTF
Engage English Engagement letter Default 2017 T1 Engagement Letter RTF
Userl English User letter 1 Default 2017 T1 User RTF
DLetter English Deceased client letter Default 2017 T1 Deceased letter RTF
User2 English User letter 2 Default: 2017 T1 User2 RTF
Letter English Client letter Default 2017 T1 letter RTF
Qletter English Client letter Default 2017 T1 TP1 letter RTF
Invoice English Clientinvoice Default 2017 T1 Invoice RTF
Qlnvoice English Clientinvoice Default 2017 T1TP1 Invoice RTF
QDLetter English Deceased client letter Default 2017 T1 TP1 Deceased letter RTF v

Template Parameters
Name: Letter M Use defaulttemplate

Description: Client letter

Brint Condition: | T1Info B[]0

File Path 2017 T1 letter RTF Browse

New Edit Template Delete Help Close

The Letter template will open in a new window and it will display text in two different colours;
e Text appearing in blue signifies data that flows from ProFile data fields. Let’s call this type of
information Field Codes
e Blue Field Codes can only be inserted or removed; they cannot be edited from within the template
e Black font represents free-form text—much like the text you enter with a word processor
e Black text can be edited or deleted, and you can also add any additional text to the template

Aral Vo V][ A [¢][ nee [¢|B ru BEEESE 6N
4 1 2 3 4 5 3 N
{Format(PrintDate,"MMMM dd, yyyy")} Al

{T1PreparerName}

{T1PreparerFirm{{i £ T1PreparerPOBox <>"or T1PreparerRR <>"}

{if T1PreparerPOBox= "{T1PreparerRR}{E1se}{if T1PreparerRR ="{T1PreparerPOBox}{e1se}{T1PreparerPOBox}
{T1PreparerRR}{endi f}{endi f}{endi £}

{T1PreparerStreetAddress}

{T1PreparerCity}, {T1PreparerProvince}

{T1PreparerPostalCode}

{ClientFirstName} {ClientLastName}

{if (MailingLabelAddress1 <> "J{MailingLabelAddress1}
{MailingLabelAddress2}

{else)

{MailingLabelAddress2}

{endif}

{i£ MailingLabelPOBox <> " or MailingLabelRR <> " {i£ MailingLabelPOBox ="}{ MailingLabelRR }
{e1se}{MailinglLabelPOBox} {MailingLabelRR}

{endi f}{endi £}

{MailingLabelCity}, {MailingLabelProvince}
{MailingLabelPostalCode}

{MailingLabelClientSalutation}

{if EFILE = 0}

We enclose two copies of your {TaxConstant("CurrentTaxYear")} income tax return. We have prepared your return
based on the information you provided to us. Please mail one copy of the return to Canada Revenue Agency (CRA) in
the enclosed pre-addressed envelope on or before {if (T7info.S[12] <> ™) or (T1Info.B[7] = 1)}June 15,
{TaxConstant("CurrentTaxYearPlusOne")}.{e1se}April 30, {TaxConstant("CurrentTaxYearPlusOne")}.{endif} The
second copy is for your records.

{else)

We have your return ly to Canada Revenue Agency (CRA) using the EFILE system. The
enclosed copy of your {TaxConstant("CurrentTaxYear")} income tax return is for your records. We have prepared your
retun based on the information you provided to us. Keep all information slips, receipts, and other documents for six
years, in case CRA asks to see them.

{endif}

e To add text (black font), place your cursor in the desired area and begin typing



You have undeds d RRSP ibutions of ${UndeductedRRSPContributions} available to carryforward to your
{TaxConstant("CurrentTaxYearPlusOne")} tax return.{i £ NextYearRRSPContributions > 0} You can also make
additional RRSP contributions of ${NextYearRRSPContributions} to deduct on your return {endi f}{endi £}

If you have any questions about your income tax return, please contact me at {T1PreparerPhone}. Or feel free to call ne
at 555-555-121 \
Sincerely yours,

{T1PreparerFirm}

e To add Field Text, right-click the template at the desired input area
e  Click Insert Field

{endif}
{i£ (ChildTaxBenefit Cut
Copy
Total estimated feder dTaxBenefit + T1ChildTaxBenefit[55]} are payable for the
Lo Paste o i
year starting in July { )} and ending in June
{TaxConstant("Currer Clear
{if (NextYearRRSPL jbutions = 0)}
Font...
Your RRSP deductior Paragraph arPlusOne")} is ${NextYearRRSPLimit}. {endi £}

{i£ UndeductedRRSi Tabs
You have undeductec Insert Graphic RRSPContributions} available to carryforward to your
{TaxConstant("Currer xtYearRRSPContributions > 0} You can also make
additional RRSP cgn ?to deduct on your return.{endi £}{endi £}

"ase contact me at {T1PreparerPhone}.

If you have any qu >

Sincerely yours,

{T1PreparerFirm}

e Then, from the Insert Field list, choose the desired field and click Insert

Insert Field X

[Plepavellnilials ] | Insert |

PreparerF ax A

PleEarerFilm Cancel

PreparetName

PrepareriPhone

PreparerPostalCode

PreparerProvince

PreparerStreet

Refund

SigningDate

Spousedddress

Spousedge

Spousedpt v

P, T .

Description

e Click File > Save to save your changes
e And select the location (letter template folder) and enter a file name




il SaveAs X

L QM)/ ProFile Data > Templates , v 0 Search Templates P

Organize v New folder s v o
IS
o Name Date modified Type
s Quick access
@%‘2013MDLT1 letter 2015-01-315:04 PM  Rich Text Format
I Desktop * o
B 2013 T1 joint letter Rich Text Format
¥ Downloads 014 T1 joint letter Rich Text Format
&/ Pictures » B 2014 T1 letter Rich Text Format
4 iCloud * B F2013 MDL T1 letter Rich Text Format
. Dropbox g EL RSI T2 letter Rich Text Format
2016 T1
Autosaved Capti
PendingCapture
Training Guides >
Do,
File name: [ 2016 T1 letter PFTour 2018 ) v
Save as v

A Hide Folders Cancel

e Click Yes to confirm that you want to use this form as the default

Confirm X

0 Use this file as the template for "Client letter"?

No

e To view the finished product, use the Form Explorer to find and open the client’s Letter

4l Form Explorer ? X
il i V|| §
L. Cosan, Maria | W, = E E - Q
Fom: Letter Open  Print  New | List Detal Key Line
Forms Name Category Description Used Lastyear Step (a)
T s Return + sched...  Federal Tax Yes  N/A 344
- e <sg Retun + sched..  CPP on sel-employment and other eamings  Yes ~ N/A 352
1. Identification | ¥ 11 Rletun + sched...  Federal tion and education amounts Yes NA 3
™ 2 slips 7 T183 Filing Information retum for electronic fiing Yes  N/A 388
W 3 Income ﬂ: Engage Client Engagement letter Yes N/
GST Client GST/HST credit Yes  N/A
o educti =
4D 5 T1Summary Client T1 Summary Yes  N/A
W58 Taxscedts | [FNRTC Cliert NRTC Comparative Summary Yes N/
" 6. Retum + sc L, i Letter Client Client letter Yes  N/&
< Audit Client Audit Summary Yes  N/A
TP | v

Letter.Client letter

* You can now preview the changes you made to the Letter template



Maria Cosan
12 Main St
Anytown, ON
M4A 1A2

Dear Ms Cosan:

We have itted your return el lly to Canada Revenue Agency (CRA) using the EFILE system. The
enclosed copy of your 2016 income tax return is for your records. We have prepared your return based on the
information you provided to us. Keep all information slips, receipts, and other documents for six years, in case CRA
asks to see them.

Your return shows a refund of $1,215.04.
You will receive a GST credit of $336.96, payable in quarterly instalments of $84.24 in July and October 2017 and in
January and April 2018.

We estimate that you will receive the Ontario Trillium Benefit of $296.00 in July 2017.

Your RRSP deduction limit for 2017 is $2,145.

If you have any questions about your income tax return, please contact me at (613) 825-3370. Or feel free to call me at
555-555-1212. MDL

e Ifyou’d like to make additional changes, right-click the form and select Edit Template

\/ 4 2016 T1/TP1: Cosan, Maria - Client letter @
@ Linfo | @271 & 3.74] (& 4 T2202/TL11 3. Letter | +

Arial v|1o v Auto l'“ None "‘ BIU EEEE AN
0
1 2 3 4 5 6 7 o
12 Main St| ~
Anytown, ON v
M4A 1A2

Edit Template % >

Dear Ms Cosan:

We have itted your return els ically to Canada Revenue Copy C+C e
enclosed copy of your 2016 income tax retum is for your records. ' Paste Ctril+V  Je
information you provided to us. Keep all information slips, receipts, Select All cti+a e CRA
asks to see them.

Font
Your return shows a refund of $1,215.04. et

Tabs
You will receive a GST credit of $336.96, payable in quarterly instal Insert Graphic and in
January and April 2018.

Insert Break

. . - o Create FX

We estimate that you will receive the Ontario Trillium Benefit of $2¢

Create T3

Carry forward

Your RRSP deduction limit for 2017 is $2,145.

Previous year's return

If you have any questions about your income tax return, please cor call me at
565-565-1212. MDL Close Form e

New Window
Sincerely yours, Print

ame . iney £na casa

In addition to tax and template files, ProFile stores other types of files in the My Profile Data folder. These other
files include EFILE logs, backups, and certain settings file.

= | My ProFile Data - o x
Home Share View (]
& 5 v A4 > ThisPC > Documents > My ProFile Data > v ® | Search My ProFile Data »
A Name Date modified Type Size A
K
# Quick access EFILE 2017-04-176:31PM  File folder
M Desktop 4 Link File folder
¥ Downloads  # Options Package File folder
& Pictures # Settings File folder
QiCoud  # SettingsBackup! File folder
80 Photo Library # SettingsBackup? File folder
fe
B Dropbox SettingsBackup3 File folder
T2 Returns File folder
2016 T1
Templates File folder
68items 1 item selected
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Options>Form Selection

ProFile has a powerful set of tools for enabling the print settings, in either soft or hard copy, that will determine
the tax forms a preparer sends to her clients. For example, rather than printing a complete tax return for each of
your clients (which can run many pages) you might want to print a tax summary with just a few selected
schedules. Here’s how to configure your print settings:

From the Options > Form Selection menu, choose the module and tax year
Choose the print job for the type of the tax return you are preparing for your client—the most common
print job being T1 EFILE =

After printing a return, ProFile lets you choose a default status. For example, once printed, you might
want to set the status of all tax returns to Completed. The window below displays the available types of

file status B

Status after printing

[] Take snapshot
Change the status to

Completed v

Unchanged
Carried forward
Work in process
Waiting for client
In preparer review
In partner review
Ready to print
Printed

Not filing

e Under Form Selection Details, you can choose the specific print set you’d like to prepare. For example,

for each tax return, you can choose to print a copy for your files, your clients and for CRA. It’s here
that you can also determine options such as duplex printing or four forms per page. You can also set

your PDF options here. =
You can rename the prints sets, or add more print sets as well. To do either, just type the desired form

names under Print Set Names [
Scroll through the Form window to select (or deselect) the forms you would like to save or send to

your clients ©

Click Carry-forward to assign last year’s print settings to the current year



4 Form Selection ? X
W 12m7 11T v | 320152m7 12 v | [ 52016T/TPess | [ Z2017Fx v
Print Job Form Selection Details
T1EFILE v N
Status afte printing B BH [T Pitthese sets
[ Take snapshot T F [ [ [F  Achivethese sets (PDF)
Change the status to M B [ [T [ Emaithese sets (FDF)
Conpleied Y D EEEE Duexses
Print Set Names T E F [ [  Reviewmaks
1: [File T E E [ [ 4peipage
[LRITSIT*T#IT™ Language
2 | Client
Find Form:
afee ] ‘ o
BB 1831 Information retur for electionic fiing - pages 1 ~
«f ] oma e Idomaton s fox cecteric - pagee 2
5 B 8 RC71-1 Discounting transaction - pages 1
B G RC71-2 Discounting transaction - pages 2
Printing Tips B 8 2201481 Disabiity tax credit certiicate
fa"viln'vlfavl‘; B E O 5l T2 T1jacket - pages 1.2
L Toautomaticaly carry =
S fommard form seloations, &) 11345 T1jacket - pages 3,45
select the checkbox B O s1 Federal Tax
EEEENE . o CHE| 52 Amounts iansferred from yous spouse
settings'" under 'Options > =] =] s3 Capital gains (or losses)
g:::"z?ﬁe"e""" [z & S3NR Capital gains (or losses)
Next a & S4 Statement of investment income:
(8] S5 Details of Dependant
- & ] s6 Working Income Tax Benefi
@ & s7 RRSP and PRPP Unused Contributions, Transfers.
L I e B B B e " . . o N
Select this job when
[EFILE=1)and(Today>=Date(2002.01.15) ]
7
Canyforward SetDefauts | Cancel Help

Options>Pricing

Tax practitioners likely bill out their work by the hour or by the return. In either case, with its Pricing Schedules,
ProFile lets you choose one method, or both.

In the Pricing Schedule window below, you can:
e  Record your GST Registration Number and tax rates and you can set your invoice numbering
sequence
e Indicate whether you want to provide a detail or summary invoice to your clients =
e  Choose whether to bill by tax schedule or by the hour (=)
e  Establish your per-schedule pricing [

e  Carry forward last year’s pricing to the current year =
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Pricing Schedule ? X
GST Registration Nurnber. [ | GST/HST rate 00
Next Invaice Number: [ ] PST rate 0.000
[J Automatically Increment Invoice Number
@ 12007 TTP 6T1/TP1 3.2015 T1/TP1 TI/TP1 5.2013 T1/TP1 6.201 ¢ |*
Invoice type: Detailed [ ] Brief Invoice by:  [] Schedule [] Hour A
T1 Basic charge paper filed 0.00
T1 Basic charge electronically filed 0.00
S1 Federal tax calculation per schedule 0.00
S2 Amounts transferred from your spouse per schedule 0.00
S3 Capital gains (or losses) per schedule 0.00
S3 Capital gains (or losses) per item 0.00
S4 Statement of investment income per schedule 0.00
S4 S of i income per item 0.00
S5 Eligible / infirm / caregiver amounts schedule 0.00
S5 Amount for an eligible dependant per claim 0.00
S5 Amounts for infirm depend per claim 0.00
S5 Caregiver amount per claim 000
s T C———— Gie
Print Carry Forward Cancel Help

If you bill for your time, you can keep track of billable hours with ProFile’s built-in timer. You'll find the Timer
checkbox on the Edit tab of the Environment option.

Environment Options

Edit Display File Preparer Discounter Trustee Audit  System
Preferences

M Automatic Override [JRight Button Highli
M Audible Override Double Click Ope
M Flyover Memos and Tapes Default Tape Des

Close tape on total
Continuous Forms
[[JForm Explorer Che
Right Click Cut Co
M Auto Insert Memo

Capitalizatio

Saving your Settings

This section described the many ways that you can personalize ProFile’s options and settings. It quickly becomes
evident, therefore, that a complete setup might take hours. Which may lead to the following questions:

e Do I need to do this on every computer in my office?

e Do I have to repeat all these steps every time I install a new instance of ProFile?

e Do I need to repeat these steps if I purchase a new computer?

e How do I prevent someone from making changes to my personalized settings?

Fortunately, the answer to the first three questions is an emphatic “No,” and, in the next few paragraphs, you’ll
learn how to save your settings for future ProFile installations, or share them with other users in your office. First,
though, let’s show you how you can prevent anyone from making unauthorized changes to your settings.



Options>Password
e To protect your option settings, simply enter and confirm your options password.

w4l Set Options/Delete Password ? X
0ld password

New password
Password: l

Confirm: ‘

EFILE Options (including the set up of login
information) are configured through the EFILE >
Options menu.

Cancel

It’s important to safely record and store your options password as the ProFile support team may not be successful
in helping you retrieve it.

Options>Administration

ProFile lets you save the global settings (those described just above) in a folder that’s separate from the program
files. This means if you upgrade or replace your computer, or if you reinstall ProFile, you can easily re-establish
your customized options. In addition, in a network environment, multiple users can point to one uniform options
package that specifies settings such as file location and tax preparer information.

e To view where ProFile stores your global settings, click Options and select Options Administration.

e The window below tells you your settings will be stored in an Options Package subfolder that’s located

within the My ProFile Data folder
e To save your customized settings in the Options Package subfolder, click New. (=) Any new setting

will appear in the Options Package area =

Options Administration ? X

OR My Folder: Apply options from this computer. Leam more

: 2 Shared Folder Load options package highlighted below.

03 Shared Folder. Ask which ontions nackace to load on startun

: Include preparer and discounter name with Option packages
f anges
: Allow multiple Opbons packege groups

Option package directory
mﬂ‘t ocuments\My ProFile Data\Options Package Browse
Options Packages
= E
Delete

Load
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e After click New, enter a name for your customized settings, and click OK
e Your settings are now saved in ProFile’s Options Package subfolder

New Settings ? X

Settings Name

General PF Settings

0K Cancel

Should you, in the future, need to reinstall ProFile, or if you add a new user or computer, return to
Options>Administration and then:

e Select the applicable radio button (in this example, an office of a sole tax preparer)

e Highlight the Options Package =

e Click Load, and ProFile will apply your settings (=)

¢ Note that you can optionally click the Multiple Options checkbox to create more than one package =

Options Administration ? X

@1 My Folder: Apply options from this computer. Leam more

Q2 Shared Folder Load options package highlighted below

Q3 Shared Folder. Ask which ootions oackace to load on startun

[Jinclude preparer and discounter neme with Option packages

rompt to save changes
: Allow multiple Ophons package groups u

Option package directory
\Wac\Home\Documents\My ProFile Data\Options Package Browse

Options Packages
General PF Settings New

Delete

n -




Chapter 2 Quiz

Question 1: True or False: You can install ProFile for a single-user or in a multi-user environment

Correct answer is True

Question 2: ProFile’s Flexible licensing lets you:

E. Allow up to ten simultaneous ProFile users

F. Keep ProFile running in the background

G. Ensure that multiple users have access to their files

H. Install ProFile on multiple computers for non-concurrent usage

Correct answer is D

Question 3: ProFile’s Environment options has features that include:

A. A file tab to indicate the location of saved tax files

B. A tax preparer tab to record names, addresses and other contact information
C. A systems tab to enable Live Community and other online features

D. All of the above

Correct answer is D

Question 4: True or False: You can EFILE tax returns without setting any EFILE Options

Correct answer is FALSE

Question S: True or False: There is an option to lock a tax file and thereby prevent further changes

Correct answer is True

Question 6: What is the key difference between Environment and Module options?

Environment options are used by a tax preparer, Module by a systems administrator
There is no key difference between the two options

Unlike Environment options, Module options are module and year specific

None of the above

oawy

Correct answer is C
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Question 7: True or False: ProFile cannot create PDFs of a tax file.

Correct answer is False

Question 8: True or False: ProFile has an option that lets you invoice your clients

Correct answer is True

Question 9: The ability to save all your option settings is found by clicking:

File > Save Tax Settings
Settings > Options
Options > Administration
None of the above

oCawy»

Correct answer is C

Question 10: True or False: To prevent unauthorized changes to your settings, ProFile lets you create an options
password.

Correct answer is True




Chapter 3: A Tour of ProFile

CHAPTER 3 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:

How to navigate in ProFile using its menus, tabs and icons
How to set various display options

How to use ProFile’s auditor

How to decipher font colours and field symbols

How to enter data

How to use memos and tapes

How to work with the Form Explorer

NAVIGATING IN PROFILE

Tabs, Menus and Tools

It’s easy to find your way around ProFile. No matter the type of return you work with, you will always see the
same ProFile user interface—commonly known as MAUI (Multiple Access User Interface). This means that, no
matter the type of return you are preparing, ProFile’s uniform set of menus, toolbars and tabs make navigation a
snap—and the learning process very short.

/il PROFILE - (2017 T1/TP1: Taxpayer, Amy - Personal information] - o x

Vil File Edit Audit Goto Form Options EFILE Online Training Window Help &
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Tabs

Every time you create a tax return, ProFile displays a tab for each open form. You’ll see the tabs just above the
form you’re currently working in, and you can navigate to any open form by clicking its tab.

V\File Edit Audit Goto Form Options EFILE Online Taining Window Help

g N e QBR[| wE
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T1 GENERAL 2017

Income Tax and Benefit Return '

\vdl PROFILE - [2017 T1/TP1: Taxpayer, Amy - T1 jacket] ‘
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You have the option to display the form name and icon on each tab, or just form name itself. Go to the Display tab
of the Options>Environment window to choose your preferred setting.
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The Menu Bar

As with all software applications, you can use the Menu Bar to navigate in ProFile. With its extensive set of menu
commands, you can, for example, create or open tax files, setup preferences, arrange windows, and jump to
specific areas of a tax file.

4l PROFILE - [2017 T1/TP1: Taxpayer, Amy - Personal information]

w4 File Edit Audit Goto Form Options EFILE Online Training Window Help

The Toolbars

Toolbars are a set of icons that let you quickly and easily move around in ProFile. There are three configurable
toolbars that you can enable (or disable) in ProFile.

* You can view the three available toolbars by clicking Options>Toolbars
o The three toolbars are: Audit and review marks, Forms and Shortcuts

|4l PROFILE - [2017 T1/TP1: <NoName> - Personal information]

Vi File Edit Goto Form Options EFILE Online Training Window Help

-3 '\ v id Environment... - Q ’—“l E]
@ 1info |@2T1| (31

Module..

Database...

Templates...

Form Selection...

Pricing...

Integration...

Customer Experience Program...
Options password...

Options Administration...

Language >

Toolbars > ¥ Auditand review marks
Pause Timer Cfrhh v Forms
¥ Shortcuts

e The Audit and review marks toolbar lets a partner or preparer approve or request changes to any line on
a tax return. We’ll discuss review marks a little later in this chapter

w4l PROFILE - [2015 T1/TP1: Taxpayer, Amy - Federal Tax]
Options EFILE Online Training Window Helg

Sl |05.Info| [ 5 Summary | @ 6.58 | (7.4 | 4

e The Shortcuts toolbar features icons that let you, quickly jump to a specific area. With shortcuts, you
can, for example, create or carry-forward tax files, find tax forms, toggle between spousal returns; print
single schedules or complete returns; open additional forms; and view file properties

w4l PROFILE - [2015 T1/TP1: Taxpayer, Amy - Personal information]
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e The Forms toolbar, or JumpBar, is a customizable area on the toolbar that lets you add a favourite
form—making it “stick”—and rendering it available in any tax file. Once you add a form to the
JumpBar, it becomes a mouse click away on every tax return that you open.

e To add a form to the JumpBar, click and hold the form’s tab, and then drag it over to the JumpBar

w4 PROFILE - [2017 T1/TP1: Taxpayer, Amy - T1 Summary]
w4 File Edit Audit Goto Form Options EFILE Online Training Window Help
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Display Options

On the toolbar below, the Spousal icon indicates that two tax files are open (one for each spouse). Clicking that
icon will toggle between the spouses’ returns, and display each one on your monitor in turn.

‘ p: = =

v"\vuo «

e Ifyou prefer viewing both spouses’ files at the same time, click the 7ile icon to view each tax file, tiled
horizontally one above the other

'-"'\'Ho °~

p = =

\/ 4 2016 TI/TP1: TaxPayer, Gavin - Personal information
@ 1.Info |EIZ-T‘ |e314|8at5| 0513 + |

2016 Personal information

Taxpayer personal information Marital status
SIN 444 444 442 Indicate your marital status on December 31, 2016
Title Mr 1 [X] Married 2 [ Living common-aw 3 [] Widowed
First name Gavin - -
e 4| | Divorced 5 || Separated 6 [ | Single
Last name TaxPayer - D - D P - D ¢
Last name changed in 20162 D Yes No If status changed in 2016, enter date of change mm-dd }
Do you want to change your address? [l Yes No | Were you married or living common-law at any
Care of time in this tax year? [ Yes D No
Street address 12 Main Apt # Residency
P.0Box IRR . .
Cty  Ottawa Province of residence
Sy otaw on 2016/12/31 Ontario
Province ON e . |
Postal codeKOA 1A1 Province of self-employment
(SR If you became or ceased to be a Canadian resident in
Home phone _ (613) 555-5555 2016, enter date of: entry mm-dd
| Bith date 1965-10-10 | 51 or donarturm mm.dd
EFILE: Not eligible Balance/Refund 7.830.41 GST Credi
va-

@linfo |@2s |@3T|8aTe|85T5| + |

2016 Personal information

Taxpayer personal information Marital status g
SIN 990 099 008 Indicate your marital status on December 31, 2016 ‘
Title Ms 1 [X] Married 2 |:| Living common-law 3 D Widowed
First name Amy 4[] o .
— ivorced Separated Single
Last name Taxpayer - D g D P B D ¢
Last name changed in 20162 D Yes No If status changed in 2016, enter date of change mm-dd
e . DN
Do you want to change your address? N | Yes No | Were you married or living common-law at any
Care of time in this tax year? Yes D No
Street address 12 Main Apt # Residency
PO Box IRR . °
City  Oftawa Province of residence
o on 2016/12/31 Ontario
Province ON Bl ProvnceotsekEemplonmentiil
Postal code _KOA 1A1 Province of self-employment
Gasmnie If you became or ceased to be a Canadian resident in
Home phone _ (613) 555-5555 2016, enter date of: entry mm-dd
| Bitth date 1977-06-06 0 Age 39 or donarura_ mm.dd

EFILE: El e/Refund 5,972.94 GST Cre
O VR it e ,M
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e Ifyou use multiple monitors, you can display one file on each screen, Click the Launch icon to create a
floating window for the second file, and then then drag it over to your second monitor

"3W-Q 0 & Q]2 S laE-a QR e
T

@linfo |25 |@3T|BeT4]|B5T5| +

|
2016 Personal information

Info

Taxpayer personal information [
SN 090 999 998 Indicate your marital status on December 31, 2016
Title Ms i 2016 T1/TP1: TaxPayer, Gavin - Personal information - o x
Firstname Ay
SstEomem Taxpayer Fle Edit Audt Goto Form Window
Last name changedin 2016 __[]Yes [X]No =0 ‘ > -5 Q‘ mOEAvvX?@
Do you want to change your address? [Wyes
Care of Ol @ | 214|bats| 13| + |
Street address _ 12 Main Apt# | " o
20 Box [ 2016 Personal infor

ity Ottawa
Yo Marital status
e pal sn 444 424 442 Indicate your martal status on December 31, 2016

p 5555555

Birth date 1977-06-06 [ Title Mr 1 [X] Married 2[] Living common-taw  3[]V.

ate of Death _yyyy-mm-dd ["5‘ name ?a‘/;" 4[Jovorced 5[] Separated s(s
Gender __ [Jusle [l Eomale s name = aver7 If status changed in 2016, enter date of change
Province or teritory where taxpayer resides if different from my | Last name changed in 2016° Yes  [x|No
address Do you want to change your address? [Wyes [XHNo | Were you married or living common-law at any
By providing an email address, | understand Care of timeinthistaxyea?  []ve
1 am registering for online mail and accept Street address 12 Main Apt# etaency
the following Terms and Conditions. [Wyes [N | P.0-Box IRrR D
et o b on 2016112731 Ontario
Use preparer address for R 04 1A1 Province of selFemployment

Nothing [ ] Notice of Assessment and Refund [N ifyou became or ceased to be a Canadian resident in

s T T T e N T

Home phone _ (613) 555-5555 2016, enter date of
(011 maling address Bifth date ___1965-10-10 Nage 51 o
s vy o
EFILE this retum? Yoo [||Gender e (] omale
EFILE multpl years? []es [j| Province or territory where taxpayer resides if diferent fiom maiing | Are you a non-resident? Oye
‘Authorization for efiler to represent taxpayer? Yes address R Resident
e sre20162 Yes [} | By providing an email address. | understand SRR
I'am registering for online mail and accept [CERTNCGHERES IS R
Method of contact for:  Pre-assessment  Post-assess| Did you dispose of a property (or properties) in 2016 for
the following Terms and Conditions. [Myes Ono
Contact preparer by mail claiming a principal residence exemption? Ye
Contact client B I
Is retum discounted? [Jyes Use preparer address for.
Is retum completed under the CRAS Nothing [ ] Notice of Assessment and Refund [ ] N of A
volunteer program?. [Jyes 74 maitine addeace v
Were you confined to a prison or similar institution b L
for a period of 90 days or more during the year? EFILE: Not eligible 7.830.41 GST Credit 0.00 Combined ... 13,803.35 +
(Sehortula & OWATA £ ST 1 WST Crority [ vas VTN CHiearimm ST AY slarimm o v marie T
[ S——— L Qg SN S T

® You can also use the Windows menu to cascade, tile or manually arrange your open windows

V4 PROFILE
File Edit Audit Goto Form Options EFILE Online Training =Window Help

~3IW-EH 0 4

p Tile Horizontally

Cascade

Arrange
Launch Current Window

+ 12016 T1/TP1: Taxpayer, Amy - Personal information
22016 T1/TP1: TaxPayer, Gavin - Personal information

The Auditor

ProFile comes with a comprehensive auditor that constantly scans a tax file and alerts you to missing or erroneous
information. ProFile’s auditor also makes suggestions for optimizing a tax return, and it reminds you about
memos you may have entered, amounts you may have calculated, or review marks that you annotated on a tax
return. ProFile, in fact has two types of auditors. Let’s look at each one.

The Passive Auditor

As you work on a tax file, the Passive Auditor constantly scans the return and, when it detects a potential error,
highlights that area of the tax file with a yellow background. When you move your cursor over that yellow field,
the passive auditor opens a context-sensitive message. Here is an example of a passive audit message:

¢ In the example below, ProFile’s Passive Auditor highlights Box 16 of an indvidual’s T4 slip. When
hovering your mouse over that field, an audit message opens and cautions you that the entered CPP
amount differs from CRA’s suggested value, the auditor suggests that you verify the highlighted
amount



4 PROFILE - [2016 T1/TP1: TaxPayer, Gavin - Statement of remuneration paid]

r3IN-EH0 d(4 & <

@ Linfo | @21 32-74|k;.g,13| «
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4 File Edit Audit Goto Form Options EFILE Online Training Window Help

EHEIEY T

gatemem of Remuneration Paid T4 Sli D
4 ota

p
>

Description NEWCO I I
Province of employment Ontario I I i
Employment income 99,918.00 0.00 0.00 0.00 99,918.00
Employee' ibuti CPP 2,755.00 0.00 2,755.00
QPP 0.00 [ [T#Box 16 (CPP premiums) may be incorrect. CRAs [ o ool 0.00
El premiums 955.00 [ formula suggests $2,544.30. Please check. 0.00 955.00
PPIP 55 0.00 0.00 0.00 0.00 0.00
Exempt CPP/QPP 28 No No No No
El No No No No
PPIP No No No No
Employment code
RPP ibuti 0.00 0.00 0.00 0.00 0.00
Pension adjustment 0.00 0.00 0.00 0.00 0.00
Income tax deducted 15.841.00 0.00 0.00 0.00 15.841.00
El insurable earnings 50,800.00 0.00 0.00 0.00 50.800.00

CPP/QPP pensionable earnings 54,900.00

0.00

0.00

0.00

54,900.00

0.00
0.00

PPIP insurable eamings
Union dues

SE3RRRNR Y

0.00
0.00

0.00
0.00

0.00
0.00

0.00
0.00

Charitable donations
Other information

[ Y T —

0.00

0.00

0.00

0.00

0.00

Other examples of ProFile’s Passive Audit messages include:

e Missing data that is necessary for filing

e Missing EFILE information
L]

L]

L]

L]

L]

¢ Planning opportunities

L]

The Active Auditor

Amounts on tax slips that fall outside the tolerance range (as in the CPP example above)
Opportunities for additional claims (for example, the taxpayer is eligible for a disability amount)
Claims that may be more beneficial on a spouse’s return

Filing requirements specific to a return (taxpayer subject to minimum tax)

Suggestions to reduce a claim (excessive RRSP deduction or unnecessary CCA claim)

Other forms or elections that may be necessary but have not been included in the tax file

The Active Auditor displays a list of audit messages that apply to the current tax file. These include passive audit
messages mentioned above, as well as notices or processing errors, EFILE messages, fields with memos or
calculations attached, overridden fields, or fields with review marks attached.

To display the Active Auditor, click its toolbar icon

Auditor displays at the bottom of your screen.

&

or just press F'9 on your keyboard, and the Active
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T1 GENERAL 2016

Income Tax and Benefit Return

Step 1 - Identification and other information
o [7]

letssasasz |

1 2 above)
990 008
Amy

0247301

ontaro ]

000

fromine 213 f e o per et 000

Overides / Memos % FLE W TI13S 35 Oninechange = Datoimpont = Coryfowerts & Topes A Vaand |

000 [Combined baance 1380335 +

Note the tabs in the audit window. These tabs include:
e Warnings that indicate potential processing problems, including messages about data may have been
overlooked— for example, a slip with no recorded information
e Notices that alert you to important dates or deadlines. Notices also alert you to amounts that fall outside
a calculated range
Sign-offs which display Review Marks that a partner or tax preparer added to the tax return
Issues for any field that has a correction or question review mark attached to it
Overrides that alert you to a change that you made to a field’s calculated amount
Memos to remind you that you attached a note to a field in the tax file
EFILE warnings to prevent you from EFILING a tax file. In addition, any messages originating from
CRA, after an EFILE was processed, will appear here.
Carry forward that lists all the data brought forward from a prior year’s return
Tapes that highlight a field where ProFile’s calculator was used
Variance that highlights any changes made after you took a snapshot of the tax return
Data Import that lists taxpayer data imported using CRA’s Auto-fill My Return
Summary which consolidates all messages from the other tabs.

Acting on audit messages
e To act on an audit message, double click the message.
e ProFile will open the applicable form, circle the item and add a yellow background to the field

@b |@2T|@3T4 B5T5 |@aT3| 4 |

D
>
Description \
% reported by spouse 42 00 00 00
% reported by taxpayer 0 00 00 00
Currency
Exchange rate to convert to Cdn §
Eligible didends | Actual Amount u 0.0 0.0 0.0 0.0 0.00
| Taxable Amount 25 0.0 0.0 0.0 0.0 0.00
Interest from Canadian sources 13 0.0 0.0 0.0 0.0 0.00
Source of Box 13 interest (for EFILE) 1/Bank 1/Bank 1/Bank 1/Bank
Capital gains dividends 18 | 0.00 0.00 0.00 0.00 0.00,
Dividends Actual Amount | 10 | 0.00 0.00 0.00 0.00 0.0
Taxable Amount 0.00 0.00 0.00 0.00 0.00
Other income from Canadian sources 0.00 0.00 0.00 0.00 0.00
lame of foreign country
Foreign income 15 00 00 00 00
Foreign tax paid 16 00 00 00 00
Royalties. Work or invention | 47 00 00 00 00
Other 00 00 00 00
Accrued income: Annuities 19 00 00 00 00
Box 19 received due to death of spouse? No No No No
Equity linked notes | Current year » 0.00 0.00 0.00 0.00
interest | Prior years 0.00 0.00 0.00 0.00
@ Summary A\ Wamings @ Notices + Sign-offs ¥ lssues Overrides Memos W EFILE W T1135 = Online change = Dat

Y
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Personalizing ProFile’s Auditor

Options>Environment
Chapter 2 described how Options>Environment allows you to personalize ProFile to meet your requirements. The

Audit tab, also found under Options>Environment, lets you choose how you’d like to work with ProFile’s
Auditor. From this window, you can:

Environment Options ? X
Edt  Display File Preparer Discounter Trustee Audit  System HyperDocs PDF  Notifications . . . .
S — e Enable or disable features such as the Passive Auditor, review marks and
[ Display Review Marks [ Show Auditor Tabs o
Do B circled fields
A x| B .| ®Choose the information to display on the Summary Tab of the Active
(7] Noti Notices
Drarerseant e Auditor
] o Careammitats . . . .
Mo el e Determine the audit messages that will prevent ProFile from EFILING a
(] Memos v £ Memos v
Prevent Fing return
We ) Memos . .
$EipEre eRemove audit messages on partner or preparer sign-off
B
Remove Audit Messages
4 0n Preparer Sigrvoff On Partner Sign-off
Office Info Setup wizard Cencel Help

PUTTING IT ALL TOGETHER

Getting Started

Up to this point, you learned about ProFile’s set-up options, and you also read about ProFile’s design, and its
features and functions. In this section, we’ll tie all that information together and show you how those features help
you become an effective and efficient tax preparer.

Where to start

Invariably, you will start by either creating a new tax return or carrying forward a file from the previous year, and
you accomplish either of those tasks by clicking the appropriate icon on the toolbar.

lv 4 PROFILE
File Edit Audit Goto Form Options EFILE Online Tr

'1"Ho ‘\/@

File New arry forward a previous year file (Ctrl+ R)|

Over and above its own prior-year files, ProFile lets you carry forward files prepared in other tax applications
including TurboTax, CanTax and TaxPrep. In addition, you can carry forward DT Max files by clicking, File
> DT Max Carry Forward.
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v
i Carry forward file X
i 2201511 v| a2 | @513 v |Egeamerx vy
Look in My ProFie Data V] & ex o
Retumns Name Size Item type Date modified A
a esort File folder 20161227104,
199711 File folder 20161226114,
ST 199871 File folder 20161226114,
1999 Fie folder 20161226 11:4
A 193971 Fil foder 2161226114,
> 193913 Fil foder 161226114,
2000FX File folder 2016-12:2611:4,
200071 File folder 2016-12:2611:4,
200013 File folder 2016-12-2611:4. A
File name: ~ Carry forward
Files of ype: 2015 Profile T1 (-15T) ~ Cancel
Help
5 TaPrepln)
2015 Profile 11 (-157)

Whether you start with a new or carried-forward return, here are a few things to keep in mind:
e ProFile opens a tax file at the Personal Information page. This is where you enter the taxpayer’s
contact information, as well as residency, marital status and other information
e ProFile automatically opens other forms and schedules, such as the T1 Jacket. You can tell which forms
ProFile opens by glancing at the forms’ representative tabs
e The yellow fields denote the Passive Auditor’s warnings about missing information

vl PROFILE - [2016 T1/TP1: <NoName> - Personal information]
Vi File Edit Audit Goto Form Options EFILE Online Training Window Help

Q| [# - B - QE R | EE

@ 1.Info ‘mg.n | &34

2016 Personal information

SN — Indicate your marital status on December 31, 2016
Title 1 [ Married 2 [ Living common-aw 3 [[] Widowed
First name 4[]Divorced 5[] Separated 6 [X] Single

Last name

Last name changed in 20167 __[]Yes ] No If status changed in 2016, enter date of change mm-dd
Last name changedin 20162 [ ] N

Do you want to change your address? [Wyes No | Were you married or living common-law at any

Care of time in this tax year? Yes [INo

Street address Apt# Residency
P.0_Box HRR

Cit Province of residence
Gty on 2016/12/31 NA l

Province
Province of self-employment

Postal code If you became or ceased to be a Canadian resident in

Birth date Yyyy-mm-d B Age 0 or departure  mm-dd

Date of Death _ yyyy-mm-dd

Gender [ male []Eemale

Province or teritory where taxpayer resides if different from mailing | Are you  non-resident? [ Yes No
address Residencystatus________ Resident

By providing an email address, | understand Country (other than Canada

I am registering for online mail and accept P

e L CHyes Oto Did you dispose of a property (or properties) in 2016 for which you are

claiming a principal residence Yes []No
Email address |

Use preparer address for
Nothing [ ] Notice of Assessment and Refund [ ] N of A

[ 11 mailing address
EFILE this retum? B Yes [INo  Are you a Canadian Citizen? [ Yes Huo
X
]

IX] No Provide information to Elections Canada? [ Yes
No Did taxpayer own foreign property at any time

EFILE multiple years? Yes

for efiler to represent taxpayer? Yes

Home phone () - 2016, enter date of entry mm-dd )

First time filer in 20162 Yes [X] No in 2016 with a total cost of more than

Method of contact for:  Pre-assessment  Post-assessment ~ CAN$100,0007

Contact preparer by mail L Is taxpayer's income zero?

Contact client Claim disability amount?

Is retum [ yes No If yes. is this a first year claim?

Is retum completed under the CRA's Mentally o physically infirm?

volunteer program? [ yes No Indian within the meaning of the Indian Act?
Wgiaam et dto 520 B i <

Entering data
e Even though ProFile automatically opens the tax jacket, it’s important to note that you enter data on
supporting forms and schedules, and not directly on the jacket itself.
e  When you click on the 74 tab (from the window above), ProFile will launch the 74 Slip window which,
after you enter an employee’s earnings, will look like this



/4 PROFILE - [2016 T1/TP1: Taxpayer, Amy - Statement of remuneration paid]
Vi File Edit Audit Goto Form Options EFILE Online Training Window Help
-r3AN-gd O Q[7 @ - -6 - QB R E s
@ lLinfo| @251 |[@3T 84T4 \ asTs| + |
Description I I
Province of .| .|
income | | ooo i 88,999.00
Employee's CPP | | ooo i 2,545.00
QPP 17 0.00 000l 000l 0.00 0.00
El premiums | 18 944.00 000l 000l 0.00 944.00
PPIP 55 0.00 0.0 0.00 0.00 0.00
Exempt CPP/QPP | 28 No | [ No No
El No INo No No
PPIP |___[No No No No
Employment code [2]
RPP contributions 20 | 0.00 0.00 0.00 0.00 0.00
Pension adjustment 0.00 0.00 0.00 0.00 0.00
Income tax deducted 15,321.00 0.00 0.00 0.00 15,321.00
El insurable eamings 52,000.00 0.00 0.00 0.00 50,800.00
CPP/QPP pensionable eamings 54,900.00 0.00 0.00 0.00 54,900.00
PPIP insurable earnings 0.00 0.00 0.00 0.00 0.00
Union dues . 0.00 0.00 0.00 0.00 0.00
|| Charitable donations 46 0.00 0.00 0.00 0.00 0.00

Colours, Diamonds and Arrows

Learning about colours
A close glance at the window above reveals fields that have different font colours. Here’s what those colours
signify:
Fields with...
e Purple fonts denote data carried forward from a prior year
e Black fonts are for direct data entry =
¢ Blue fonts indicate a field calculated by ProFile [
e Red fonts mean that you overrode a calculated field (=)

e Green fonts denote a row or column total g

Arrows and Diamonds
The right edge of certain fields may display an up-arrow, a down-arrow, or a diamond. Here’s what those
diagrams signify:

e Ifa field displays a down arrow, then a dropdown menu exists for that field

Information about your residence,
Enter your province or territory of
residence on December 31, 2016:

Enter the province or territory where
you currently reside if it is not the

same as your mailing address above:

If you were self-employed in 2016,
enter the province or territory of
self-employment:

British Columbia
Alberta
Saskatchewan

Manitoba

Ifyoub or d to be a ¢
enter the date of:
Month/Day
entry mm-dd

Month/Day
or departure mm-dd

e When a field displays an up arrow, it means the data in that field originates from another form. In
addition, ProFile displays amounts in those fields in blue font




e  When a field has an up-arrow view, double-click it (or press F6) and ProFile will jump to the
referenced form
Step 2 - Total income

As aresident of Canada, you have to report your income from all sources both inside and outside canada
When you come to a line on the return that applies to you, go to the line number i G

income (box 14 of all T4 slips) 1“1 88,999 00f"| ’

Commissions included on ine 101 (box 42 of all T4 slips) 102 ofoo |

Wage loss replacement contributions

(see line 101 in the guide) 103] oloo §

Other employment income 104] 0/00
0ld Age Security pension (box 18 of the T4A(OAS) slip) 113 0/o0
CPP or QPP benefits (box 20 of the T4A(P) slip) [114] 0loo
Disabilty benefts included on line 114

(box 16 of the TAA(P) slip) [152] oloo |§

Other pensions and superannuation
Elected spit-pension amount (attach Form T1032)

Universal Chid Care Benefit (UCCB)

UCCB amount designated to a dependant

Employment insurance and other benefits (box 14 of the T4E siip)

Taxable amount of dividends (eligble and other than eigible) from taxable Canadi
corporations (attach Schedule 4) Description
Taxable amount of dividends other than eligible dividends,
included on line 120, from taxable Canadian corporations
Interest and other investment income (attach Schedule 4) Province of employment
income .
Net partnership income: limited or non-active partners only Employee’s contributions g’;’: :: 2 54g gg g gg
R | I
egistered disabilty savings plan income (1 promiums [181] 44,00 .00
Rentalincome Gross [160 oloo £ ‘ggl:/opp %N 0.00 - 0.00
xempt o o
Taxable capial attach Schedule 3 t
‘axable captal gains (i chedule 3) = o N
Support payments received Total [156] 0loo = — |PPIP . No No
mployment code
RRSP income (from all TARSP sips) RPP 2 ) )
Lo Spacky; Pension 52 0.00 0.00
e e income tax deducted 2| 1532100 0.00
El insurable eamings 2 52,000.00 0.00
CPP/QPP pensionable eamings 26 54,900.00 0.00
PPIP insurable eamings 56 0.00 0.00
Union dues 44 0.00 0.00
Charitable donations 46 0.00 0.00

Overrides
If you decide to override a calculated field, ProFile does two things; it displays a red diamond in that field, and it
also displays the overridden amount in red font.

4

Description ALGONQ
Province of employment 10 |Ontario
Employment income 14 88,999.00 0.00
Employee’s contributions | CPP 16 2,545.00 0.00

QPP 17 0.00 0.00

El premiums | 18 944.00 0.00

PPIP 55 0.00 0.00
Exempt CPP/QPP 28 |No No

El No No

PPIP No No
Employment code 29
RPP contributions 20 0.00 0.00
Pension adjustment 52 0 0.00 |
Income tax deducted 321, 0.00
El insurable eamings 24 | 52,000.00 0.00
CPP/QPP pensionable eamnings 0.00
PPIP insurable eamings 56 0.00 0.00
Union dues 44 0.00 0.00
Charitable donations 46 0.00 0.00

Overrides are great for “what if?” scenarios. After you complete your what-if analysis, just press the F2 key to
cancel the override and return that field back to ProFile’s original, calculated value.



Memos and Tapes

ProFile’s memos are great for embedding notes and reminders into any field on a tax return. And you can use
ProFile’s calculator to add up a series of numbers and enter the total into any field of the tax return.

Using Memos
e Torecord a memo, click into any field

e Press the F8 key
e Type in your note
e Click OK

4 Memo ? X

Ask client to confimr this amount

[ Canry-forward to next year Insert Date Stamp

Review Mark
@None O Preparer (O X Enor
O Partner (O7? Question

0K | Cancel Clear

Using Tapes
e Touse Tapes, click on a field

e Press CTRL+FS8
e In the window that opens, enter a description (optional), and a value on each line
e Press the = key and ProFile will paste the sum directly into the selected field

vl Tape ? X

| +/- 0.00

[ Descriptions M Post Decimals 2
[ Camy-forward descriptions

Ok Cancel Clear

When you record a memo, or use a tape in a field, ProFile puts a green background in that field. To display the
underlying memo or tape, just hover your mouse over that field

Il - Carrying charges and interest expenses
Accounting fees
M or safe custody fees
Investment counsel fees
Reported on T5013 slips

0
0
0
0
0
Legal fees paid to collect, establish or increase the amount of support payments 0
Interest on money borrowed to earn interest, dividend, and royalty income _I
Interest on money borrowed to acquire an interest in a limited partnership or a partnership in which you are not
an active partner:

+ o+ o+ o+

Tax shelter 0Joo
Rental and leasing property 0|00
Resource property 0

0

Enj is amount on line 221 of your return.
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Finding What You Need

When preparing a tax return, you will, of course, want to work with additional forms and schedules. And, given
you don’t enter data directly on the tax jacket, this means you have to find those supporting forms and schedules

somewhere in ProFile.

The Form Explorer

Though ProFile’s toolbar includes a Search field that lets you enter the name of the
form or schedule that you need, you may want a little more horsepower than that.
You may indeed want to use The Form Explorer.

If you don’t know the name of the form that you’d like to open; if you only know the line number you’d like to
access; if you’d like to see the forms that were used on this—or the prior year’s—return, then Form Explorer is

for you.

e To open the Form Explorer, click on the Filing Cabinet icon, or just press your keyboard’s 4 key

Category
Identification

Description

Personal information

D dant information

4l Form Explorer
‘ Taxpayer, Amy
ufom |I
Forms Name
1. |dentification @i
§5D
25K @ CanyfwD
3. Income (& T2202/TL11
4 Deductions | B T3
“T4
5 Taxroedts | o
6. Retum + sch. & T4A0AS
1 Fiing S T4aP
o T4ARCA
8. Client <
[Macen =] |
T & T4PS
1 || (& TamiF

Identification
Slips
Slips
Slips
Slips
Slips
Slips
Slips
Slips
Slips
Slips

Canyforward Summary
Tuition and education credit certificate
Statement of trust income

Statement of remuneration paid

Statement of pension, annuity and other in...

Statement of Old Age Security

Statement of Canada Pension Plan benefits

Statement of distributions from a RCA

Statement of Employment Insurance and
Statement of profit-sharing plan allocations.

Statement of income from a RRIF

?

List | Detail
Used Last year
Yes  Yes
No  No
Yes No
No No
No No
Yes  Yes
No No
No No
No  No
No  No
No No
No No
No No

Gd &

X

Key Line

Step A

e Ifyou use Windows Explorer ™, you’ll be comfortable with ProFile’s Form Explorer
e The right pane of the Form Explorer window includes column headings for each form’s full name, its

category, and its description
e Notice, too, for carried forward files, the Form Explorer indicates whether a form was used in the

current or prior year =

¢ In the left pane, you’ll find folders that let you filter which forms to display =

e To find a form, just type its name in the search field =

Form Explorer Icons

There are four icons at the top right of the Form Explorer window. These icons provide view options. The bullets
below explain each icon’s purpose:



4 Form Explorer
Taxpayer, Amy v] Lo ’?:: %:-:: b4 }. )
IFom: | | List Detal Key Line
Forms Name Category Description Used
1. Identication | @ 'nfo Identiication Personal information Yes  Yes 1
- #% Dependant Identification Dependant information No No 3
2 Shps [/ ] CamyPwD Identification Caryforward Summary Yes No 4
" 3 Income (& T2202/TL11 Slips Tuition and education credit certificate No No 6
W 4 Deductions | B T3 Slips Statement of trust income No  No 7
; o . 14 Slips Statement of remuneration paid Yes  Yes 8
SUECERLE (5 T44 Slips Statement of pension, annuity and other in...  No No 9
™ B Retum +sch.. | (4 T440AS Slips Statement of 0ld Age Security No  No 10
™ 7. Filing s T44P Slips Statement of Canada Pension Plan benefits  No No 1
WgCkn -] | BT4RCA Slips Statement of distibutions from & RCA No Mo 12
- & T4E Sl Statement of Employment | d. No N 13
m TS Sipe Ststement ofposhang ln slocstons . No Mo 14
TP1 o T4RIF Slips Statement of income from a RRIF No No 15 v
e As the name implies, the Detail view provides complete information, such as category and description,
for each form.
e The List view gives you a simplified view where all forms are displayed as icons.
e The Key view lets you use keywords to find the required form. This view is ideal when you know what
information you’re searching but you’re not sure of the form’s name.
e Lastly, the Line view provides a line by line listing of all available forms. You find a form, in this view,

by entering a tax line number in the Form field

One more thing
e If you right-click inside the Form Explorer window, you will open a dialog box that lets you choose
whether to print, open or sort the Form Explorer view. Y our options include sorting by name, category,
descriptions, step or by whether the form was used

4l Form Explorer ? X
Taxpayer, Amy v l ) [T B B 4 T.
Fom:[T4 || gpen Print List Detail Key Ling
Forms Name Description Used Lastyear Step A
i - T Yes  Yes 8
2 Slips A ST g peeYes Yes (8
h Open Fs [ Yes  Yes 17
3. Income BT Open in new Window Ctrl+Alt+F6
4 Deductions a7 Print
5 Taxscredts | T i
. 8T Check all
6. Retun+sch... | -
- T Uncheck all
7 Filing BT
8. Client B View
3.l - T Arrange lcons by Name
W A Used _:I Properties by Category
™ B.Dataentered | (& T101 Statement of renounced resofyce ex Y Description
C. Last year | T5008 Labour-sponsored funds tax cigdit by Used
| T5007 Statement of benefits
(% T5008 Statement of securities transaction: S
5 T5013 Statement of partnership income
Ll (& S3Details Capital Gains Entry No  Neo 28
1 | S3PrincipalResi.. $3 Principal Residence Detail No No 29 v
[T4:Statement of paid

The Data Monitor

As you add information, and append more forms to the return, ProFile constantly updates the taxpayer’s tax
status. At the very bottom of the window, ProFile displays an at-a-glance summary of the taxpayer’s tax status.
This display is called the Data Monitor.

As you can see in the example below, the Data Monitor reveals that the taxpayer owes $5,972. In addition,
because it is a spousal return, it also shows that the combined amount owing is $13,803. The Data Monitor
reveals other information too, including available GST credits and Internet Filing eligibility.
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/4l PROFILE - [2016 T1/TP1: Taxpayer, Amy - T1 jacket]

FIN-E0

@ Linfo | @ 2.51 @an ‘,;514\ [r

Vi Fie Edt Audt Goto Form Options EFILE Oniine ToRwng Window Help

AP E e

815| @5T5| + |

-t ) @ e e | J

- o X

-8 x

Protected B when completed A

l *I =

“Agence du revenu
du Canads

Income Tax and Benefit Return

T1 GENERAL 2016

Ident

Step 1 - Identification and other information

ion

Print your name and address below. Enter your social nsurance number (SI) [099 999 998
Frstname and ntal YoarionthDay
A - of bith 1977-06-06
Lastname

Taxpayer Your language of correspondence: Engish  Francais
g s g St e e e ]
12 Main ']

70 Box R P

Gty ProvTerr._Postal Code

Ottawa Blon § koA 1a1 ]

]  prveg a0
e b e e ooes o e 1 o1 e i
g o E x|

Enter an email address:

for online mai. | have

§ 4[Joworces 5[] separatea

Enter your province or terrtory of
residence on December 31, 2016:

Information about your residence

Enter the province or tertory where

You currently reside if ¢ is not the
same as your b

i R L

6[Jsnge

Ontario [} common-law partner (if yo
Enter his or her SIN
Enter his or her first name:

] Enter his or her net income for 2016

f you were self-employed in 2016,
enter the province or territory of
self-employment

to claim certain credts:

Enter the amount of universal chid care
beneft (UCCB) from ine 117

Information about your spouse or

u ticked box 1 or 2 above!
444 444 442

Gavin

104.017.14

OOOI

SO & o< ieet of € anata for incnme tay nurnnass in 2048 | - -
&_vodied EFILE: Eligible Balance/Refund 5,972.94 [GST Credit 000 [Combined balance _13;
— —

Customizing the Data Monitor
You can customize and add information to the Data Monitor.

e For example, to display line 150, just highlight it [

e  Click the “+” sign at the bottom of the window [=]
e You have just added Line 150 to the Data Monitor =

\vdl PROFILE - [2016 T1/TP1: Taxpayer, Amy - T1 jacket] - u} X
VA Filk Edit Audit Goto Form Options EFILE Online Training Window Help - & x|
. .o
3N -E 0 di[4 8 B «-% -| & & - QB
@1linfo| w2st @M | 5474|5675 &5TS| + |
Taxable amount of dividends other than eigble dividends, ~
included on line 120, from taxable Canadian corporations 180 2 338[83 i
Interest and other investment income (attach Schedule 4) [121] 844|00
Net partnership income: limited or non-active partners only 122 0Jo0
Registered disabilty savings plan income 125 000
Rental income Gross [160 oloo § Net[126 0[oo
Taxable capital gains (attach Schedule 3) 127 0/oo
Support payments received Total[156 oloo § Taxable amount|128 0[oo
RRSP income (from all T4RSP siips) 129] 0[00
Other income Specify: 130 000
Self-employment income _
Business income Gross [162 oloo |§ net[135] oloo §
Professional income Gross [164 oloo Net[137 ojoo
Commission income Gross [166) ojoo g Net[139 oloo
Farming income Gross [168] oloo Net[141 oloo
Fishing income Gross [170 ofoo Net[143] ojoo |
Workers' compensation benefits (box 10 of the TS007 slip) 144 0joo
Social assistance payments 145] 0jo0
Net federal (box 21 of the TAA(OAS) slip) 146 0[00
Add ines 144, 145, and 146
(see line 250 in the guide). 000 @» 147
Add lines 101, 104 to 143, and 147 This is your total income. M n
Protected B
Step 3 - Netincome
Enter your total income from line 150 1
Pension adjustment
(box 52 of all T4 slips and box 034 of all T4A slips) 206 0[00 i .
< >

Modified
T1:150: Tota...92,473.01

EFILE:

Eligible Balance/Refund 5,972.94 GST Credit

0.00 | Combined ba...13,803.35 .



Removing a data monitor is easy. Just right-click it and select Delete

step 3 L N e )
Jump

Enter your t 1
Pension adju goito

(box520fa @ 206 oloo § .
< e StTerAGAT G s >
Modified P - igible |Balance/Refund 5,972.94 |GST Credit 0.00 | Combined ba...13,803.35
T1:150: Tot roperties +

The power of a Right-Click

Right-click a form to get quick and easy access to additional functionality.

e Right-click over a blank area of a form, and ProFile gives you a set of instructions including Print,
Carry forward, Close, and Copy Memos and Tapes

* You can also jump to specific areas of that form and, for carried-forward files, you can also launch last
year’s tax return

v 4 2016 T1/TP1: Taxpayer, Amy - Statement of remuneration paid =38 |
@ Linfo| @25 |3 54T |asT5| + |

< >
Description ALGONQUIN
Province of employment [ 10_Ontario
Employment income [ 14 8899900 000 000 000 88,999 00 Copy fied code
Employee’s contributions | CPP |16 | 2,545.00 0.00 0.00 0.00 2,545.00 </
QPP 17| 0.00 0.00 0.00 0.00 0.00 Copy Memo/Tape
El premiums | 18 | 944.00 0.00 0.00 0.00 94400y P T
PPIP [55 | 0.00 0.00 0.00 0.00 0.0 &
Exempt CPPIQPP | 28 [No No No No @t =
El No No No [No Printform
PPIP No No No No
[Employment code 2 New window
RPP 2 0.00 00 00 00 obo Launch window
Pension adjustment 52 0.00 00 00 00 obo
Income tax deducted 2 15,321.00 00 00 00 15.32190 ey
El insurable eamings 24| 5200000 00 00 00 50.800 40 Create T3
CPP/QPP pensionable eamings 26 | 54,9000 00 00 00 4.900.0p
PPIP insurable earings 56 000 00 00 00 [
Union dues “
Charitable donations 46
Clergy housing allowance |
Transfer allowance to T12237 |
Board and lodging 130 | 0.00 0.00 0.00 0.00 0.00
Special work site 3 0.00 0.00 0.00 0.00 0.00
Travel in prescribed zone 132 0.00 0.00 0.00 0.00 0.00
Medical travel assistance 33 000 000 0.00 000 0.00
Home relocation loan deduction 37 000 0.00 0.00 000 0.00
Other taxable benefts 40 0.00 0.00 0.00 000 0.00
Stock option deduction | 110(1)(d) | 39 | 000 0.00 000 000 0.00
110(1)d.1) 000 000 000 0.00 0.00
Fmnlaumant rammiccinne non 0non non non 000 M|
EFILE: Eligible Balance/Refund 5,972.94 GST Credit 0.00 Combined balance 13.803.35 .

T4AS0 Tatali @ anion

e Ifyouright-click on a field, you’ll see additional commands, including Cut, Copy, Paste, as well as
Insert/Delete columns and Attach Memo/Tape
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\v 4 2016 T1/TP1: Taxpayer, Amy - Statement of remuneration paid oo =
@ lLinfo| @251 |[@3T 54T4 ‘.~‘§.TS| +
muneration Paid
Slip #2 Slip #3
Description
Province of employment |10
Employment income Copy 88,999.00
Employee’s CPP Copy field code 0.00 2,545.00
QPP e 0.00 0.00
El premiums aete 944.00
PPIP 55 Insert column 0.00
Exempt CPP/QPP 28 N
El Delete column
— = PPIP 5 Attach memo
mployment code
= = Copy Memo/Tape 000
Pension adjustment 52 Paste Memo/Tape | | 0.00 0.00
Income tax deducted 2 15, Attach HyperDoc 0.00 15,321.00
El insurable earnings 24 52 Typing list AltsDown 0.00 50.800.00
CPP/QPP pensionable eamings 2% 54, i) 0.00 54,900.00
PPIP insurable eamings 56 [arenrie Y 0.00 0.00
Union dues 44 Close form Esc | | 0.00 0.00
Charitable donations 46 0.00 0.00
Othe T—— Print form
Clergy housing allowance New window 0.00 0.00
Transfer all to T1223? e h o
Board and lodging 30 0.00 0.00
Special work site 3 Create FX 0.00 0.00
Travel in p zone 32 Create T3 0.00 0.00
Medical travel assistance 3 0.00 0.00
Home relocation loan deduction 37 AT 0.00 0.00
Other taxable benefits 40 Previous year's return 0.00 0.00
Stock option deduction 110(1)(d) 39 0.00 0.00
A0AVA 1\ | a1 SiELiie n0n non v
< >
EFILE: Eligible | Bal 0.00 Combined bala...13,803.35

When you right-click over a blank area, or in a field, of the T1 Jacket, you can jump to specific areas of the tax

file

Identification Help F
Elections Canada S4 F6
Total income v T5
Net income T3

Taxable income T5013

T4PS

Refund or Balance owing

Direct Deposit Request

Review Marks

Review Marks let you or approve, or request changes on, any field of a tax file. There are four different types of
Review Marks.
e Use the Preparer Sign-off to confirm the amounts entered on each line of a return, or to approve any
errors or issues signaled by the Passive Auditor

(V) % ?

e The Partner Sign-Off is similar to the Prepare Sign-Off, except that it’s used in an office where a
supervisor or partner approves all returns

/({‘/)'x ?

e Use Correction Required to flag a field error on the return

v ¥'(%)?




e Use the Question Mark to tag a field for further analysis

v v %(?)

Using a Review Mark
¢ In the example below, the Auditor warns you that a T4’s CPP amount may be incorrect

/412016 T1/TP1: Taxpayer, Amy - Statement of remuneration paid

@ linfo| @25 |@3T| w6

(5 4T4 I;-.gTS‘ + |

J

Employment code
RPP

Pension adjustment
tax degucted
Hasepata b

53100]

Description 'ALGONQUIN I
Province of (Ontario 3
Employment income 0.00,
Empl s CPP 0.00
QPP 0.00
El premiums | 18 0.0(
PPIP 0.0
Exempt CPP/IQPP | 28 |No No
El No No
PPIP No No

e To indicate that the amount is indeed the correct T4 value, select a Sign-off Review Mark and click the
yellow field

e ProFile adds a review mark to that field, and also signals it in the Sign-offs tab of the Active Auditor

ation Paid

/4 2016 T1/TP1: Taxpayer, Amy - Statement of remuneration paid
@ linfo| @251 |31 |@wess 84T4 [ 25T5|

‘.‘ Partner sign-off T4/1 Box 16: CPP contributions for ALGONQUI!

« 3
Description ALGONQUIN
Province of 10 |Ontari Ontario
income " A 0.00 0.00 0.00 88,999 00
Employee’s contributions | CPP. j X 0.00 0.00 0.00 2.449.00
QPP 17 0.0 0.00 0.00 0.00 0.00
El premiums | 18 | 0.00 0.00 0.00 944 00
PPIP [55 0.00 0.00 0.00 0.00 0.00
Exempt CPP/QPP | 28 [No No No No
El No No No No
PPIP No No No INo
Employment code [29]
RPP contributions (20 0.00 0.00 0.00 0.00 0.00
Pension adjustment 52 0.00 0.00 0.00 0.00 0.00
Income tax deducted 22 15,321.00 0.00 0.00 0.00 1532100 v
mary \ Wamings @ Notices ¥ Sign-offs Overrides Memos W EFILE W T1135 (% Online change = Dat *|*
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Chapter 3 Quiz

Question 1: ProFile uses Tabs to:

Indicate which forms are open on a tax return
Create multiple copies of a tax return

Toggle back and forth between different tax files
All the above

cawy

Correct answer is A

Question 2: True or False: All of ProFile’s toolbars are customizable

Correct answer is False

Question 3: ProFile’s toolbars include:

Audit & Review Marks; Tax Prep; EFILE settings
Audit & Review Marks; Forms; Shortcuts

EFILE settings, Shortcuts, Archive and Save
None of the above

oCawy»

Correct answer is B

Question 4: True or False: You can hide ProFile’s three main toolbars

Correct answer is True

Question S: True or False: You can add any ProFile form to the JumpBar

Correct answer is True

Question 6: You can use ProFile’s display options to:

Launch tax returns so that they display on two monitors
Tile multiple tax returns

Display multiple tax returns on a monitor

All the above

cawy

Correct answer is D




Question 7: True or False: ProFile has two Auditors (Passive and Active)

Correct answer is True

Question 8: True or False: A field with a yellow background indicates a Passive audit message

Correct answer is True

Question 9: Which of the following types of messages might the Active Auditor display?

Warnings that indicate potential processing issues
A list of data carried forward from a prior year
Notices to alert you to important dates or deadlines
All the above

oCawy»

Correct answer is D

Question 10: True or False: You can go to the Environment option to personalize the Auditor

Correct answer is True
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Chapter 4: A Basic T1

CHAPTER 4 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e How to prepare an individual’s basic T1 tax return
e How to prepare a T1for a married couple
e The A to Z of preparing a T1 for a client, including CRA’s EFILE system

T1 BAsICS

First of all, professional tax preparers rarely, if ever, use the term “tax return.” Most will distinguish a tax return
by its type. Rather than say “tax return,” tax preparers will simply call a personal tax return a “T1.” Likewise, a
corporate tax return is a “T2,” and a trust return, a “T3.”

In this section, we will explore the differences between a manually prepared T1 and one prepared in ProFile.

Paper versus ProFile

You might recall that Chapter 1 introduced a hand-written T1 for an individual named Marianne St Laurent. Let’s
explore how you would manually prepare Marianne’s tax return using CRA’s hard-copy forms and schedules.

e Assume that Marianne was a student during the tax year and that she also worked part-time. Here is the
T4 slip—statement of remuneration—that Marianne received from her employer:

[ vy ey — Jol] Sooserewe Agmonarmens T4
ABC Inc Year 2016 Statement of Remuneration Paid
Année
ABC Marketing & SEO Inc - ] : wEm de la rémunération payée

54 | Employers accourt rumber o de comate Oe I r Province of employment

Exempt - Exemption
c ]

Socul mswrance rumoe
Numéro dassurance socale CPPCPP EI PPIP

@ 444 444 442 ED“ H
AP

RPCARQ AE AP

t & persion - 7

N
18,4210

uss - Ino 212
syncicales - igre 212

Employee's name and address ~ Nom et adresse de l'employé

ors)  Nom e amis o eves modtes wame Foom e it

Last e 0 cap
—’{ St Laurent Marianne I RPP cortributions - e 207 Chastatle donations - ine 349

+atadie comas
Cotisations & un APA - igne 207 Dons go bientaisancs - igne 340

12 Main St

Protected B when completed / Protégé B une fois rempli

Anytown ON CAN M4A 1A2
2
]
Box - Case Amourt - Montant Box - Case
Other information
o tematn [~ | ] ] 1
2 [ /[ | l

e Because Marianne was a full-time university student, she also received the following tuition slip



Bl S renme Apwcessieen

Koy ol Canadn Tuition, Education, and Textbook Amounts Certificate Protected B/ Protégé B T2202A (16)
Certificat pour frais de scolarité, montant relatif aux 6tudes  yhen completed / une fois rempli " Soent
et montant pour manuels Pour Netudant
o Tssue s Corticane 10 8 ShgeT! W0 was EOIeG GG e Caenzar yea 1 8 Qualfye * Déihreson confst s it ottt a0 oo e T v 4 g oo
cdlcationsl progree or & specied ecUCaOn BTORFET sl & POS-eConary FSSRAON, WCh 85 fomalon edmisste O
a Colloge O unwersty. o a1 ar mEtRton Cartten By £ maoyment ano Soosl Deveooment T YT w par Emglol o
Canada (ESDC) socisl Canada (EDSC)
+ Tuton foossac i rosses o calerdar yoar 1o any cne et have 9 ba more T o 8 ¥ 0 sclarh payes & un e Quelcoraue cou s arbe il Gowent ipaseer
cary 100 Los ¥ sayés & un tablsomont sosseconGae doven e 08 Gous 0o e
fon crtied by ESOC have 1o be o courses aken  postaecondai. Les Vs payés & un éaissemert fecorn par EDSC dovert e des cours suvs en
he student has % be 16 years of age or oider € B G § ek s COMpEIenCDs Hrolessrrells. € Bl S0t o+ 16 378 2 DS

avant ia i Go Tannse

n et caicue les montants reials aux
Sextbook amounts based on the number of months dcaled in Box B o C below © e SO s Fuprta o mambes G0 el ko durs 00 caoes D o0 C 0-Seeet

St e s S

3123131
x

[T —rr—

St Laurent

12 Main St

Anytown ON M4A 1A2 CAN

Concordia University
1000 Main St

Anytown ON M1A1A3

Intor e o1 students e o i
Reseianermns pous ies gl

To manually prepare a T1, first obtain a copy of CRA’s T/ General, Income Tax and Benefit Return. You can
download a fillable PDF from CRA’s website, or a hard copy from any Canada Post outlet.

e Start with Page 1 of the tax return (the T1 Jacket) and begin entering your name, address and other
contact info

el = TR T1 GENERAL 2016
Income Tax and Benefit Return
Step 1 - Identification and other information

Print your name and address below. Enter your socil irsurance

Pumber (SIN) | 44444 444
First name and intel Year Month  Day
Marianne Erter your cate of beth 1979 12 13
Last rame Your language of comespancence Englsh Fr

St Laurent Vore langue ce comesporcance E“
Makng accress. Apt No - Street No Street name

12 Main Street
PO Box AR
[ If this return is for a deceased Year Morth  Day
& —— T person, enter the date of death: | |, | ' |
Anytown |oN] IM4AILAR] Marital status
Tick the box that applies 10 your marital status on
1 unGerstand that by providing an emal accress, | am registering for cnine mail | | 1 [ Masmec 2 [0 Uving common-aw 3 [ Wicowee
1 have read anc | accept the terms and conditions on page 17 of the guice.
a0 onorcee 5[] Separatec 8 snge
Enter an emal address wm_aST0121@gmail.ca
Information about your 8@ or
common-law partner (f box 1 or 2 above)
Information about your residence ere e J
Enter your province or Serritory of . Enter his of her SIN: ] |
rescerce on 2008 Ownkario -
Enter e province or e Enter his or her first name:
YOu currently resice I it is not the
same as your maling accress above Enter his or her net Income for 2018
© clam Cerntar Crecits. I
I you were seff-employed in 2018,
enter e province o teiory of Enter the amount of universal chilc care
selt-empioyment Denefit (UCCS) trom line 117 I
of his or her retu.
mamnunmdcm&bmwwm Enter the amount of UCCS repayment
hmlmn from e 213 of his or her retum |
Month  Day Morth  Day Tick this box if he or she was self-employed in 2016 10
entry o ceparwee | |, |

Ae— Elections Canada (For more information, see page 19 in the guide.)

A) Do you have Canadian citizenship?. Vos@' NoDz

Answer the lollowing question only if you have Canadian citizenship.

B) As a Canadian citizen, do you authorize the Canada Revenue Agency to give your
mauam-mmzmmsmcmwwwhmwmm of Electors? Vugl‘ MDZ

Your authorization is valid until you file your next tax return. Your information will only be used for purposes permitted under the Canada
Elections Act. which include sharing the information with provincialterritorial election agencies, members of Pariament, registered
poitical parties. and candidates at election tme

[z [ 172 ————]

s0co-n

e On Page 2, enter the employment income amount as indicated on your employer’s T4




Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
When you come to a line on the return that applies to you, go to the line number in the guide for more information.
income (box 14 of all T4 slips) 101 18, 421 po
Commissions included on line 101 (box 42 of all T4 slips) 102 |
Wage loss replacement contributions
(see line 101 in the guide) 103
Other employment income 104 +
Old age security pension (box 18 of the T4A(OAS) slip) 13+
CPP or QPP benefits (box 20 of the T4A(P) slip) 14+
Disability benefits included on line 114
(box 16 of the T4A(P) slip) 152 |
Other and i 115 +
Elected split-pension amount (attach Form T1032) 116 4
Universal child care benefit (UCCB) 17 4+
UCCB amount designated to a 185 [
and other benefits (box 14 of the T4E slip) 19 4
Taxable amount of dividends (eligible and other than eligible) from taxable
Canadian (attach 4) 120 4
Taxable amount of dividends other than eligible dwmnds
included on line 120, from taxable Canadian 180 |
Interest and other income (attach Schedule 4) 121 4
Net partnership income: limited or non-active partners only 122 4+
Registered disability savings plan income 125 4+
Rental income Gross 160 Net 126 +
Taxable capital gains (attach 3) 127 +
Support payments received Total 156 | Taxable amount 128 4+ |
RRSP income (from all T4RSP slips) 129 4
Other income Specify: 130 4
Self-employment income
Business income Sross 162 Net 135 4
Professional income Gross 164 Net 137 4+
[ ission income 3ross 166 Net 139 4
Farming income 3ross 168 Net 141 4
Fishing income Sross 170 Net 143 4
Workers' comp ion benefits (box 10 of the T5007 slip) 144
Social assistance pay 145 +
Net federal supplements (box 21 of the T4A(OAS) slip) 146 + [
Add lines 144, 145, and 146 (see line 250 in the guide). = P 147 +
Add lines 101, 104 t0 143, and 147. This is your total income. 150[= 1%, 421 OOI

e Next, find Schedule 11 and use the T2202 issued by your learning institution to calculate your eligible
tuition credits

T1-2016 Tuition, Education, and Textbook Amounts Schedule 11
For more information, see line 323 in the guide.

Only the student must complete this schedule and attach it to his or her return. Use it to:

« calculate your federal tuition, education, and textbook amounts;

« determine the federal amount available to transfer to a designated individual; and

* determine the unused federal amount, if any, available for you to carry forward to a future year.

Tuition, ion, and book laimed by the student for 2016

Unused federal tuition, education, and textbook amounts from your 2015 notice

of assessment or notice of reassessment 1
Eligible tuition fees paid for 2016 320} 7788 o0 2

Education and textbook amounts for 2016

Part-time student: use column B of forms T2202A, TL11A, TL11B, and TL11C.
Do not include any month that is also included in column C.

Only one claim per month (maximum 12 months)

Education amount:

Number of months from column B x $120 = 3

Textbook amount:

Number of months from column B X §20 = * 4

Add lines 3 and 4. = | 232188 5

Full-time student: use column C of forms T2202A, TL11A, TL11B, and TL11C.
Only one claim per month (maximum 12 months)

Education amount: 3200 foo

Number of months from column C B X $400 = | 6

Textbook amount: 520000

Number of months from column C 8 x $656 = + 7

Add lines 6 and 7. = | 332208 ar2000 g
Add lines 2, 5, and 8. Total 2016 tuition, education, and textbook amounts = [ » 11 508 IDO 9
Add lines 1and 9. Total avallable tuition, and textbook = 1150800 1q
Enter the amount of your taxable income from line 260 of your return if it is $45,282 or
less. If your taxable income is more than $45,282, enter instead the result of the 18421 hoo
following calculation: amount from line 45 of your 1 divided by 15%. 1
Total of lines 1 to 22 of your 1 - 13719000 42
Line 11 minus line 12 (if negative, enter "0") = 470110 43
Unused tuition, education, and textbook amounts claimed for 2016 o bo
Amount from line 1 or line 13, is less — » 14
Line 13 minus line 14 = 47010015
2016 tuition, education, and textbook amounts claimed for 2016 47010
Amount from line 9 or line 15, whichever is less + 16
Add lines 14 and 16. Total tuition, education, and textbook +701h0
Enter this amount on line 323 of 1. amounts claimed for 2016 [= 17

e You will also need to find Schedule 1 and enter the basic personal amount at line 300, the Canada
employment amount at line 363, and the CPP and EI amounts from your T4 slip at lines 308 and 312.
Finally, transfer the amount from line 17 of Schedule 11 to line 323 of Schedule 1



Protected B when completed
T1-2016 Federal Tax Schedule 1
This is Step 5 in completing your return. Complete this schedule and attach a copy to your return.
For more information, see the related line in the guide.
Step 1 — Federal non-refundable tax credits
Basic personal amount claim $11,474 11474 00 1
Age amount (if you were born in 1951 or earlier) (use the federal ) $7,125) [ 2
Spouse or common-law partner amount (attach 5) 3
Amount for an eligible (attach 5) 4
Family caregiver amount for infirm children under 18 years of age
Number of children for whom you are claiming
the family caregiver amount Ja52] x $2121 = M+ 5
Amount for infirm age 18 or older (attach 5) W+ 6
CPP or QPP contributions:
through employment from box 16 and box 17 of all T4 slips 738 59
(attach Schedule 8 or Form RC381, whichever applies) 0853 .7
on self-employment and other earnings (attach Schedule 8 or Form RC381, whichever applies) ﬁ+ .8
Employment insurance premiums: ) 246 | 31
through from box 18 and box 55 of all T4 slips $955.04) + .9
on self- and other eligible earnings (attach Schedule 13) %+ «10
Volunteer firefighters’ amount i+ 1
Search and rescue volunteers’ amount 9553 12
Canada employment amount 1161] o0
(If you reported employment income on line 101 or line 104, see line 363 in the guide.) 6 | " 13
Public transit amount 14
Children’s arts amount 15
Home accessibility expenses (attach Schedule 12) 16
Home buyers’ amount 17
Adoption expenses 18
Pension income amount (use the federal 19
Caregiver amount (attach 5) 20
Disability amount (for self) (claim $8,001, or if you were under 18 years of age, use the federal 21
Disability amount transferred from a dependant (use the federal worksheet) 22
Interest paid on your student loans 23
Your tuition, ion, and textbook amounts (attach 11) 4701 10 24
Tuition, education, and textbook amounts transferred from a child 25
Amounts from your spouse or common-law partner (attach 2) 26
Medical expenses for self, spouse or common-law partner, and your
dependent children born in 1999 or later @ 27
Enter $2,237 or 3% of line 236 of your return, whichever is less. — 28
Line 27 minus line 28 (if negative, enter "0") = 29
Allowable amount of medical expenses for other dependants
(do the calculation at line 331 in the guide) 331088 30
Add lines 29 and 30. = | 233203 | 31
Add lines 1 to 26, and line 31. %: 18 421| 00 32
Federal tax credit rate X 15% 33
Multiply line 32 by line 33. 8 15 34
Donations and gifts (attach 9) 35
Add lines 34 and 35. s
Enter this amount on line 48 on the next page. Total federal non-refundable tax credits 36

Paper Observations

As you can see from the example above, it quickly becomes evident that manually preparing even the most basic
is a protracted and complex affair. The need for complex calculations, the risk of omitting a schedule or form, or
of not transferring the proper amounts to said forms, all mean that the probability of errors and omissions is, in
fact, quite high.
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Once again, in ProFile

Let’s now explore how we prepare the same T1 in Profile:
e Launch ProFile and go to File > New > 2016 T1
e After ProFile opens the /nfo page, enter the individual’s name, social insurance number, date of birth
and other relevant information
e The Info page should look like the image below

|/ 42016 T1/TP1: St Laurent, Marianne - Personal information [= e ]
ounvo‘ﬁj;rq 3T|0|3‘Ug$||x§,T3"-QN‘,».Z.IS'Jg,RRSP/PRPPl - |

" 2016 Personal information

Marital status
Indicate your marital status on December 31, 2016

Taxpayer personal information

SIN 444 444 442

Title 1 D Married 2 |:| Living common-law 3 |:| Widowed
Firstname ___Marianne 4[] Divorced 5[] Separated 6 X Single

Last name St Laurent

Last name changed in 20162 D!es ﬂa If status changed in 2016, enter date of change mm-dd
Do you want to change your address? [Wyes No Were you married or living common-law at any

Care of time in this tax year? [OYes [ONo
Streetaddress 12 Main St Apt #

ZOL A L L Province of residence

B oo 0n2016/12/31 Ontario

Province ___ Province of sell-employment

Posiaicode __M4A 1A2 Ifyou became or ceased 1o be a Canadian resident in

Home phone __ (909) 555-5555 2016, enter date of entry mm-dd

Birth date 1979-12-12 BAce 37 or departue  mm-dd

Date of Death _yyyy-mm-dd

Gender D Male |:| Female

Province or territory where taxpayer resides if different from mailing Are you a non-resident? [JYes [XNo

address Residency status Resident

By prowiding an email address, | understand Country (other than Canada)

1am registering for oniine mail and accept B e

the n;Iegv;ung ;‘grms anld Comlmnons ’ [Wyes [Ino Did you dispose of a property (or properties) in 2016 for which you are
= = claiming a principal residence exemption? Yes [X]No

Email address l

Use preparer address for.
Nothing |:| Notice of Assessment and Refund D NofA

[J 11 mailing address

EFILE this retum? XH Yes I Are you a Canadian Citizen? [—l X| Yes No

EFILE muttiple years? Yes Provide information to Elections Canada? _____|X| Yes No

Authorization for efiler to represent taxpayer? X] Yes Did taxpayer own foreign property at any time in

First time filer in 20162 2016 with a total cost of more than

Method of contactfor. __ Pre-assessment pmssessm canstoooorr  [lves (Mo

Contact preparer by mail Q s taxpayer's income zero? Yes ﬁ No

Contact client Claim dicahikity amount? Voe %I Ny e
Modified EFILE: Eligible Ba\an(e/Rcfund 000 |GST Credit 280.00 |Combined balance 000 +

e Once again, here is the T4 slip—statement of remuneration—that Marianne received from her
employer

7% name - Nom Go fempoyeur Joll Soosremnn Agwoedseen T4
ABC Inc Year I Statement of Remuneration Paid
Anmnge | 2016 ] Etat de la rémunération payée

ABC Marketing & SEO Inc

urt rumwe | Numérd de comite O lempioyeLt

P et
oo
Exemot —Ex w»n M —!

PPIOPP €I PP Employmen code Employes' QPP oo

Fassse ) B H

Employee's name and address ~ Nom et adresse de l'employé

) o e tarnde e s mobdes Fist name - Prbvom it - ot

Protected B when completed / Protégé B une fois rempli

—.[ St Laurent Marianne |
12 Main St o
Faclout G bQuvalnncn - igne 208 g A ou cun RPOB
Anytown ON CAN M4A 1A2
Box - Case Amours— Mortart Box— Case
Other information I J
(s00 over)
o |Auves Box- Case Amoure - Mortart Box - Case Amourt - Montant Box- Case Amount - Montant
T |renseignements I ] l l I
3 [tvorauverso)

e Torecord the T4 slip in ProFile, press the 74 key to open Form Explorer and then, in the Search field,
type T4. Double-click the T4 line in the right pane of the Form Explorer window, and ProFile will open
that form



vl Form Explorer ? X
Wl 5tLaurent Marianne v ™ "
- -
Form | T4 Qpen Bint Lst | Detall Key Lie
Foms Name Category Description Us.. Last.. St
n @ico Identfication  Personal information Yes NA 1
W 1 Iderticston #4Dependant  Identfication  Dependantinformation No NA 3
™ 2 sioe @ CamyPWD Identfication  Camyforward Summary Yes N/A q
B 3 boome B T2202TLIT Slips Tuition and education credt certfi. No  N/A 6
- BT3 Slips Statement of frustincome No NA 7
£ Deckon &T4 Slips Statementofremunerationpaid ~ No  N/A 8
5 Taxs credts BT4A Slips Stetementof pension annuityend.. No  N/A 9
W 6 Retum + schedules | (4 T4A0AS Slips. Statement of Old Age Security No N/A 10
W 1 Filng = B T4AP Slips Statement of Canada Pension Pi No NA n
TP & TAARCA Slips Stotement of distributons froma.. No  N/A 12 M

e Enter the data on the T4 Slip form line by line

e And ProFile will transfer the T4 amounts to the corresponding line on the T1 return itself (the T1

Jacket)

3TI013|©451|B5T3 BETH|1TS| @8 RRSPARIP|

O 1info |@2T1|

=

#2016 T1/TP1: St Laurent, Marianne - T1 jacket [E=8EoR =X=|

Descripton ABC INC oo W2T |azw| - |
Step 2 - Total income ~

Province of employment Ontario | | As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
Employmentincome (4| 1842100 000 000 000 )| | When you come to a line on the return that applies to you, go to the line number in the guide for more info
Employee’s conbutions | CPP. 74577 000 000 000

app | 00 000 000 000 14 of al T4 sips) [to1] _18.421J00

El premiums 1 0.00 0.00 0.00 Commissions included on line 101 (box 42 of al T4 siips) [102]

PPP 000 000 000 J| | Wage loss replacement contributions
Exempt CPPIGPP No o Vo o (see ne 101 in the guide) [103]

[} No o No No ther
o 52 i o o o Okt Age Securty pension (box 18 of the TAA(OAS) sip) o
RPP contributions 20 000 000 000 (box 20 of the T4A(P) skp) [114]
Pension adustment 52 000 000 000 Doty bonea kodosor e 14
income tax deducted 2 000 000 000 l§ | ox16ofthe T4ap) sip) oloo
El insurable earmings 24 18,421 000 000 0.00 Other pensions and 115] oloo §
CPPIQPP pensionable earn 2 18,421 000 000 000 ll | Gectes = - [r6] oo B
PPIP insurable eamings 56 [0 000 0.00 000 | o i Care Beners (UCCH ] oo R
Union dues: au o 000 000 0.00 e arc Beneft (JCCH)
Chariable Gonalions % o 000 000 000 J§ | Ucce amount designated to a dependant .

o s (box 1401t i19] ojoo
Modtied EFILE: Eligible /Retund 957.00 GST Credit 427.00 Combined | corporations (attach Schedule 4) [120] 0|

5 158 13

Bl

received
RRSP income (from all T4RSP slips)
Other income

Seif-employment income

EEEN

Gross[162] net[135] 0loo
Gross[164] et [137] 0Joo
Commission income Gross [166] Net[139)] 0Joo
Gross |168] Net 141 0J00
Fishing income Gross [170] Net[143] 0Joo
Workers' (box 10 of the TS007 sip) [123] oloo i
145 oloo m
(ox2torhe TaA(OAS fas] oo |
Aﬂd lines 144, 145, and 146
(see line 250 in the guide). o b 147 oool .
- . y s .
¢ And here, again, is Marianne’s tuition slip
|} Kooy FEnR——~ Tuition, Education, and Textbook Amounts Certificate Protected B/ Protégé B T2202A (16)
=

Certificat mmbamw.mmwnmmﬂ- when completed / une fois rompli o

Pour et

o Jseus Bia corticete 1o & shuderd who was envoled g e ulerr year n  Qualyi
ucational prograrm of a specified educational oA at & post-secondary insSRACN, Such a8

a ologe o invershy, o 6 6n ItV Garified by Emghoyment and Sociel Developmart
Canada (ESDC).

 Tution 1905 pard In FosDAct of the Cakndar yoar 10 any 070 INStton hav 1o bo morethan @
$100. Foos pad 10 3 post-600ong
post-secondary level Fees
5 gut o irpmcuve 8l i 1 ccupaton, and fhe Shaient s 1 b 16 yelrs o age & e
efors the end of the your.

» Do not enter the cost of textbooks on this form Siucerts cakcuiaie o educalon and
Sextbook amounts based on the number of months dcaled in Box B o C below

Dewvucew s b o 04 Ut e, o coes o e v, L ur popraeens &0
formation admissicie oy & s
omma un Cole Tu e uorSMY, 0u dans 4 par Emplos o Obveiops

social Canada (EDSC)

05 trais 09 5COIaS Pays & un HADIESEMEN QUICONQUO POUT UMD AVHS VM GoNverT ddpasser
100§ Los ¥ payes & un feablssemert sorseconGas dowent vise dos Cours B0 e
osisecondare. us vas Daybs & un Elabimserent recony par EDSC dovent viser des cours suvs en
vue Cacquésic ou damélorer des compétences prolessionmeles, et eludiant SOt svoi 16 ans ou plus
avant ia fin de fannde.

Ninscrivez pas le codt des manuels sur ce formulaire | tuciart caicul les montarts reat s sux
#tutes et pour manusis d'sprés le nombre de mols naicub dans les cases B ou C O-dessous

Inormaion o shudess: S ack 5 1 o et >t s 5 oy Mo, ecaton
Remseignersants our et @uslants . ses o verss . et | 5 108 i aire o sa

T
Marketi 3123131
[ T — A
Marianne St Laurent (,4"":,;3 e
12 Main St [ A [ o .
oA w v-a v v parie | '
An ON M4A 1A2 CAN
yiown 349900 4| o©
Concordia University 4,289.00 3 g
1000 Main St +
| o] o
Anytown ON M1A1A3 Tomen 7,788.00| 8 0

o v o s st 6 v e 1

Name 373 20301 & C0 el FEHNAOn N adeste 3¢ abbsarart §waegemert

00 1 00 vin ~GrArth AP aun #1001 € GO N 1o OWLe: 1 verso Ou Vet 2

e Use Form Explorer to find and open the T2202 tuition form. Record the slip information on that form
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e ProFile will transfer those amounts to the Schedule 11

/42016 T1/TP1: St Laurent, Marianne - Tuition and education credit certificate = & )
©®1info|@2T1 &9 T2202/TL11 §.T|0|3"‘é§1‘ ~§T3‘ »6.T4| 8775 J§RRSP/PRPP‘ + ‘

Tuition Slips

Slip #1 T1-2016 Tuition, Education, and Textbook Amounts Schedule 11

Only the student must complete this federal schedule and attach it to his or her returm. Use it to
* calculate your tuition, education, and textbook amounts;

+ determine the amount available to transfer to a designated individual; and

Oz A RN B + determine the unused amount, if any, available for you to carry forward to a future year

Tuition fees paid Tuition, ion, and book claimed by the student for 2016
Number of months in part-time enrolment Unused federal tuition, education, and textbook amounts from your 2015 notice of I
1

Concordia U

Number of months in fultime enrolment @ assessment or notice of reassessment
TL11D Eligible tuition fees paid for 2016 7.788[00 |f 2
Tuition fees paid Education and textbook amounts for 2016

CIMRADISUOMM O Part.time student: use column B of Forms T2202A, TL11A, TL11B, and TL11C.
Do not include any month that is also included in column C.

Only one claim per month (maximum 12 months)

Modied EFILE: Not eligilile |Balance/Ref
amount:
number of months from column B 0 i x §1 ojoom3
Textbook amount:
number of months from column B oo N4
Add lines 3 and 4. ofoo | » XX oloo ll 5
Full-time student: use column C of 02A, TL11A, TL11B, and TL11C.
Only one claim per month m 12 months)
Education amount:
column C 8 il xs400= 3.200[/00 W 6
nt:
months from column C 8 i x 865 = 520[00 @ 7
Add lines 6 and 7. 3.720/00 § » kx4 3.720[00 @ 8
Add lines 2, 5, and 8. Total 2016 tuition, education, and textbook amounts 11.508]00 | » 11.508/00
Add lines 1 and 9. Total available tuition, education, and textbook amounts 11.508[00 | 10

Enter the amount of your taxable income from line 260 of your return if it is $45.282 or less.
If your taxable income income is more than $45,282, enter instead the result of the

following calculation: amount from line 45 of your Schedule 1 divided by 15 %. 1842100 W 11
Total of lines 1 to 22 of your Schedule 1 13.719|90 @ 12
Line 11 minus line 12 (if negative, enter "0") 470110 @ 13
Unused tuition, education, and textbook amounts claimed for 2016 | I
Amount from line 1 or line 13, whichever is less oo m» 0jo0 g 14
Line 13 minus line 14 470110 | 15
2016 tuition, education, and textbook amounts claimed for 2016
Amount from line 9 or line 15, whichever is less 4.701)10 @ 16
Add lines 14 and 16. Total tuition, education, and textbook
Enter this amount on line 323 of Schedule 1 amounts claimed for 2016 | 4.701)10 @ 17
Transfer / Carryforward of unused amount
Amount from line 10 11.508/00 J§18

e And ProFile will then transfer the amounts from Schedule 11 to the Schedule 1 and, finally to the T1
Jacket



T1-2016 Federal Tax

This is Step 5 in completing your retum. Complete this schedule, and attach a copy to your retum.
For more information, see the related line in the guide.

Step 1 - Federal non-refundable tax credits

Schedule 1|

Protected B when completed

Basic personal amount claim $11.474 £ 1
‘Age amount (f you were bom in 1351 or earier) use federal worksheet) (maximum §7,125) 2
‘Spouse or common-law partner amount (attach Schedule 5) 3
‘Amount fo an eligible dependant (attach schedule 5 4
Famiy caregiver amount forinfrm children under 18 years of age
Number of children bor for whom you are claiming
the family caregiver amount ofixs 2121 = 5
‘Amount fo infim dependants age 18 or older (attach Schedule 5] 6
CPP or QPP contributions:
through employment from bos 16 and box 17 on all T4 slips
(attach Schedule 8 or Form RC381, whichever appiies) .7
n selfemployment and other eamings (attach Schedule 8 or Form RC381, whichever apples) .8
Employment Insurance premiums
through employment from box 18 and bosx 55 of all T4 slips maximum $955.04) .9
on selfemplo s «10)
Volunteer frfighters” amount 1
Search and rescue volunteers' amount 2
Canada employment am:
(f you reported employment income on line 101 or ine 104, see line 363 n the quide.) (maximum $1,161) 3
Public transit amount "
hilcren's arts amount 5
lome accessibiity expenses (atach Schedule 12) %
fome buyers' amount ”
Adoption expenses 18
ension income amount (use the federal worksheet) (maximum $2,000, 19
Caregiver amourt (attach Schedule 5) _ 2
Disability amount (for self) (claim $8,001_ or f you were under age 18. use the federal workshest) 2 Protected B wn feted
Disabilty amount Gependant (use the federal worksheet) 2
Interest paid on your student loans 2 0
Your tution, education u
Tuition, education. and textbook 2 Pt whichever dopes). =
xpen 12 E g 235)
dependent children born in 1999 o lat e .
Enter 52,237 or 3% ofline 236 of your retum_ whichever is less. e ‘“’2 anesze
Line 27 minus ine 26 (i negative, enter “0°) : ;
Allowable amount of medical expenses for other dependants .
(do the calculation at ine 331 in the guide) Js
Add ines 29 and 30 3 . ¥
Add lines 1 t0 26, and line 31 = C |
Foderal non-ofundable tax credi rate » ot ncone 28
Muliply ine 32 by lie 33 u Retundof nvesil T2038(00))
Donations and gifts (attach Schedule 9) 3 )
Add ines 34 and 3. |
Enter this amount on ine 48 Total federal x crodits 3%

oloo fix 1500 % -

9lo1

Muliply line 40 by line 41

Add lines 42 and 43, oloo

Step 3 - Net federal tax
Enter the amount from line 44
Federal tax on split income (from line 5 of Form T1206) 424
‘Add ines 45 and 46

Enter your total federal non-refundable tax credts from line 36 on the previous page
Federal dividend tax credit

Minimum tax caryover (attach Form T691)

Add lines 48, 49, and 50

Line 47 minus line 51 (f negative. enter "0°)

276315 || 45
g

pE Y |

e Because Marianne had no other slips or additional information to record, here is snapshot of her tax

return

e Note that the last page of the tax return indicates that Marianne is receiving a refund of $9.91

a retund.f he resut s postive, you have a balance owing
Enter the amount below on whichever ine appies.

Balance owing [485] oloo

Step 2 - Federal tax on taxable income Tox
Provinfal
Enter your taxable income from line 260 of your return 18.421j00 37 Acd il 437 10 478, These are your total credits. 482 0
. et . Line 48 minus ine 482 This s your refund or balance owing.
neIamore LneITismore Lne37ismore
s I SR B ifthe resut s negatie, you ha
omplete the appropriate column depending Lne 37 notmorethan ot more than Line 3718 more

on the amount on ine 45282 oress 390563 140,388 than $200,000 (SRS 300 e TS S O
Enter the amount from line 37 ooo i LMY

90563000
Line 38 minus line 39 (cannot be negative) 0loo

X %
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[ I I T1 GENERAL 2016

Income Tax and Benefit Return

Step 1~ Identification and other information

o [7]
o yout name and address bolow. Enter your sockal msurance numoer (SM) |44 444402 |
Frstname and ntal Vearmiontnay
Hanenno Enter your date o bt [1979-12-12
ront orc
Maiing acaress: Api 1o Sireei o Sreet name
12 Wi St ]
#0800 =
L]
ciy Step 2 - Total Income
[Anvtown _ aga resident of Canada,

e e e e e S i e e

14 of ail T4 sips) [101] 1842100
‘Commssions included on line 101 (box 42 of all T4 sips) il ool
e
o oo il .

Step 3 - Net income

'Ok Age Securty pension (bor 18 of the TAAOAS )
resdence onbecemoer 31, *‘cPPmaPﬁmm o 20l he T4xP) i)
Pension adustment

iy benetts ncuged on fne 114

150, 18.421j00 |

e nepownce ety u o |salmelwmyp oxs20tar TaA sips) [208] doofl
currently resce £ 1
e = egre pensnpanscuon (20 f g nox 022 Tak i) oo i
Tozz) RSP regeiredpenin B (RPP) 360
(see Schedule 7 and attach receipls) oo §
entor e province o fartory 0 PRPP employer cortrbutors
e e [208] ojoo §
eigte) from st

e S e e 1oz g P |
2016, entar the date ot Tasable amount of di RC381. whichever apples) a1 0J00.
ooy @ Annuat unon, potessona. or = 5 430 oo

entry mm-dd 1)
ent ox 235 2 oloo
e or T778) Provincial resutis°0) 428 0jo0
ke ‘Ad nes 420,421, 430, $22 300 426 T 5 your e (435| oo -
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Conclusion
As can be seen from the illustration above, ProFile—at least with a basic T1—provides guided tax preparation
that requires you to simply enter information on the required forms and slip (in this example T4 and T2202) and

ProFile will then complete the T1 based on those entries.

Contrast that with the same hand-written example, and the benefits gained by using tax-preparation software are
immediately evident.

A TAX PRACTITIONER APPROACH

Preparing a T1 for a Married Couple

This section explores how a tax preparer works with a client—in this example, a married couple named Jane and
Javier Cosan—who have asked you to file their T1 returns. So that you can proceed, they provide you with the
following tax slips:

e T4 slips that itemize each spouse’s employment earnings
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e There is also a charitable donation receipt and a TS5 slip issued by a bank or other financial institution
that lists the amount of investment income earned in the tax year. Assume that the investment income
was shared equally by each spouse

Canada Revenve  Agence du revenu of Income Your B/Protégé B
| L e @ Canada T5 Emu-nvmu-ou [20 7 8]  when / une fois rempli

——— T v -Gy Annte

B e P e ) i [T Tl

448.12
o - oo e . e

O = O~ O] [21] Rapor: Gode [22] Receent cersicaton nurbe | 23] Aecpert o

1,275.00 1,491.75 156.96 o 444 444 442 1

ot ot sou Iwaenaes
e

]

] I ]

I

Amount | Montant Box / Case Amount / Mortart

Recipert's name (las: name Arst) anc acdress - Nom, Prénom ot A0S0 du DENACIAre. Payo’s name and address - NOm ot A0°08s0 Oy Payeu”
COSAN MARIA HIGH FLYING ETF INVESTMETS
COSAN JAVIER 10 BAY STREET
12 MAIN ST
ANYTOWN ON CAN M4A 1A2 TORONTO ON  MIA1A1
Curency and denthication co0es.
» @] ] @] ] @] ] For information, see the back.
Foreign cuTency Transt - Succursale ecoent scoount Pour obtenir des renseignements,
eangeres. Numéo Ce compie du éné‘care lisez le verso.
etormation ark nurber CRA PPU 183 4 CAA Py 006 posomen, ARG P 150 o ARC PP 098

Prvacy
T5(15)

\77 Parkinson Canada

316.- 4211 Yonge Stee: M2P 209
T.4162276700 | F. uenrmo | waw parkinson. ca

Jane Cosan
12 Main St
Anytown, ON
M4A 1A2

10809 1788 RRO0DY

Date Received/Don e.
escedmocs bme o, 2016112112

6mis le:

Date
Place of Issue/Lieu d'émission: Toronto, ON

DUPLICATE RECEIPT
REGU EN DOUBLE

Receipt No/Numéro du requ: L100032816

Donation Amount/Montant du don: $100.00

This is an official tax receipt for income tax purposes. / Recu officiel aux fins de Iimpot.
Canada Revenue Agency: www.cra.gc.ca/charitiosandgh

cra.gc.
Agence du revenu du Canada: www.cra-arc. gc.calchrts-gvng/menu-fra htmi

Authorized signature/Signature autorisée
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With these slips, along with their contact information, you are ready to proceed.

T1013

As a professional tax preparer, you will want all new clients to complete and sign CRA’s T1013 authorization
form. Think of a T1013 as your T1 Launchpad. With it you can access CRA’s website and obtain your clients’ tax
information. The information that a T1013 provides will include: Notices of Assessments, client data summary,

account balances, as well as information slips such as T3, T4, T5 and RRSP slips. Here’s how you complete and
filea T1013

e C(Create a new tax return in ProFile and fill out the Personal Information page. Here’s an excerpt of
Jane’s information page

/4 2016 TI/TP1: Cosan, Jane - Personal information [E=R(ECE|
@ Linfo | 0 4 Medical | @271 | @551 | 8374| + |

ifo 2016 Personal information

Taxpayer personal information Marital status

SIN 444 444 442 Indicate your marital status on December 31, 2016
Title Ms 1 [x] Married 2 [ Living common-aw 3 [] Widowed
First name Jane =
e 4[JDivorced 5[] Separated 6] single
Last name Cosan - D - D P - D v
Last name changed n 20162 [ Yes No If status changed in 2016, enter date of change mm-dd
Do you want to change your address? [l Yes No | Were you married or living common-law at any
Care of time in this tax year? Yes [INo
Street address 12 Main Street Apt # Residency
EIOLAn own I RR Province of residence
oA on 2016/12/31 Ontario
%M A A Province of seff-employment
L if you became or ceased to be a Canadian resident in
Home phone | (909) 555-1212 2016, enter date of- entry mm-dd
Birth date 1979-12-12 B Ace a7 el i
Date of Death _ yyyy-mm-dd
Gender D Male Eemale
Province o teritory where taxpayer resides if different from mailing | Are you a non-resident? [ Yes No
Ces Residency status Resident
By providing an email address, | understand e
yaen roges: st oy ool e 2ud accert Did you dispose of a property (or properties) in 2016 for which you are
the following Terms and Conditions [Wyes [no s e o > ¥
g a principal residence Yes [X]No
Email address [ |
Use preparer address for
Nothing [] Notice of Assessment and Refund [ ] N of A
[ 11 mailing address

EFILE this return? Xl Yes ] No Are you a Canadian Citizen? m Yes No
EFILE multiple years? Yes No Provide information to Elections Canada? Yes No
for efiler to represent taxpayer? X| Yes [ ]No Did taxpayer own foreign property at any time

First time filer in 20162 Yes No in 2016 with a total cost of more than

Method of contact for: ~ Pre-assessment  Post-assessment canstoooorr  []ves No

Contact preparer by mail Is taxpayer's income zero? Yes No

Contact client Claim disability amount? Yes No

Is retumn [Jyes No If yes_ is this a first year claim? Yes No

Is retumn completed under the CRA's ~ ~ Mentally or physically infirm? Yes No .

e To enter Javier’s spousal information, just scroll to the bottom of Jane’s Personal Information page

Spousal information Additional contact information
SIN 888 888 880 Work phone number () - ext
Title Mr Faxnumber () -
First name Javier Cell phone )
Last name Cosan Mailing label
e Joint names Jane and Javier Cosan
Street address 12 Main St l Apt # e
P.0.Box HRR
Gty Anyiol 12 Main St
CVE Anytown P.0.Box ERR
Province ON cty Anytown
ey | o —
Postal code M4A 1A2 Province ON
Home phone (905) 555-1212 Postalcode  M4A 1A2
Birth date 1060-06-23 BAge [ R
Net income 0.00 | Joint Salutation __ Dear Mr and Ms Cosan
Spouse’s province of residence Client Salutation  Dear Ms Cosan
e A 1.2/31‘ o Oy . B Cient ettr type Joint ]
s spouse’s net income zero? es o
bt o U it ? XH Y N

Spouse self-employed in 20162 [ Yes No 6 Joi voice yes (Mo
If spouse became or ceased to be a Canadian resident
in 2016, enter date of entry mm-dd

or departure  mm-dd

e After entering Javier’s information, press F5, or click the toolbar’s Spouse toggle icon
e ProFile will ask if you want to open or create a tax return. Because Jane and Javier are new clients,
select Create a new return for spouse



Couple Returns X

(®) Create a new return for spouse
(O Dpen an existing retum

Cancel

e Once you enter Jane and Javier’s Personal Information page, press 4 to open ProFile’s Form Explorer
and, in the Search field, enter T1013

e Onthe T1013, check the Authorize a representative box and ensure that the information--including the
clients’ names and social insurance numbers, your CRA representative information as well as the
authorization level—are all accurate

e Submit the T1013 to your client for signature

()
when completed

Canada Revenue Agence du revenu
Agency du Canada

Authorizing or Cancelling a Representative

The purpose of this form is to:
Authorize a representative

. . L OR [] Notapplicable
[:l Cancel a representative ~ OR D Cancel the consent(s) given for the individual

Important: If you recently moved, update your address and contact information with the Canada Revenue Agency (CRA) online if you are
registered for My Account at cra.gc.ca/myaccount, by telephone at 1-800-959-8281, or in writing.

By registering for My Account, you can view, add, modify, or cancel your i . To i i cancel a

call us at 1-800-959-8281.

Complete a separate Form T1013 for each account (Part 1) and representative (Part 2).

Do not complete a new form every year if there are no changes.

See the attached information sheet if you need help completing this form.

r Part 1 — Taxpayer information

Complete the line that applies.
SIN, TTN or ITN First name Last name
444 444 442 "] Jane Cosan

[Tmst account number [Tmst name I
T

5 filer identification number
HA

[Filer name |

r Part 2 - Representative information and authorization
Complete section A or B, as applicable.
[] To grant an individual online access, enter his or her ReplD.
L] To grant a group online access, enter its GrouplD.
To grant a business online access, enter its Business Number (BN).

A. Authorize online access for all tax years (including access by telephone, in person, and in writing)

ReplD
First name: I Last name: I

GrouplD

G Group name: I
Business Number (BN)

112112911 I i name: A1 Tax Preparers | |
Representative mailing address: 12 10 Ave SW, Calgary. AB. T1A 1A1 l
Enter the level of authorization (level 1 or 2):

Notes
A representative of a trust account will have access to all tax years with no online access.
If you have a "care of" address on your account, we will send you a letter asking you to call the CRA to authorize the online access

B. Authorize access by telephone, in person, and in no online access

e [t is very important that your clients sign their T1013 before you submit them to CRA. Once signed,
click EFILE > EFILE the T1013 for this taxpayer

v 4 PROFILE
File Edit Audit Goto Form Options EFILE Online Training Window Help
-3 t\ . H o P2 EFILE/ReFILE this return... Ctrl+F11

EFILE P/ horized Debit for this taxpayer...

v 4 2016 T1/TP1: Cosan, Jane - Authorizi EFILE the T1013 for this taxpayer...

6.T1013 ]olA Info | [ 4 Medic EFILE the T1135...

I*I :2::7 Revenue :f?;".f Build T1 EFILE Online Batch...

EFILE Online Batch

The purpose of this form is to: A o

Authorize a representative jIEiConnects

D Cancel a representative Ol Renors ’
Print All ACKs

Important: If you recently moved, uj
registered for My Account at cra.

By registering for My Account, you ¢ Set EFILE Password To imi

call us at 1-800-959-8281.

Complete a separate Form T1013 f

Do not complete a new form every year if there are no changes.

See the attached information sheet if you need help completing this form

View Notice of Assessment (ENOA)

Options...
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e Once CRA authorizes access, log into CRA’s Represent a Client portal at www.canada.ca (select the
Income Tax dropdown)
e Choose CRA login and enter your CRA Represent a Client credentials

Represent a Client

including your employer.

online banking).
= None of your information will be shared with CRA. Your Sigr-In Partner wil not

know which government service you are using. Fos
porary your Sgnin Pane.
Bowin @
» View the fulllist of Sign-in Partners Affinity rine”

CRA Login

| User ID: (required)

AlTaxProp
Forgot your user ID?

Eorgot your password?
For more information on how your privacy is protected, refe to our Personal Information Collecion Statement.

Logn 1Y
Register f you are a new user.

To revoke. ge v password, or . ¥ logi

e  Enter Jane’s social insurance number and click Access SIN

Access Client Information

To access information on behalf of clients, the CRA must have authorizations on file from these clients granting online
access.

Enter the Social Insurance Number (SIN) or the Business Number (BN) of the account you want to access:
SIN (no spaces or dashes)

444444442

Access SIN

BN (no spaces or dashes)

Access BN

e You are now at Jane’s Information page. Note the tabs at the top of the page that give you access to
CRA’s tax information for that client

e —

< Home Tax returns Accounts and payments Benefits and credits RRSP and TFSA ClientsumD

Welcome, A1 Tax Preparers

We have the following information on file for Jane Cosan

© View mail

YYou have 3 unread items

Important information

The 2015 return was assessed and a refund of $260.55 was deposited directly into your client's bank account
on May 12, 2016.
o View your 2015 Notice of Assessment

The 2014 return was assessed and a refund of $860.69 was deposited directly into your client's bank account
on May 26, 2015.

o View your 2014 Notice of Assessment

View your T4 and other tax slip information.




Entering tax data

With Jane’s tax return open in ProFile, use Form Explorer to open the forms and schedules that you need to

record Jane’s slip information.

e Press F4 to open Form Explorer, and, in the Search field, enter 74. Record the slip information on
Jane’s T4 form. Press F'5 to toggle to Javier’s return. Enter Javier’s T4 information as well

\v 4 2016 T1/TP1: Cosan, Javier - Statement of remuneration paid

@ 1.Info \ @an

/4 2016 T1/TP1: Cosan, Jane - Statement of remuneration paid
2 3.T4 | -

@1 @2 53T . | Box | Slip #1 Slip #2 Slip #3 Slip #4 Total
‘ >
Description NewCo
International
o Province of employment [ 10 [Ontario
income 14 | 102911.00 0.00 0.00 0.00 102,911.00
Description NewCo Employee's CPP 116 | 2,544.30 0.00 0.00 0.00 254430
International [ 7] 0.00 0.00 0.00 0.00 0.00
El premiums 955.04 0.00 0.00 0.00 955.04
Province of employment | 10 |Ontario [PPIP 55 0.00 0.00 0.00 0.00 0.00
ent income 97.321.00 Exempt CPP/IQPP | 28 |No No No No
ploy CPP 254430 i e 1 INo No No No
QPP |17 | 0.00 PPIP No No No No
I e Bl »
RPP 2 0.00 0.00 0.00 0.00 0.00
E CPP/QPP _ |§28R(No Pension 52 0.00 0.00 0.00 0.00 0.00
El Income tax deducted 2 24312.44 0.00 0.00 0.00 24312.44
BRI El insurable earnings 2 50,800.00 0.00 0.00 0.00 50,800.00
Employment code L CPP/QPP eamings 26 54,900.00 0.00 0.00 0.00 54,900.00
RPP 2 PPIP insurable earnings 56 0.00 0.00 0.00 0.00 0.00
[Eansion = Union dues “ 0.00 0.00 0.00 0.00 0.00
Income tax deducted l22| 23121.00 Charitable donations | 46 0.00 0.00 0.00 0.00 0.00
El insurable eamings 2 50,800.00 J§ Lt - =
CPP/QPP pensionable eamings 2% 54,900.00 0.00 0.00 0.00 54,900.00
PPIP insurable eamnings 56 0.00 0.00 0.00 0.00 0.00
Union dues 4 0.00 0.00 0.00 0.00 0.00
Charitable donations 46 0.00 0.00 0.00 0.00 0.00

e Return to Jane’s T1 by pressing F'5 again, and press F'4 to find the TS form and record that slip’s

information

e Because it was decided that 50% of the investment earning is allocated to each spouse, enter “50” on

the line that reads, “% reported by spouse”

vl PROFILE - [2016 T1/TP1: Cosan, Jane - Statement of investment income]

i File Edit Audit Goto Form Options EFILE Online Training Window Help

T3W-H 0 % [H

4 @ -~

671013 | @ 1.Info | [ & Medical | (@271 | @551 | 8374 BZT5 \ |

@ ] GR[ = =

- —

<« »
Description HighFlying ETF|
 g—
% reported by spouse 50.0 00 0.0 0.0
% reported by taxpayer 50.0 0.0 0.0 0.0
Currency L —
Exchange rate to convert to Cdn § L 0 0 0 0
Eligible dividends | Actual Amount Iz 0.00 0.00 0.00 0.00 0.00
Taxable Amount 125 | 0.00 0.00 0.00 0.00 0.00
Interest from Canadian sources 113 | 44812 0.00 0.00 0.00 448.12
Source of Box 13 interest (for EFILE) | |1/Bank 1/Bank 1/Bank 1/Bank
Capital gains dividends |18 | 0.00 0.00 0.00 0.00 0.00
Dividends Actual Amount |10 1,275.00 0.00 0.00 0.00 1,275.00
Taxable Amount 11 1,491.75 0.00 0.00 0.00 1,491.75
Other income from Canadian sources |14 0.00 0.00 0.00 0.00 0.00
Name of foreign country L
| Foreign income 15 0.00 0.00 0.00 0.00 0.00
| Foreign tax paid 16 0.00 0.00 0.00 0.00 0.00
Royalties Work or invention 17 0.00 0.00 0.00 0.00 0.00
Other 0.00 0.00 0.00 0.00 0.00
Accrued income: Annuities 19 0.00 0.00 0.00 0.00 0.0q
Box 19 received due to death of spouse? No INo INo INo
Equity linked notes | Current year 30 0.00 0.00 0.00 0.00
interest Prior years 0.00 0.00 0.00 0.00

e Press F4 and enter DON in the Search field to open the Charitable Donations form. Record that slip’s
amount as indicated below
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/1 2016 TI/TP1: Cosan, Jane - Charitable donations [o-o-=
671013 | @ LInfo | O 4 Medical | @271 | @551 | (2374 O &Donations | (a7.75| + |

ritable donations [§

Charitable donations details

Name of organization Amount paid
[Parkinson Canada 100/00
oloo |
Reported on slips Claim: Own slips ofoo |
Total current year donations 100[00 |
Donations to U.S. organizations
Name of organization Amount paid
0Jo0
| Total current year donations ofoo |
Donations made to g entities oloo I
Donations made to prescribed universities outside Canada 0[00
Donations made to the United Nations, its agencies, and
certain charitable organizations outside Canada oloo i
Donations made to a registered museum or cultural organization 0[00
Community Food Program Donation (Farmers) 0[oo I

Charitable donations summary
us.  _
Modified EFILE: Eligible Balance/Refund 2,217.66 |GST Credit 0.00 | Combined balan... 3,223.06 +

Canadian _ Total v

Wrapping things up
Before finalizing things, you’ll want to double-check the tax returns. As discussed earlier, ProFile’s auditor is a
powerful tool that alerts you about any errors or missing information. In addition to the auditor, you will also want
to refer to the Slip Summary form. This form lists, on a single page, the information from every slip used on a T1.
e Press F4 to find Jane’s Slip Summary form. Use it to confirm the T4 and other slip amounts
e Press F5 to toggle to Javier’s T1 and to access his Slip Summary form as well

2016 Slip Summary
INAME: Cosan, Jane 2016 Slip Summary
[T4 Slips - Feuillets T4 1 Total NAME: Cosan, Javier
Description NewCo
Intemational T4 Slips - Feuillets T4 1 Total
D NewC
Province of employment Ontasio escoption oo
Intemational

Employment income 14 102,911.00 102.911.00
E[PP Contributions ;5 2 ;j: ;2 254 ;‘: Province of employment Ontario

EE— = Employment income 14 97,321.00
fncome tax deducted 2 2431244 P - = 254430
Elinsurable eamings 24 50,800.00 T e = T
[CPP/QPP pensionable eamings 26 54,900.00 e WA = 2312100

) . Elinsurable eamings 24 50,800.00
TS Slips - Feuillets TS 1 Total CPP/QPP pensionable eamings 26 54,900.00
Description HighFlying
ETF

 reported by spouse 500
6 reported by taxpayer 500
fnterest from Canadian sources 13 448.12 44812
[Taxable amount of dividends n 149175 149175

® You can also use ProFile’s Sign-offs Review Marks to indicate, on each form, that you have verified
and confirmed all entered amounts

1/ 2016 T1/TP1: Cosan, Jane - Statement of remuneration paid =
wim|e 374 | (2475 | [ 5 Donations | @ 6 RRSP/PRPP | # Z.Dependant | @ 8.51| + |
Box Slip #1 Slip #2 Slip #3 Slip #4 Total
< |
Description NewCo
International
Province of employment | 10 |Ontario
Employment income i [1a | 10291100 ¥ 0.00 0.00 0.00 102.911.00
Employee’s contributions | CPP |16 | 2,544.30 0.00 0.00 0.00 2,544.30
QPP L7 0.00 0.00 0.00 0.00 0.00
El premiums | 18 | 05504 0.00 0.00 0.00 055.04
[PPIP | 55 | 0.00 0.00 0.00 0.00 0.00
Exempt CPP/QPP 28 |No No No No
El No No No No
PPIP No No No No
Employment code 29
RPP contributions 20 0.00 0.00 0.00 0.00 0.00
Pension adjustment 52 0.00 @ 0.00 0.00 0.00 0.00
Income tax deducted L 22 | 24,312.44 0.00 0.00 0.00 312.44
El insurable earnings 24 50,800.00 ¥ 0.00 0.00 0.00 800.00
CPP/QPP pensionable earings | 26 | 54,900.00 ¥ 0.00 0.00 0.00 900.00
PPIP insurable earnings 56 0.00 0.00 0.00 0.00
Union dues |44 0.00 0.00 0.00 0.00 0.00
| [ Charitable donations 46 0.00 0.00 0.00 0.00 0.00




Using the auditor

e Press CTRL+FO to consult ProFile’s Auditor for errors, omissions and suggestions
e Double-click an audit message to jump to the related form
e Use a sign-off to clear the audit message

V4 2016 T1/TP1: Cosan, Jane - T1 Summary

Taxpayer personal information

@27 @4 Tisummary |E 5. Donations | @ 6. RRSP/PRPP | [J 7. Medical | @ 3.51 | [ 1.Sips | #% 8 Depend « | >

TrSum 2016 Tax Return §

= © s

Spousal information \/ 4 2016 T1/TP1: Cosan, Jane - Statement of investment income

[E=S =R

wﬂ here.

ew whether the taxpayer is considered 3 first-time donor and provide ang

SIN 444 444 442 SIN - "
b ) s @ 5 3 3 yA 3 .
Name Cosan. Jane Name Cosan, Javies @Wim| @2mfo| (s34 2 |\; 4.75| [ 5 Donations | @ 6 RRSP/PRPP | iy 7. Dependant | < 8.51 | |
Care of 1978-12-20 Taxable amount of dividends other than eligible dividends (specify)
e - 50.0% 5 sles B
Street address _ 12 Main Street I Apt # HighFlying ETF (50.0% of 1491.75) 746 88 A
[:X s
OB RR Jioun Province of residence on 2016/12/31 Enter this amount on fine 160 of your returm 180[ 745
[
Province ON IEF"-E this votym? Taxable amount of eligible dvidends (specify)
Postal code __ M4A 1A2 — oloo
Home phone __(909) 555-1212 Use preparer address for Enter this amount on line 120 of your retum 120) 745(66
i .12~ Date of death
R 19791242 e Il- Interest and other investment income
Marital status  Married pecify
Total income HighFlying ETF (50.0% of 448.12) 22; 38
Employment income (box 14 on all T4 slips) 101__102911joo J§ [Ty Ty e
Taxable amount of dividends from taxable Canadian corporations 120 745/88 |j " o .
Taxable amount of dvidends other than eligible dvidends, Enter th TR 121
included on line 120, from taxable Canadian corporations 180 745]88 Lnter ths amount on hne 171 of your feturn
Interest and other investment income (Attach Schedule 4) pral 224)06 l Il - Carrying charges and interest expenses
Total income 150___103.850[04 J§ Accounting fees ooo J§
Net income - Management or safe custody fees 0/00
< L Investment counsel fees 0[00
Reported on T5013 slips 0[00
mary @ Warnings Q Notices « Sign-offs X Issues Overrides Memos EFILE o 43 0[00
[@ Notice $4 Taxpayer has income. Are there carrying charges or interest expenses that could be deducted? Legal fees paid to collect, establish or increase the amount of supportpayments 0 _I°°
@ Notice S9 Donations are being claimed. Please r Interest on money borrowed to eamn interest, dividend, and royalty income 0[00

Interest on money borrowed to acquire an interest in a limited partnership or a partnership in which you are not

Modified EFILE:

Out the door

Eligible

Tax shelter
bnce/Refu... (1,761.96) |GST Credit 0.00 [Combine... 2.051.88) + Rental and leasing property

an active partner:

Resource property

Enter this amount on line 221 of your retumn.

You’ll need to provide to your clients a copy of their tax returns. You can, of course, print the return or, as is
becoming increasing popular, provide a PDF copy. In either case, in order to EFILE the returns, you will want
your clients to sign CRA’s T183 form.

e To print the return, click the toolbar’s Print icon

e ProFile will open the Print Selection window—ready to print only those forms that you selected under
Options>Print Selection

v 2016 T1/TP1 Print Selection

? X
Print Job 1. Cosan, Jane [7] 2. Cosan, Javier 3. Cosan, Maria
EAAllow mukie obs Pint Detais
Llrapel [ B T Piintthese sets
ClT1Eab Busincss |Ea i Archive these sets (PDF)
ﬁwﬂenl &l Duplex sets
eview & Review marks
e @ ] 4 per page
Aftor prining o Language
E“’"e:‘:**“ Find Fom: [ @
ange the status to
Comiid S [N - ] Information return for electronic filing - pages 1 ~
[} Information return for electronic filing - pages 2
Options [ E] Discounting transaction - pages 1
[JKeep selections @& Discounting transaction - pages 2
Piint All Pages - oA T1 jacket-pages 1.2
[E1} T1jacket-pages 345
[ Date in heading =1 : Fe éeralTai o
EADefaut pinter @ e Amounts transferred from your spouse
EAMerge print sets @ @& Capital gains (or losses)
[ Show only Selected - | Statement of investmentincome
Pining Tios e Details of Dependant
ot FRENE] Working Income Tax Benefit
L To quickly print a form you o an RRSP and PRPP Unused Contributions, Transfers, and HBP or L.
czlg:‘—;l’g(r:r;ll':;!mm o EQ CPP on self-employment and other eamings
SnC SSioch LIRS0 @ EQ Donations and gifts v
Newt
Simpified Print Setup. SetDefauts | | Cancel Help
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e Ifyou’d rather email a PDF, first enter the client’s email address on the Personal Information form,
then click Print / Email PDF

e In the eReview Print Selection window, ProFile enters the email address for you

e After confirming the address,

e  Click Email to send the tax file

/4l 2016 T1/TP1 eReview Print Selection 7 X
(LD 1. Cosan, Jane [7] 2. Cosan, Javier [7] 3. Cosan, Maiia
|Alow mubivl ibs Pt Deta
o ot A T B [ [T [ Emaithess sets (PDF)
e s = @ @ B B Reviewmks
TS Language
After Build PDF/Email FndFom ‘ ®
[ Take snapshat
- B Information retur for electronic filing - pages 1
T o B -] T183-2 Information return for electronic filing - pages 2
FNE] & RC71A Discounting transaction - pages 1
Options @ @ 5 RC712 Discounting transaction - pages 2
[JKeep selections @ EE B T2 T1jacket-pages 1.2
A Date in heading [EN-NE B T1-345 T1jacket-pages 345
A Merge ik sets [ - = 5 S1 Federal Tax
[ Show onb Selected @ & B s2 Amounts transferred from your spouse
w only Selecte
Y @O B S3 Capital gains (or losses)
[IDskete POF @ B s4 Statement of investmentincome
Resolution 300 DPI i [FNE] E S5 Details of Dependant
Email Template @@ B sb Working Income Tax Benefit
<none> v Bl B s7 RRSP and PRPP Unused Contiibutions, Transfers, and HBP or L.
— @@ 8 B S8 CPP on selfemployment and other eamings
ey @ B EBE S9 Donations and gifts
Find Form - =
- A E v
Tobiingthe Find Form 2] Donations Charitable donations
"~ search box back into focus,
press <F3> Emal addiess for Cosan, Jane
e B
Simplfied Preview Emai Cancel Help

EFILE it

The very last step is to EFILE the return. EFILE is CRA’s electronic-filing portal that all professional tax
preparers are required to use.

Before a preparer can EFILE a tax return, she will need the client’s signature on CRA Form T183. Here are a few
additional need-to-know items regarding the T183:
e Ensure that your client signs at Parts D and F of the T183
e Consider checking the box that reads Want instant CRA assessment results... Clicking that box will
activate CRA’s Express Notice of Assessment, thereby allowing individuals and authorized
representatives to view the result of an assessment immediately after filing a return—and receive a
Notice of Assessment the next day



Cosan Jane SIN: 444 444 442 Privsec 2017.10.04 14:20

.*. Canada Revenue Information Return for Electronic Filing of Protected B
Agwrcy an Individual's Income Tax and Benefit Return when completed
Tax Year : 2016

Thie rfomeation Sourd on P Krm coresponds 1 th syt Foated on the Fght
Bofore you 1 cut 1 Torm, e fomealion s Instractioes on cage

The raividus (e gal rapesertative) idantfied in Pat A must sgn Part F. Part G 16 1 be filod out by your eloctrorkc fler 0nce the foturn has boan submitec

Give the signed crging of ths Sorm 30 your electroric Nier arG koo @ copy for yoursel!.

Part A - Identification and address as shown on r return (mardatory)

Last ramo Soc Insurance rumber

[Cosan |44 444 442
Maling acdrass. Apt 10 - Street no Street name POBox | RR Cy Prov.Terr | Postal coce
12 Main St nytown ION IM4A 1A2

Part B - Declaration of amounts from your General Income Tax and Benetit Return (mancatory)
Entor the folowing amounts from your ratum, # appicable

Total income (line 180) 103,880 94
Taxable icome (ine 260) 103,880/94  Refurd (line 484 |
or
Total federal non-refuncable tax credits (ine 350 of Schadule 1 2,43515  Balance owing (ine 485) 2,217166

Part C - Optional sign up for new Canada Revenue Agency (CRA) services
» Want to go paperiess? Give CRA your email address and your CRA mail will be delivered electronically in My Account

Emall Address (optional):
| understand that by providing an email adcruss, | am registering for onlive mal and | accept the terms and conditions. For more formation. refer 1o page
2

To access online mal you must be registered for My Account.
» Want instant CRA assessment results and your Notice of Assessment faster? Tick this box: i

Y L ———
rotor 10 page 2.

0 box atove, | aen alowin 10 1w alwctronse §

» Pt E. Foe

P Want to Pre-authorize CRA to withdraw a specified amount from your bank account? Fill in the info below

1 Paraby auronzo e eloctronk e 1 Craatn 146 perscnal oo auihorizod dotit on My ahat. | UEhorizn tho CRA 1o automascally widraw the 4.nds #0m My bank accourt as por the
agreemant dotals Istod elaw. | acknowladge that | Fave f0ad and Lndamiood the IMbrmason about re-auihorzod detit on Page 2 of i form,
2017-10-04
Sgratum Yo Morshs Dwy

O ime paynant ko your iidust come sas (71), Yo be wihdrean o ] for s mourt of
Yoar Month Day

» Want to ReFILE like you EFILE? Tick this box: B

| undorstand that by ticking (x) the box above. | authorize the olecironic for namod n Part & 1o Ref L my amendod T4 retum

n electronic filer t 1t you
AUhoriz0 tho Canada Hevanue AGoncy 1 deal with the 0KCHTonK: flar ramed 1 Part B 5 My Foprosentativn 1or ACOMO Sx MAtiors o My K faturm.

T W 20000 5 e 1 e ApecTic Lx et and oms 01 DOV Ty repemaninve wih o0k wooess This wuthoraton wi espim on

Yoar Month Day
 you 30 rot Show an axsiry dat, this ausnorzaton will ramain in effact unth you. the undersigned, cancel & Kead page 2 of this form for mare detalls
2017-10-04
[S1g79ture (ndvidua iderafied in Part A or agal feprosertative) Naro and tho of lagal oprosertatin Year Moeth Day

Part E - Electronic filer identification (mandat
By aring Purt F beow, you decure Tal the 1o " b o frm s sincroncaly fiing B 11 rebrn andicr B amended T1 et (f ReFILE & fchnd above) of S penon e
Part A Part F must be signed bokro the retrn & aeciancaly iranam

Naera of parson oe fem A1 T 1 Ednctronic fer numene 09339

Part F - and ¥)
| Gaciar that the rfomation ertered In Part A, B and € a0 coroct and complote and fully decksn my Incom from al sources. | 160 Gocare that | have fead the Fformation on page 2
of this formm, wnd Pt P skectronsc Siee sntitnd n Purt € i il mry wtum | wlaw the ewctone fer o communcatn wit the CRA 10 corect sty er#om of omasons.
Sigranre (ranidus I5eTed 10 Part A cf 10ga roprosertatie) Nama and the of lmgal Foprosertative Year Morth Day

Part G - Document control number (mandatory)

Entor the documant contrel numBber 10° the FAIUN's BCHONK fecord ‘

0933916725338

Frivacy Act personal Information bank numters CRA PR 008 and CRA PPU 175

e To EFILE the T1 return, just click the EFILE menu and select EFILE/ReFILE this return

Ctrl+F11

EFILE the T1013 for this taxpayer...
EFILE the T1135...

Build T1 EFILE Online Batch...
EFILE Online Batch

Build TP1 NetFile...

TP1 Connect...

Reports >
Print All ACKs

View Notice of Assessment (ENOA)

Set EFILE Password

Options...

And that’s it. Job done!




Chapter 4 Quiz

Question 1: Tax preparers use the term “T1” to describe:

The form an employer sends to an employee at year-end
A statement that a bank sends to investors

A corporate tax return

A personal tax return

cawy

Correct answer is D

Question 2: True or False: You record all income and deductions directly onto ProFile’s T1 jacket

Correct answer is False

Question 3: ProFile’s Info page is used to:

A. Enter all amounts earned during the year

B. Enter the names of employers, banks and investments houses
C. Indicate which forms and schedules you want to use on a T1
D. Enter the name, address and other personal information

Correct answer is D

Question 4: True or False: Each type of income (T4, T5, etc.) is recorded on a dedicated form or Schedule in
ProFile

Correct answer is True

Question S: True or False: The T2202 Form is used to enter tuition amounts paid to a learning institution

Correct answer is True

Question 6: A signed T1013 form is used to:

A. Geta client’s sign-off on a completed T1

B. Record deductions and credits

C. Ensure that there are no CRA omissions

D. Access CRA’s website and obtain a client’s tax information

Correct answer is D




Question 7: True or False: There is an icon on ProFile’s toolbar to toggle between spouses’ T1s

Correct answer is True

Question 8: True or False: You use the Slip Summary form to verify the amounts from all slips

Correct answer is True

Question 9: A signed T183 is used to:

Record the amount of tax deducted on a T4 slip
Get a client’s authorization to EFILE a T1
Change an error on a filed T1

All the above

oCawy»

Correct answer is B

Question 10: True or False: ProFile cannot EFILE a T1. You can only do so from CRA’s website

Correct answer is False
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Chapter 5: Advanced T1 Work

CHAPTER 5 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e How to prepare a T1 when there are dependents
e How ProFile optimizes a T1
e How to prepare T1 for the self-employed

DEPENDANTS AND DEDUCTIONS

Now that you have learned the basics, let’s explore T1 preparation at a more advanced level.

Building on the previous example, assume that a married couple, Jane and Javier Cosan, also submit additional
forms.
e These forms include the following RSP slip

TD Waterhouse Canada Inc.

77 Bloor St. W.
Ii ’ P.O. Box 5999, Station F
REGISTERED RETIREMENT Toronto, ON M4Y 2T1
SAVINGS PLAN
ATTACH TO FEDERAL INCOME TAX RETURN
DATE ACCOUNT DURING THE FIRST 60 DURING THE REMAINDER CONTRIBUTOR'S NAME
NUMBER DAYS OF THE YEAR OF THE YEAR
FEB 24, 2017 8000.00 Jane Cosan

INSURANCE NUMBER INSURANCE NUMBER

ANNUITANT'S SOCIAL ICONTRIIUTOR‘S SOCIAL
N

Jane Cosan 444-444-442 444-444-442
12 Main St Contribution was in whole or O
Anytown, ON in part, in kind
M4A 1A2
Official t ipt H—
Registered under the ncome tax act ‘ # o

L ab

(CANADA) and subject thereto.

e And a schedule of Medical Expense

Medical Expenses
Date Description Amount
Javier Jan 12, 2016 | Eyeglasses 812.88
» Jane Jan 12, 2016 | Eyeglasses 910.44 ‘
Jane Mar 31, 2016 | Root Canal 1440.12
' Javier June 14, 2016 | Crown 1299.02 ‘
' TOTAL 4462.46 ‘

e Further assume that Jane also submitted to you the following T4 and tuition slip for her daughter,
Maria, who is a full-time student at Concordia University



POl Sousereme Ao s e

Tuition, Education, and Textbook Amounts Certificate Protected B/ Protégé B T2202A (16)
Certificat pour fras de scolarté, montant relsti sux #tudes  hen compieted /une fois oo s
et montant Pou

2% avor 16 a8 0u P

o Ninaciives pan 1o Go0t dos mamuels our oo ormulaire L Wackart calcule s mortards elaths sk
#tuses et pour manuels d'aprés be nombre de mois nSicub dans les cases B ou C -dessous

N o o o7 Course o G4 program 03 o T
Fine Arts 323122
Maria COSAN ) ’
12 Main St c
T s
Anytown ON M4A 1A2 CAN T . T 1
" 01_| 2016 | 04 328547, 0| 4|
Concordia University 09 | 2016 % 12 3,329.80 | g ; |
1455 De Maisonneuve Bivd W Y ) o]l
Montreal QC H3G1M8 Tomen 6,615.27 0 8
e o 3 sucents 1
Revsoranerarts bout b R —
Empioyers name - Nom 08 fempioyeur ] Ganaca Revene  Agerce o reeny T4
Outdoor Equipment Inc Year | I Statement of Remuneration Paid
Amnge | 2016 Etat de la rémunération payée
Empiogment ncorme - ine 101
Reverus gempio - igne 101
I“J 1 92!@ ] 1
'é [“{wam‘»-uw’f e | Waméro de comale O femoioyeut Prosece ol nloyrer_ Erooyees CPP corkttons~loa 8 T e
96852 2243 RP 0001 odnos satons do Fermploy o ™~ Gans assurabios GAE
e ] 10 16 24 "
a —— s o O] (] oo | B neeo |
E Numar dassurance socal copoep E‘ “"‘" Employment code Empioyee's QPP contributions - ine 308 CPPOPP ponsionable
@— E Code demplo Cotestions ce lempioy & ARG - Kgre 308 _ Gains cuvrar 701 & penson - ARGAAQ
2 [Zlossss5556 | [ 7 2]
2 wemore e 2| 7] [ ] B 1g2ioo |
o ) 22
'8y [Empioyes's name and address - Nom et adresse de Tempioyé Cotauiors Se Tempioys 4 TAE = tgne 312 Cotsacons synccaies - igre 212
H mcons s ot ot ___rowra-pw_ v | (18] 224]11 |
= -.{ COSAN Maria |
3
3
=% 12 Main St Perision adustment - e 206
H e
3
E Anytown ON CAN M4A 1A2
E
o
3
% Box - Case Arourt - Vortare Box - Case Aot~ Mortart Do C.
§ Other information I J I
a (see over)
| autes Box- Case Amout - Mortart Box - Case Amount - Motant Box- Case Amount - Montant
: s [ | [ ] | [ l
5 |voirauverso)

RC-14-500

Recording RRSP contributions

e With Jane and Javier’s tax return open, press F4, enter RSP in the Search field, and Profile will open
the RRSP/PRPP deduction form

\/ 42016 T1/TP1: Cosan, Jane - RRSP/PRPP deduction
6.T1013 | @ LInfo | (2.T1 | @ 5.51 | (2 3.T4 | [ 8 Donations | [J 4 Medical @ 9 RRSP/PRPP | 75| .+ |

RRSP/PRPP ded

RRSP contributions

Verify unused amount from Box B Notice of Assessment or enter it as 'Prior to 2016".

Contributions made to

Description Contribution period Own RRSPs Spousal RRSP:
1D January 1, 2017 to March 1, 2017 ] 8.000/00
March 1 to December 31, 2016 ! 0jo0 0joo
Subtotal 8,000[00 ofoo

PRPP Contributions
Employee Contributions

L - . Made to
Description Contribution period Own PRPP
January 1, 2016 to December 31,2016 i oloo i
Subtotal ofoo |§

PRPP employer contributions: January 1, 2016 to December 31, 2016
(amount from your PRPP contribution receipts) - report on line 205 0|00 I

Total RRSP/PRPP contributions

Contributions made to
Own RRSP/PRPP  Spousal RRSPs

RRSP contributions 8.000[00 J§ oloo i
PRPP contributions 0 gl

Subtotal 8,000(00 oloo i
Less:Designated Home Buyers' Plan (HBP) repayment 0Jo0 I
Designated Lifelong Learning Plan (LLP) repayment 0Joo I
Non-deductible contributions due to HBP or LLP withdrawal oloo
Refund of undeducted contributions included above 0/00 I
Total RRSP/PRPP contributions 8,000[00

<

Modified EFILE: Not eligible Balance/Refund 1,710.81 |GST Credit 0.00 | Combined balance2,716.21 + /|




e  When entering RRSP contributions on this form, scroll down to enter or confirm the taxpayer’s

deduction limit (which you will find on CRA’s Notice of Assessment). Note that ProFile will not allow
an RRSP deduction until you fill in this field

\/ 4 2016 T1/TP1: Cosan, Jane - RRSP/PRPP deduction o=
@ Linfo | (2475 | [ 5 Donations @ 6.RRSP/PRPP |EZ2.T1| (& 3.74] + |
AROFIFACE uBuULUUT 14,001 jUY "
SPP deduction limit
Own SPP oloo | spousal sPP oloo il 0joo
SPP deduction 0[00
RRSP/PRPP deduction limit
Option 1: Enter limit from 2015 Notice of (Re)Assessment 14,861 .
Option 2: Calculate the limit
2015 eamed income 0 x18% ofja
Lesser of A or $25,370 off
Less:Pension adjustment from 2015 T4/T4A slips ol
2016 past senvice pension adjustment 0 l
Plus: 2016 pension adjustment reversal from T10 slip 0 I
Subtotal [ |
Plus: Unused RRSP/PRPP deduction room from 2015 0 I
Subtotal 14,861 )}
Less:Saskatchewan Pension Plan deduction off
RRSP/PRPP deduction limit for 2016 14.861
RRSP/PRPP summary
2016 RRSP/PRPP deduction limit 14,861
Eligible income transferred to your RRSP/PRPP 0
Subtotal 14,861 14,861 |8
RRSP/PRPP contributions to March 1, 2017 8,000 §C
RRSP/PRPP deduction (lesser of lines B and C) 8.000 @D
RRSP/PRPP contributions carried forward to 2017 (C - D) off
SPP contributions carried forward 0 I
v
< >
Modified EFILE: Eligible |Balance/Refund  (1,255.10) |GST Credit 0.00 [Combined balan...(249.70) +

Entering Medical Expenses

e To optimize a married couple’s tax return, you will want to combine and claim medical expenses on
only one of the spouse’s returns. Assume, therefore, that you have decided to enter the medical
expenses on Javier’s T1

e OnJavier’s T1, press F4, enter Med in the Search field and ProFile will open the Medical Expenses
form

e Enter the medical expenses as illustrated below

/4 2016 TI/TP1: Cosan, Javier - Medical expenses

(oo =
@ linfo |[2T1|(53T4| @4t L‘i-MedicaI] +

Medical Medical expenses

Optimize medical expenses? Yes |:| No
Medical expenses - line 330

Period covered by claim:

from 2016-01-01 to 2016-12-31 |

Payment date Name of patient Payment made to ‘?":::::: ':";:‘f;'," Amount | Claim |
016-01-12_|Javier Cosan Optical Centre Eyeglasses o .| 12[88 || 12[e8 |}
016-01-12 |Jane Cosan Optical Centre Eyeglasses o .| 1044 | 1044
016-03- Jane Cosan Downtown Dental [Root Canal o .| 144012 1.440/12 @
016-06-14 _|Javier Cosan Downtown Dental [Crown o .| 1.290[02 | 1.299/02 |
-mm-dd o . | oloo i ojoo o
Medical expenses subtotal 4.462|46 l
Are you claiming medical expenses? No !
Taxpayer Spouse
Premiums paid to private health service plans 0Joo 0Jo0 I
Employee/Recipient-paid premiums for private health services plan 0[00 Y |
Québec prescription Drug Insurance Plan - 2015 0[00 0j00

Nova Scotia Seniors' Pharmacare Program 0Jo0 0J00 0]00 I
Total medical expenses - line 330 0[o0 I

Modified EFILE: Not eligible |Balance/Refund 1,005.40 | GST Credit 0.00 | Combined balance(756.56) +




Recording Dependant Information

e With all of the spouses’ information entered in ProFile, the last step is to record the slip information for
the Cosan’s daughter, Maria. To do this, you will use a feature called Family Linking.

Family Linking

When you create a dependant’s tax return, ProFile will link the return with that of the

parents. You can tell Family Linking is enabled by the toolbar icon and dropdown
Cosan, Javier menu that lets you toggle amongst the family’s tax files.

v Cosan, Maria

osan, Jane

e  With the spousal return open, Press F'4 and enter Dep in Form Explorer’s Search field
e Enter Maria’s personal information on the Dependant information form

/4 2016 TI/TP1: Cosan, Jane - Dependant information =3 Ich ==
6.T1013 | @ L.Info | [ 2.T1 | © 5.51 | (& 3.T4| [ & Donations | @ 9.RRSP/PRPP | [J 4.Medical &4 Dependant | Bz1s| + |

- - A
Dependant information
Are you eligible to receive the Child Tax Benefit? Yes No []
Family caregiver amount claimed by You Spouse []
Depend Depend Depend

. o
Social Insurance Number 555 555 556 | |
First name Maria | |
Last name Cosan

Daughter IN/A IN/A
Birth date 1998-06-23 'yyyy-mm-dd 'yyyy-mm-dd

et income 0.00 0.00 0.00

Claim as eligible dependant? No No No
Dependant claiming GST credit? __|Yes No No
Dependant claiming PST No] No No
credit (MB)?
Did you or your spouse or No No No
common-law partner received in
December 2016, child assistance

payments from Retraite Québec?
Qc)

Did live with you in 20167 |Yes | | No No

Street address 12 Main Street

P.0.Box,RR

Apt No.

City /Anytown

Province ON

Postal code M4A 1A2

Province of residence on 2016/12/31_|Ontario NA NA

Disabilitv/inficmity v
Modified EFILE: Eligible |Balance/Refund (1,761.96) |GST Credit 0.00 [Combined balance (756.56) +

e Tocreate a T1 file for Maria, right-click on any field in the form and select Return for Maria
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\/ 4 2016 T1/TP1: Cosan, Jane - Dependant information
671013 | @ 1.Info | (2.1 | @ssl|a314| pe Donationsl D 9.RRSP/PRPP | [J 4.Medical &% Def
Dependant

Are you eligible to receive the Child Tax Benefit?

Family caregiver amount claimed by Spouse |:|

F1
Social Number Return for Maria
First name |
Last name Cosi
Relationship |Dau Copy
Birth date 199¢ Copy field code
Net income |
Claim as eligible dependant? No
Dependant claiming GST credit? Yes Insert column
Dependant claiming PST No
credit (MB)? | Delete column
Did you or your spouse or No Format override Ctri+F2 N;
common-law partner received in ooty s
December 2016, child assistance ach meme
payments from Retraite Québec? Copy Memo/Tape
Qc) | Paste Memo/Tape
Did dependant live with you in 2016? |Yes o
Street address 112N A ES e |
P.0. Box, RR Review marks >
Apt No. lose f L
City |Anyt Close form Esc [
Province ON Print form
Postal code New window
"

e ProFile will confirm that you want to create a tax file for Maria. Click OK

Confirm X

0 ProFile

Create a new return for Maria?

e From Maria’s tax file, return to Form Explorer and enter Maria’s T4 and T2202 (tuition) information

4 2016 TI/TP1: Cosan, Maria - Statement of remuneration paid
Olnfo|@am B3T4| . |
[ Slip #1 Slip #3 Slip #4 Total
|
Description Outdoor
Equipment
Province of employment 10 Ontario
Employment income (14 1192100 0.00 0.00 0.00
Employee’s contributions | CPP ‘16 417.00 0.00 0.00 0.00
QPP ‘7 0.00 0.00 0.00 0.00
El premiums | 18 2411 0.00 0.00 0.00
PPIP 55 0.00 0.00 0.00 0.00
Exempt CPPIQPP | 28 No No No No
El No No No No
PPIP I iNo No No No
Employment code 2
RPP contributions 2 0.00 0.00 0.00 0.00
Pension adjustment 5] 0.00 0.00 0.00 0.00
Income tax deducted ‘2 1214.88 0.00 0.00 0.00
E'F;giggg'::s”l‘;:g;a — i 2 2016 T1/TP': Cosan, Maria - Tuition and education credit cetficate =
PPIP insurable eamnings 5 | @ Linfo |@2T1| 8374 saTR202TLNT | L |
Union dues ‘a4
Charitable donations 46

Modified EFILE:

|Concordia U
T2202A, TL11A, TL11B, TL11C

Tuition fees paid A 661527 0.00 0.00 0.00

Number of months in parttime enrolment | B | 0 0 [ 0

Number of months in fulltime enrolment | C 8 0 [ 0
0.00

TL11D

Tuition fees paid )
Charitable donations 0.00




Tuition transfers
When a student’s income isn’t high enough to use up all of the tuition credit, CRA allows that student to transfer
the excess credit to a family member. ProFile takes care of this transfer automatically. It does so by a process
called optimization.
e Because Maria did indeed have excess tuition expenses, ProFile automatically transfers the applicable
tuition credit to the appropriate spouse. A quick glance at line 324 on the S1 form of Javier’s
Tlconfirms the transfer

isabilfy amount (for S¥If) (claim $8:401, or ¥ you were under a , Usé thefeder: Tksheet) 6 0[oo 1
bisability amount ferred from a dependant (use the federal worksheet) 8 0/00 m 22
B‘nerest paid on your student loans 9 0§ 23
)our tuition, ed ion, and textbook (attach Schedule 11) 0
)ition education, and textbook amounts transferred from a child 4 5.000]00 @ 25
Amounts transferred from your spouse or common-law partner (attach Schedule 2)

igal expeps; on-law partner, ul

There is a setting in ProFile that toggles family linking on or off. To make sure that this setting is enabled, go to
Options > Module and scroll down, under the General tab, to the section that reads “Allow family linking.”

Module Options ? X
i 12017 TP V] 32015-2017 T2 w | &) 52016 T3/TP646 ¥ ] &3 z2017mx |
File Template
[ l Browse
General Datalocking Variance Disclaimer T1/TP1 Review
[0 Update preparer information on Info form (using the informati A Language
[X] Complete preparer information on T1 jacket @® English
X Curent signing date OFrench
|m} Complete line 6509
B Joint client letter
B Joint client invoice
! TR U gud "Form Selection” settings
0 Calculation options
[x] Allow family linking
- on
X Recalculate invoice on data locked returns
& File naming
© Long names
Q Long with SIN v Cancel
< > Help

As mentioned in the previous paragraph, ProFile provides seamless, invisible optimization, and it alerts you with
audit messages designed to achieve the most beneficial tax results for a tax preparer’s clients.

Here is what ProFile’s optimization prowess includes: medical expenses; donations and losses; foreign tax credits;
advantageous caregiver and infirm dependant claims between spouses; smart disability credit transfers; and
intelligent transfer of tax credits between taxpayers and their dependants.

Pension Splitting
Splitting pension income is another example of ProFile’s optimization capability. Let’s look at an example.

The Tax Summary below shows that Mary earns significantly more that her spouse, Frank, and it also reveals that
Mary has pension income of $48,950. There is an opportunity, therefore, to split the pension income and reduce
the couple’s overall tax liability.
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Summary

Total income

Old Age Security

CPP/QPP benefits

Other pensions
Split-pension amount z
Universal Child Care Benefit
Employment Insurance
Taxable divi

Interest

Limited partnership

RDSP

Rental

Taxable capital gains
Support

RRSP

Other

Self.

Workers' compensation and
social assistance
Total income

Netincome
RPP
RRSP *

Spm-Pe"gn Deguction, o -

e To optimize pension income, go to the pension-transferor’s return and open form 77032
e Scroll down the form and click Split-Pension Income

Protected B
when completed

r Step 3 - Elected split-pension amount

For assistance in determining the elected split-pension amount, s ur Split-Pension Income worksheet.

Enter the amount that you and your spouse or common-law partner decide to jointly el

split pension amount for the year. The split-pension amount cannot be more than the amount from Line F. 0[00 §G

Enter this amount on line 210 of the ing spouse or law partner’s return and on line 116 of
the receiving spouse or common-law partner’s return.

r Step 4 - Pension income amount (line 314)
Part A - Calculate the pension income amount of the transferring spouse or common-law partner.

Amount from line A 48,950.000 ;]
RS S T e S ~ el st S

e ProFile opens the T/0320pt pension worksheet form. Right-click the form and select Optimize split
pension income

T10320pt - = =
plit-pension income

Information for the elected split-pension amount
| The Spiit-Pension Income optimization worksheet helps you determine the amount, i any, to enter on line G of the T1032 - Joint Election to

Split-Pension Income.
To view the amount that we suggest for transfer, right click on the worksheet and select Optimize split-pension income.

For additional information, press <F1> to access help for this worksheet.
Calculation of the elected split-pension amount Copy ield code

e B BICINRS Copy Memo/Tape.
o Paste Memo/Tape.
Elected spit-pension amount 00 00 000 Close form [
[ty o o o0
Total payable (ine 435) [Frank 00 00 00
Combined 00 00 00 e
Mary 00 00 00 Launch window
Balance owing / refund  [Frank 00 00 00 CresteFx
[Combined 00 00 00 reate
Combined net benefit (cost) 00 00 Create T3
Carry forward

[Maximum split-pension amount (from line F of your T1032) 24.475.00 | Previous year's retun

Please enter the split-pension amount you wish to transfer to Frank. Show auditor Cti+F3
[This amount will appear on line G on your T1032 Elected split.pension amount 000

- o

e As illustrated in the window below, ProFile will run an analysis and then suggest the pension income to
transfer
e The form highlights the net benefit of accepting the suggested transfer =

e And it also provides a chart outlining the tax liability with different transfer amounts =
e To accept ProFile’s suggested transfer, right-click the form and select Elect split-pension amount of

524,475 B



Calculation of the elected split-pension amount

Elected spiit-pension amount [ 2447500 00

Mar 43533 32.003.13 | 00
Total payable (ine 435) [Frank 3,688 11,044 00

mbined 47222 43,047 00

Mary 20374 14,844
Balance owing / refund [ Frank IR 1.04422 § & Elect spiit-pension amount of $24,475.00

Combined 20.062.97 15,888.35 | S —
Combined net beneft (cost) 4174 Copy field code
Summary of the elected split-pension amount o ienalles]
We have determined that transferring $24,475.00 to Frank's retum will esult n the lowest combined total payable. If you elect to transfer ti "> Memo/Tape
suggested amount, the balance owing of $20,062.97 is decreased to $15,888.35. This represents an overall savings of $4,174.62 Close form =
Maximum split-pension amount (from line F of your T1032) > 275 ool

New window

Please enter the split-pension amount you wish to transfer to Frank.

This amount will appear on ine G on your T1032 Elected split.pension amount 000  launchwindow

Create FX

Impact of electing a split-pension amount on your combined total payable P
reate

Cany forward

™
Combined | 47
total Show auditor Ctrl+Fg.
payable | E
(ine 435)

«l

S0 ST Sem5  SLM2  S970 S22 S14885  SITAR  SI9S80  S22027 824475
i unt (max 524,375 0

You can learn more about optimizing, go to Help > ProFile Help, click the Search tab and enter “Optimizing” in
the Search field

Vil ProFile Help - O X

- 2 P s 53]
i@ 207 1/1P1 Help WebSite  Online Resouces  Contacts

e 2> Q [ &
Back Foward Siop Refiesh Pt

Contents Index ~Search Optimizations
Type in the keyword to find:

ProFile provides seamless, invisible optimizations,

(Optimizing ‘ and savvy audit messages designed to achieve the
best results for your clients. In addition to the
List Topics optimizations described here, there are foreign tax
S p— credit optimizations, advantageous caregiver and
iTopCE ey infirm dependant claims between spouses, smart
Gifts and Income Tax disability credit transfer, and intelligent transfer of
Medical: Medical expenses tax credits between taxpayers and their
dependants.
Optimizing chartable donations [Py medical expenses
Optimizing losses donations
Optimizing medical expenses losses
Display
Topic feedback: Comments about this help topic:

O Topic was very useful

O Topic was partially useful

O Topic was irrelevant Submit

[/] Display comments area Enable anonymous help tracking

PROFILE AND THE SELF-EMPLOYED

As professional-grade tax software, ProFile can accommodate many types of income-generating scenarios.
Examples include rental income, investment income and income from self-employment. This section will
illustrate ProFile’s ability to accommodate the latter scenario.

Sam Hruzec, runs an un-incorporated marketing business called SH Marketing Services. Sam has asked you to
prepare a T1. Sam has no income or expenses, other than the Statement of Revenue and Expenses below.
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SH Marketing Services
Income Statement
Janauary - December 2016
Total

Total Revenue $ 91,773.00
Expenses

Advertising 144747

Interest and bank charges 1.546.84

Membership Dues & Fees 1,573.59

Professional fees 4,800.00

Office Supplies 1.397.70

Travel 4,199.00

Telecommunications 1,.634.32

Vehicle lease 6,624.00

Fuel & Oil 2,322.00

Repairs & Maintenance 956.00

Vehicle Insurance 1,433.00

Vehicle Registration 149.00

Condo interest 6,300.00

Condo insurance 375.00

Condo heat 689.00

Condo electricity 498.00
Total Expenses $ 35,944.92
Profit 7§ 55828.08

T2125

You will record all of Sam’s business-related revenue and expenses on form T2125, Statement of Business or
Professional Activities. After entering Sam’s personal and contact information on the Info page, use Form
Explorer to find and open the 72125

4l Form Explorer ? X
71 o N 2
& Hruzec, Sam ‘ '\ Lo E & M b
Form: [T21 2 ] Open Print  New | List Detal Key Ling
Forms Name Category Description Used Lastyear Step A
T 2 T2091WSH Income Principal Residence Worksheet No N/A& 88
_ o L2218 Income Fishing activities No NZ& 83
1 Identiication | -4 12121CCAS... - Income Summary of CCA for fishing activities No NA @0
™ 2 Slips “LT221CECH Income Cumulative efigible capital for fishing activi.. No N/A g1
™ 3. Income T T2121Assetht Income Asset details No NZA& 2
W 4 Deduct "1 T2121Assetlist#  Income Asset list No N/ 94
S UEO S roroicca Income Detais of CCA No N 93
W 5 Tar+crediv| | =3 12121 Compara... Income T2121 - Comparative summary No N/& 95
TiT21258 Income Business activities No  N/A 96
TP = . re—ar—— vy ™ o v
[T2125#:Business activities

Here’s how to complete form T2125
o Enter the business contact details and other required information under identification area, and record
the gross sales under Part 1 — Business Income



Identification

Name Hruzec, Sam Your social number 545 554 115
Business Name Account Number

SH Services (15 characf RT

Business address

Number _ Street, P.O. Box Apartment or suite

100 EMain st

City Province or territory _ Postal code

Anytown Hon Brire B

Fiscal Period Was 2016 your last year of business?  Yes | ] No

From:  Year/Month/Day Year/Month/Day
2016-01-01 to: 2016-12-31 ICalendarYear

Main product or service

Industry code (press F6) 541910

Marketing see the appendix in Guide T4002)
Tax shelter identification number Partnership Business Number Your percentage of
TS (9 digits) the partnership
100.0000 [ %
Name and address of person or firm preparing this form
603-900 Greebank Road
Ottawa, Ontario K2J4P6
How many Internet web pages and websites does your business earn income from? Enter "0" if none. 0 I
List below the site addresses (URL addresses) of your main web pages.
http:/
What percentage of your gross income is generated from the above web pages? 0.0000 I A
[T1139: Last year additional business income (T1139 line G) oloo §

— Part1-B income

Type of income Business Commission

2. |X] If you have business income, tick this box and complete this part. Do not complete parts 1 and 2 on the same form.

Income reported on T4 slips

Income reported on T4A slips

Fees for services (T4A box 28,

sales tax (HST) (if included in sales above)

Returns, allowances, and discounts (if included in sales above)

Gross sales, commissions, or fees (including GST/HST collected or collectible) 91.773jo0
oloo
ojoo
0[oo

91.773[00 g1

Minus Goods and senvices tax and provincial sales tax (GST and PST) or harmonized

oloo i
ojoo

e Record all business expenses in Part 5

0 I2
Subtotal (line 1 minus line 2 91.773 3

of the T2125

— Part 5 — Net income (loss) before
Gross business or professional income (from Part 3 line 20) or Gross profit (from Part 4 line 30)

Expenses (enter only the business part)

91.773J00 31

Advertising 1.447/00 [ 32
Meals and entertainment 0|00 I x 50%

Meals and entertainment (long haul truck drivers) 0loo W x 80% oloo J§33
Bad debts 0/00 @34
Insurance 0/00 @35
Interest 1.547]00 | 36

Business tax, fees, licences, dues, memberships, and subscriptions

00 W37

Office expenses

joo J§38

Supplies 00 |39
Legal. accounting. and other professional fees 4.800{00 @40
Management and administration fees 0[00 @41
Rent 000 @42
Maintenance and repairs 0[00 @43
Salaries, wages, and benefits (including employer's contributions) 0[00 @44
Property taxes 0[00 @45

Travel (including transportation fees. accommodations. and allowable part of meals

Telephone and utilities

00 §46
00 47

Fuel costs (except for motor vehicles)

00 @48

Delivery, freight, and express

00 |49

Motor vehicle expenses (not including CCA)

(see Chart A) - from worksheet 5.220]00

Motor vehicle expenses (not including CCA)

(see Chart A) - other oloo l

oo [ 50

Allowance on eligible capital property

00 | 51

Capital cost allowance (from Area A)

00 | 52

Convention fees

Private health services plan premiums
Resenves

Terminal loss

olololo|o

7ﬂl

o0

—%I
00

Other expenses =

o

oloo 53

2181900 | » 21.819|00 [ 54

9270
Total business expenses (add lines 32 to 53)
Net income (loss) before adjustments (line 31 minus line 54)

69.954/00

— Part 6 - Your net Income (loss)
Your share of net income (loss) before adjustments (from Part 5 line 55) or the amount from

Form T5013, Statement of Partnership Income 69.954

0o [ 56

GST/HST rebate for partners that was received in the year 0

00 57

Subtotal (line 56 plus line 57) 69.954)

ool » 69.954|00 [ 58

e Note, however, that you don’t record vehicle expenses on the T2125 itself, but on the Business Auto

ancillary form (see illustration below), and you indicate, at the top of the Business Auto form, where to

send the vehicle expenses

Here are other key points to consider with the Business Auto form
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¢ You must indicate the business kilometers and the total number of kilometers driven in the tax year.
ProFile uses these values to calculate the allowable vehicle expense

e Any vehicle loan or leasing costs are calculated in a separate area of the Business Auto form. See Chart
D, at the bottom of the window below, which is where the eligible leasing cost is calculated

Motor vehicle expenses (Business
Allocation of expenses Fiscal period Amount
Start End
Chart A - Motor vehicle expenses
Descri of Filmore
Enter the kilometers you drove in the tax year to earn business income 10.000 I 1
Enter the total kilometers you drove in the tax year 22,000 | 2
Taxable Non Eligible Total
GST HST
Fuel and oil oloo |§ 232200 | oloo 2.322l00 § 3
Interest (see Chart B) 0/00 00O W 4
1.433/00 1.433/00 @ 5
License and registration 149/00 14900 @ 6
Maintenance and repairs 0J00 956[00 I 0/o0 956/00 @ 7
Leasing (See Chart D) 0joo 6.624/00 | 0Jo0 6.624/00 @ 8
Other expenses (specify) 0/o0 0[o0 I 0/00 0joo @ 9
0[00 ojoo 0[00 0[00 @ 10
Total motor vehicle expenses 0]00 9.902]00 I 1.582(00 11.484|00 @ 11
Business use part: Multiply line 11 by 45.45 | % oloo i 450091 71909 J§ 5,220[00 ] 12
Business parking fees oloo i oloo J§ oloo J§ oloo J§ 13
Supplementary business insurance oloo J§ ofoo Jf 14
Allowable motor vehicle expenses oloo J§ 4.500[01 i 71909 J§ 5.220[00 J§ 15
Chart D - Eligible leasing costs for passenger vehicles
Date lease commenced 2016-01-01 .
Date lease terminates 2018-12-31 I
Total lease charges incurred in your 2016 fiscal period for the vehicle 6.624.00 I 1
Total lease payments deducted before your 2016 fiscal period for the vehicle 0.00 §2
Total number of days the vehicle was leased in your 2016 and previous fiscal periods 366 @3
Manufacturer's list price 23.199.00 g4
GST/HST 1300 | PsT 0.00 ]

35.294.00 ] + 4,588 22 ] (GSTHST/PST) 3088222 5
Enter the amount from line 4 or 5. whichever is more 39.882.22 I x 85% 33.899.89 I 6
Imputed interest on any refundable deposits in excess of $1.000 for 2016 and previous years 000 @7
Imputed interest on any refundable deposits in excess of $1,000 for 2016 0.00
Total reimbursements receivable for this lease in 2016 and previous years 0.00 I 9
Total reimbursements receivable for this lease in 2016 0.00 I 10
( 500 ] + 104 ) x 366 J= __ 330.864.00 ff=30= 11.028.80 [ minus lines 2,78 9 = 11.028.80 | 11
( 30000+ 30000 x 6624 = 22455360000 - 33,809 89 [ line 6 - lines 8 & 10 = 6.624.00 12
Eligible leasing cost (line 11 or 12, whichever is less) 6.624.00 13

One further step in recording Sam’s business expenses is to enter the allowable home office expense. As a self-
employed individual working from home, Sam can deduct a portion of her home expenses. This portion is
calculated by adding up all of Sam’s home expenses and multiplying it by a factor that represents the percentage
of the home’s area used to run her business.

e To record home expenses, scroll down to Part 8 at bottom of the T2125

e Enter the home’s total area and the area used for business

e Enter the operating costs for the home including heat, electricity, insurance, etc.

L]

ProFile will calculate the allowable home office expense and include as an eligible business expense on
the T2125

— Part8 - C. ion of busi f-h P
Area of home used for business (A) 150 .
Total area of home (B) 650 I
Heat 68900 63
Electricity 498|00 @64
Insurance 375/00 @65
Maintenance 0[oo I 66
Mortgage interest 6.300/00 I 67
Property taxes 0loo I 68
Other expenses (specify):
0[00 W69
Subtotal (add lines 63 to 69 7,862|00 @70
Your personal use portion of the business-use-of-home expenses 6.047(69 @71
Subtotal (line 70 minus line 71 1.814[31 72
Capital cost allowance (business part only), which means the amount from Part 11 line G minus any portion
of CCA that is for personal use or entered in Part 5 at line 52) 0loo I 73
Amount carried forward from previous year 0/00 W74
Subtotal (line 72 plus line 73 plus line 74 ) 1.814|31 @75
Net income (loss) after adjustments (amount from Part 6 line 60 — if negative, enter "0") 69.954/00 § 76
i use-of-hom il to carry forward (line 75 minus line 76—
if negative, enter "0") 0]00 I 7

Allowable claim (enter the lesser amount of line 75 and 76 — Enter this amount in Part 6 at line 61) 1.814[31 |§ 78




T1 Jacket
After entering all required information on the T2125, ProFile will calculate the gross and net business income and
transfer it to the T1 Jacket.

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside C|
When you come to a line on the return that applies to you, go to the line number in the guide for md
Employment income (box 14 of all T4 slips) 101 OIOO i
Commissions included on line 101 (box 42 of all T4 slips) 102 0|00 i
Wage loss replacement contributions
(see line 101 in the guide) 103 oloo §
Other income [104 oloo |§
0Id Age Security pension (box 18 of the T4A(OAS) slip) 0[o0 i
CPP or QPP benefits (box 20 of the TA(P) siip) 4 oloo
Disabiity benefts included on line 114
(box 16 of the T4A(P) sip) 152 oloo §
Other pensions and superannuation [115] oloo §
Elected spit-pension amount (attach Form T1032) 1 oloo |
Universal Child Care Benefit (UCCB) 1 0]00 i
UCCB amount designated to a dependant 185 ofoo |y
insurance and other benefits (box 14 of the T4E slip) 119 oloo §
Taxable amount of dividends (eligible and other than eligible) from taxable Canadian
corporations (attach Schedule 4) 120 0[oo
Taxable amount of dividends other than eligible dividends,
included on line 120, from taxable Canadian 180] oloo §
Interest and other investment income (attach Schedule 4) m‘ 0/o0
Net partnership income: limited or non-active partners only 122, 0/oo
Registered disabilty savings plan income 125! 0jo0
Rentalincome Gross [160] oloo § Net|126 0joo
Taxable capital gains (attach Schedule 3) 127 0/o0
Support payments received Total[156] oloo § Taxable amount |128 0loo
RRSP income (from all TARSP slips) [129] 0loo
Other income Specify: 130 000
Self-employment income
Business income Gross[162]  91.773/00 | net[135]  68.139]69 |j
Professional income Gross [164] oloo | Net [137] ofoo
Commission income Gross 166 oloo | Net[139] oloo
Farming income Gross[168 oloo | Net[121 oloo
Fishing income Gross[170] oloo | Net[143 ojoo |
Workers' compensation benefits (box 10 of the TS007 sip) [124] oloo j§
Social assistance payments 145) 0[00 i
Net federal supplements (box 21 of the T4A(OAS) slip) 146 0[00 i
Add ines 144, 145, and 146
(see line 250 in the guide). 0[00 J» 147 0[00 I
Add lines 101. 104 to 143. and 147 This is vour total income. m 68.139169 I

PART-YEAR RESIDENTS

In this section, we’ll briefly describe how to set up ProFile for newly-arrived residents.

Working on a part-year resident return
If someone is newly arrived in Canada, follow these steps to set up a T1 return.
e Complete the Info page as you normally would. So that ProFile can prepare the proper schedules,

. . 1
ensure that you select the correct province of residence [

e Report the date of entry into Canada =
e After reporting the date of entry, ProFile will open additional fields, including Line 5292 and 5293. In
these fields, report Canadian and foreign-sourced non-resident income. In this example, there is

$10,000 of foreign-sourced, non-resident income B
e Once you enter an amount on either Line 5292 or 5293, ProFile will tick the box to prorate non-

refundable tax credits =
e You may then complete the rest of the return as you normally would
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Title M 1[J Married 2[] Living common-law 3 [] Widowed
First name Renee

_— 4| | Divorced 5 || Separated Single

Last name Descartes - D - D = g

Last name changed in 20162 D Yes No If status changed in 2016, enter date of change mm-dd
Last name changed in c0To7 [ | Y il

Do you want to change your address? |_l Yes Were you married or living common-law at any

Care of time in this tax year? |—] Yes D No
Street address 112 Main St Apt # Residency

P.0. Box IRR

Cty  Anytown Province of residence

Gty Ayt on 2016/12/31 Ontario

Province ON

Province of self-employment

EvstalCoTalE MOA 150 ifyou became or ceased to be a Canadian resident in

Home phone  (905) 555-5555 2016, enter date of- entry 06-01
Birth date 1980-12-12 0 Age 36 or departure  mm-dd

Date of Death _yyyy-mm-dd
e Spouse's or common-law partner's net

Gender Male [ Female income while the taxpayer is living in
Province or territory where taxpayer resides if different from mailing Canada

address Spouse's or common-law partner's net

By providing an email address, | understand income while the taxpayer is living outside
| am registering for online mail and accept of Canada

the following Terms and Conditions. EI Yes |:| No Canadian sourced non-resident income

Email address 1 Foreign sourced non-resident income 5293
Use preparer address for Prorate non-refundable tax credits for part
Nothing D Notice of Assessment and Refund D Nof A vear resident?

[ 11 mailing address Are you a non-resident?

Residency status Resident

Country (other than Canada)
Did you dispose of a property (or properties) in 2016 for which you are
claiming a principal residence exemption? [] ]

Residency rules, for both Canadian citizens and non-Canadians, can be a complex affair. For more information,
consult CRA’s guides, such as T4058 Non-Residents and Income Tax, and T4055 Newcomers to Canada.



Chapter 5 Quiz

Question 1: The feature that allows you to prepare T1s for married couples and their dependants is called:

Hub and Link
Synchronization
ProFile Review
Family Linking

cawy

Correct answer is D

Question 2: True or False: ProFile will calculate the allowable RRSP deduction even if no deduction limit
indicated:

Correct answer is False

Question 3: Select the best way to create a dependant’s T1:

Go to the File menu and click New T/

Right-click a T1 Jacket and select New

Click the Synchronize icon

Right-click the dependant’s name on the Dependant form, and click Return for ...

cawpy

Correct answer is D

Question 4: True or False: If a dependant has excess tuition credits, ProFile will transfer the excess amount to a
parent’s linked return

Correct answer is True

Question S: True or False: ProFile has an option to toggle Family Linking on or off

Correct answer is True

Question 6: Which of following tax situations does ProFile’s Optimization verify?

Medical expenses
Charitable donations
Tuition credits

All the above

oawy

Correct answer is D
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Question 7: True or False: The T1032 form allows you to optimize and split pension income between spouses

Correct answer is True

Question 8: True or False: ProFile cannot prepare tax returns for self-employed individuals

Correct answer is False

Question 9: To prepare a T2125, ProFile requires the following. Choose the best answer:

ProFile cannot prepare a T2125 return

A statement of revenue and expenses (Income Statement or Profit & Loss)
A balance sheet

None of the above

oCawy»

Correct answer is B

Question 10: True or False: ProFile can prepare a T1 for part-year residents

Correct answer is True




Chapter 6: An Online World

CHAPTER 6 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e How to use CRA’s AutoFill My Return
e How to ReFilea Tl
e How to communicate with clients with ProFile’s Hub and Link

Every day, more and more businesses are taking things online. Online stores; online information; online
payments; online communication—all are part of our everyday lives. It should come as no surprise, then, that tax
preparers too are increasingly using cloud tools. Canada Revenue Agency, for example, demands that tax
preparers EFILE tax returns and, at the same time, with a dedicated Represent a Client account, CRA gives tax
preparers online access to an array of client information that was unthinkable just a few short years ago. ProFile is
accentuating this cloud trend as well. As a ProFile user, you have access to an increasing number of cloud tools.
Let’s take a closer look:

GETTING ONLINE

The online toolbar
The Online toolbar sits permanently under ProFile’s Menu bar. Here’s what the four icons in that toolbar do:

e  Click the Live Chat icon...

... To engage a ProFile support agent and chat online

B & @ Pprofile Chat Support X |+ v = o X|
P

S > © & @ accountantsintuit.com/su e c il * ¥ 7 e -

Live Chat - ProFile

Ask a live Support agent your product related
questions and get them answered now by clicking the
button belo

Click the Notification Centre...

=2) O

... To view alerts, reminders and other ProFile messages
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ProFile Notification Centre Clear Al

v 5100 notes - Known issue in ProFile 2017.1.0

Learn More

e Click the Online Settings to access ProFile’s online tools...

=4 )0

e ...Including features for online access and backup of your tax files

)

Online Settings
Online Account

You are signed in as: Imims—" -
ADMIN of Company: DilLauro CPA_CMA

*All files will sync to this user's o account.

Switch User ' Launch ProFile R Sign Out

Online Backup
(® Enable Online Backup

Each time you save a file. a backup copy of that file will upload to your

Crofile Heview account.
O Disable Online Backup

Cloud Bridge
(@® Enable Cloud Bridge

Automatically sync ProFile T1 data to your Pro
easy on-the-go access.

Select Folder: \WMac\Home\Documents\My ProFile Data\
Change Folde

W account for

O Disable Cloud Bridge

OK Cancel

e  C(Click the Review icon...

=4 (0

e ... To access and download your backups...

L= ProFile Review X v -
= il ar o X
& O @ a8 intuit.ca a3 Pe v I -
INTuIt Prol v (Peeavack 5} Michael A Di La ®
ud

Backup
am R
& Bacwp All Tax Years v Al file types v
EP FILE NAME « CREATED ON s DOWNLOAD DELETE

St Laurent, Marianne. 17T 12/16/2017, 02:38 PM i ]




e ...And also to view your tax files online

B & @ ProFile Review X 4+ v - [u] X

& O a@ & intuit.ca Q * % L
INTUIT ProFile Review Preedvack % Michael A Di La ®

R

28 ciientList

Return Status

ToTAL UNKNOWN ~ CARRIED WORKIN WATING ™ INPARTNER  READYTO PRINTED COMPLETED  NOTFILING
FORWARD PROGRESS ~ FORCLENT  PREPARER  REVIEW PRINT

2 0 2 0 0 0 0 0 0 0

Tax Year 2017 v My Clients v 9)
LAST FIRST LATEST TAX CLIENTCHECKLIST _ CLIENTREVIEW _ RETURN
] s ¢ CONTACT s s s +
NAME NAME YEAR @ @~ staTUS
O  Cosan Jane = &9 217 Send Share Carried Forward
©2014 Intuit. Al rights reserved Privacy | Legal | Terms of Service

Accessing your online account

If you have a ProFile account, getting online is quick and easy:

e From the toolbar, click the Online Settings icon and ProFile launches the sign-in window
e Click Sign In

e Enter your user ID and password =

e Select your firm (or add a new one) (=)

e Click Finish and you’re done a

InfuIt Profile
[online Settings X

Select your business

Online Account
You are not signed in  Sign Please select the business this license of ProFile
should be connected to.

To use Online Backup and Cloud Bridge. sign in with your ProFile Review
e o n

Each time you save a file, a backup copy of that file will upload to your
account

Automatically sync ProFile T1 data to your iew account for
easy on-the-g

Select Folder: \Mac

Add New Business

me\Documents\My ProFile Data\

OK Cancel
Connect Business

v Signin 5 ProFile Online Backup - Login ? X

Sign in

Success! You're All Set.
Email or user ID

You are signed in as

Manage Your Online Settings Launch ProFile Review
Password E I

You can access online features by clicking on the
l &0 icon in the top ber.

TIP: Try it out - you can always change it later in setings
¥ Remember me Fre aining

| forgot my user ID or password

New to Intuit? Create an account




But I don’t have an online account
If you don’t have an online account, creating one is a snap:
e From the toolbar, click the Online Settings icon to launch the sign-in window

e Click Sign In

e Click Create an account =

e Enter your email and company name. [

e You will also need your order or service number from when you bought ProFile =

e Follow the prompts, per steps 2 through 4 in the previous example, to complete the process

See the images further below for details on order or services numbers

[Online Settings p%
Online Account
You are not signed in  Sign In -
To use Online Backup and Cloud Bridge. sign in with your Profile Revie

username and password

vi

Each time you save a file, a backup copy of thatfile will upload to your INTUIT ProFile
FroFile Review account.

v Signin Create your company
d

5:, S|g n |n Already have an account? Sign In

| Email

sam@samuelson.ca

Email or user ID Company Name

michaeld@dilauro.ca A1 Tax Preparers

Password | Order/Service Number*

Where can I find this?

+ Remember me
Create company
a Signin

I forgot my user | Ssu
New to Intdt? Create an account

Order/Service Number
Read on if you’re not sure where to find the Order/Service Number required for the window above.

e  After purchasing ProFile, you will receive an emailed receipt containing the product information to be
entered in this window
If you purchased ProFile through Intuit’s Web Store, you will find the codes at the very bottom of the receipt.

ProFile Québec Tax Suite License (1-4) 1 $325.00 $325.00

Required to activate your product(s):
Product Code: 496-998

License Key: 5612016834-

Sub-total: $2,355.00




If you placed your order by telephone, the codes will appear in the Order Details section

ORDER

Quantity ItemId

DETAILS

Unit Price  Ext Price

1

1

423452 $1,680.00 $1,680.00

FR PROFILE TY14 QUEBEC SUITE

423522 $325.00 $325.00

FR ProFile TY14 Quebec Suite License (1-4)

Required to activate your product:
Product Code:496-998 License Key:9059-8678-95 2 i}

AUTO-FILL MY RETURN

AutoFill My Return (AFR) is a secure Canada Revenue Agency (CRA) service that allows individuals and

authorized representatives to automatically fill-in parts of a T1 return with information that the CRA has available
at the time of filing the return. Many authorized representatives are already accessing CRA’s online services to
gather client information. AFR is the logical next step. By filling in key tax data, CRA’s AFR simplifies the tax
preparation process.

To use the AFR service, a tax preparer must:

Register and be an approved electronic filer

Register in CRA’s Represent a Client and have a RepID, GroupID or business number (BN)
Have a valid Form T1013 Authorization Form (described in Chapter 3) for each client

1t is important to note that AFR service is not mandatory for EFILE certified software products. Some products
include the service in their product, but others may not. ProFile falls in the former category and has full AFR
functionality.

Summary of Tax Information that CRA delivers with AFMR

Information Slips

T3, Statement of Trust Income Allocations
and Designations

T4, Statement of Remuneration Paid

T4A, Statement of Pension, Retirement,
Annuity, and Other Income

T4A(OAS), Statement of Old Age Security
T4A(P), Statement of Canada Pension Plan
Benefits

T4E, Statement of Employment Insurance
and Other Benefits

T4RIF, Statement of Income from a
Registered Retirement Income Fund

TS5, Statement of Investment Income
T5007, Statement of Benefits

T5008, Statement of Securities
Transactions

RC62, Universal Child Care Benefit
Statement

RC210, Working Income Tax Benefit
Advance Payments Statement
Registered Retirement Savings Plan
contribution receipt

T1204, Government Service Contract
Payments

RENT ASSIST
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T4RSP, Statement of Registered Retirement
Savings Plan Income

Other Tax-Related Information

RRSP contribution limit

Lifelong Learning Plan repayment amount
Capital gains and losses

Federal tuition, education, and textbook
carryover amounts

Client Data Enquiry (CDE)

Home Buyers' Plan

Social assistance or workers' compensation
benefits

Working income tax benefit advance
payments (RC210)

Reassessment information

New balance owing message for prior
claim(s) on a refund

Current tax year return

Insolvency, consumer proposal indicator
Recent page access

Provincial tuition, education, and textbook
carryforward

Unfiled returns

External refund set-off amounts
Reassessment in progress

CPP payments (T4A(P))

Working income tax benefit

Emigration Date

Direct deposit indicators

AFR Download
Before you file a tax return with the CRA using the information delivered by Auto-fill My Return, you must make
sure that all the proper fields on the return are filled in and that the information provided is true and accurate.

If you notice a mistake on an information slip, contact the employer, payer, or administrator responsible for
preparing that slip.
If you notice a mistake in the tax-related information, have an account-specific question about other tax-related
information, or need additional information, call the individual income tax and trust enquiries line at 1-800-959-

8281.

Home Buyers’ Plan repayment amount
Non-capital losses

Capital gains deductions

Provincial tuition, education, and
textbook carryover amounts

Lifelong Learning Plan

Employment insurance and other benefits
(T4E)
Universal child care benefit (RC62)

Balance owing
No debt owing indicators

Bankruptcy

Other existing outstanding balances
Federal tuition, education, and textbook
carryforward

Disability tax credit eligibility

Review

Internal refund set-off notification
T4A income

Outstanding GST/HST returns
Immigration Date

EFILE ineligibility indicators



Using AutoFill My Return

4 PROFILE - [2016 T1/TP1: Cosan, Jane - Personal information]
Vi File| Edit Audit Goto Form Options EFILE Online Traini

New >

Carry Forward... CtrisR
DT Max Carry Forward...

Open... Ctri+0
Reopen >
Save Ctrl+S
Save As...

Close Ctrl+W

o With a client file open in ProFile, click File>Import CRA Data

Close family Cti+Q
Properties... Ctriel
Print... Ctrl+P
Print / Email PDF... Ctrl+Al=P
Print Slips

Quick Print

Print Setup...

Print Slips Setup...
Setup Mailing Labels..
HyperDocs..

Delete...

Couple.

Uncouple...

@ vmoozooooooi-i-m-e e

Link a Corporation

Review Linked Corporations.

OnePay Upgrade
QBOA Import.

Import

Import CRA data

Import RQ data
QuickBooks Desktop Import.

>mim Bl ——c m

Eit

First time filer in 20167

o Click Launch CRA Website

@ CRAData Import X

ProFile CRA Data Import

*  Save time by automatically importing client information

* Prevent manual data entry errors === e
« Ensure client data is always accurate and up-to-date o . |"— —

* Learn more on intuit.ca

e
QL launch CRAWebsite L) Cancel |

e ProFile will open a browser and take you to CRA’s website
e Click CRA Login

e Enter your credentials =

e Confirm CRA’s request then click Next (=)

e (Close the window to return to ProFile @
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Individuals and families | Businesses | Charities and giving | Representatives.

Home = E-services = Auto-fill my return and Express NOA

Auto-fill my return and Express NOA

Frangais
The CRA's Auto-fillmy return flows individuals and authorized ta

filin parts of a
2016 and 2015 income tax and benefit return. The Express NOA service allows eligible individuals and authorized
representatives to find out the status of a return immediately after it has been filed and to receive a notice of
assessment the next day in the cerified tax preparation software.

Canada Revenue Agency

Choose from one of two ways to access Auto-fil my return and Express NOA:

Continue to Sign-In Partner

+ Use the same sign in information you use for other oniine services (for
example, oniine banking).

+ None of your information will be shared with CRA. Your Sign-In Partner will
ot know which government service you are using.

+ You will temporarily leave the CRA website to use your Sign-In Partner.

Auto-fill my return—request confirmation

You are requesting 2016 tax information for the following SIN(s):

Note: If you are requesting tax information for more than 10 SINs you will have to make a separate request

+ Log in with yof
+ Forgot your p

« Entering your| o001
Canada Revenue Agency . Date modified: 2017-02-13

" Successfully connected

Next [NEYY

CRA Login
“User ID: (required) We've connected to CRA My Accountand are ready to import data,
Forgot your user ID? Return to your tax product to continue.
Password: (equired)

our CRA My Account

Forgot your password?

You can now close this window.
For more inormation on how your privacy s prolecied, efe to our Personal Information Colection Stalemen,

ea e

L3
Rogistr ifyou aro a now user.
o revoke or change vour CRA user ID or password, o to manage you security quesiions and answers, you must st login,

cms30

e Profile displays the Data Import Worksheet where you can accept or deselect the information to import
into the tax file [

e  Click Import Selected Data =
e Close the window that confirms the import is complete [

e ProFile will list the imported information on the Data Import Summary form =
e You have successfully used CRA’s Autofill My Return

[@ cra Data impont

Data Import Worksheet

Review the imported data below

) Check/UnCheck All

nd Al Collapse Al

T4 Statement [@ Dt imeort

T — . ° ° °
1 CITY OF OTTAWA n Add As New!

biersl Tuition, Education and Textbook - Carryover amounts Data Import Completed

se review the updated status list

cRA P

¥ Federal Tuition. Education and Textbook - : Add As New|

SIN
Provincial Tuition, Education and Textbook - Carryover amounts
2 Import Selected Data
Data Import Summ
Data Imported on Apr 16 2017 07:59:36 PM
Here is the overview of all imported slips and CDE data from the CRA / Revenu Québec.
Vou can e aach kst ohp by cichng on the dtal ok
Imported Slips
Box Amount Details Ch
[Federal Tuition. Education. and Textbook Amounts 1 5,025 00 Details|

Client Data Enquiry

[Working Income Tax Beneh Indicator Tves ]
[Fo Debtingcator Tves |
[Balance Owing Amount oo |

Unfiled Retum ]
[2008 |
[2007 |
[2006 ]




ALL ABOUT REFILE

If you are an EFILE service provider, you can use ReFILE to make changes to T1 that was previously filed with
CRA. These online adjustments only apply for the 2015 and 2016 tax years.

Who can use ReFILE?
Preparers can use the ReFILE service if the following conditions apply:
e  You have ProFile version 2016.4.3 or later (for tax year 2015 and 2016 ReFILE)
You have T1013 level 2 authorization from your client
The initial return was filed online (EFILE)
The initial return was assessed
You have acquired a new sign-off on a revised T183 from client

What does the ReFILE service exclude?
In addition to CRA’s standard EFILE and Change My Return exclusions, you cannot use the ReFILE service if
the taxpayer is:

e Subject to provincial or territorial income tax in more than one jurisdiction

e Waiting for either an initial Notice of Assessment or a Reassessment

Amending an election or wants to make an election (for example, Form T2057, Election on disposition
of property by a taxpayer to a taxable Canadian corporation)

Applying for child and family benefits

Allocating the refund, if applicable, to other CRA accounts

Applying for the disability tax credit

In the position of having been arbitrarily filed by CRA

In addition, you cannot use ReFILE to change page 1 of the taxpayer's T1 Income Tax and Benefit Return.
Instead, individual taxpayers should use My Account to make changes to the following information:
marital status

address

direct deposit

email address

Service limitations
e The online system accepts only nine adjustments per tax year for each taxpayer, whether the taxpayer
or you or CRA initiates the adjustments
e Ifyou go over the limit, you will get an automated response saying the limit has been reached and
explaining how to send a paper request
e Make additional requests on paper, preferably using Form T1-ADJ, T1 Adjustment Request, and mail
them to the CRA

If you have any questions or concerns about the ReFILE service, contact CRA’s EFILE Helpdesk at

Winnipeg Tax Centre
66 Stapon Road
Winnipeg MB R3C 3M2
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Local and long distance calls:
1-800-461-1806
Fax: 204-984-5302

Sudbury Tax Centre
1050 Notre-Dame Avenue
Sudbury ON P3A 5C1
Local calls: 705-670-6499
Long distance calls: 1-800-361-6283
Fax: 705-670-6500 or 1-855-338-5495

Jonquiére Tax Centre
2251 René-Lévesque Blvd
Jonquiere QC G7S 5J2
Local and long distance calls:
1-855-699-4640
Fax: 418-699-0203 or 1-800-497-5806

Using ReFILE

Before attempting to ReFILE a return, verify that you have a valid T1013 form—with level 2 authorization—on

file with CRA. If CRA already has the authorization information on file another filing of the T1013 is not
required.

To ReFILE a return
e Open a T1 return that has already been EFILED and for which a CRA Notice of Assessment has been

received.
e Save the return as a new file, using the Save 4s... option from the File drop-down menu in the top
toolbar
il Save 2016 T1/TP1 As ? X

1.Cosan, Jane 2 Cosan, Javier 3.Cosan, Maria

Cosan, Maria (555555556)

Client Status: | 8. Completed v [OLlocked
EFILE Status: | 2. Eligible

SEND Status: | 2. Eligible

TP1 Status: 1. Not eligible

<< |L< <

T1135 Status: | 1. Not eligible
DCN ‘4123414123412412341

Invoice [ Time: [00.00.00
[Discounted?  [JCRAEtrors D2139

Preparer. |MDL Parter. |

File

—
Documents\My ProFile Data\2016 T1\Cosan, Maria REFILE.16T
Onling’

Activate Online Backup

Concel

Help Advanced >>

e In the tax file, enter the new information that mandates a ReFILE. If, for example, a client has received
an unexpected T4, then enter that new information on ProFile’s 74 Slip



e After making the necessary changes to the tax file, press /4 to open Form Explorer and, in the Search

field, enter T/IReFILE

e Ensure the client information (SIN and Name) is correct in their respective fields

e Enter the current date in the Date of ReFILE field Bl

e Select the Yes option in the “Is this an amended tax return?” field: =

Note: failing to select the “yes” option will produce an error when attempting to ReFILE.

e Answer the subsequent questions in the form =

Note: these questions are not mandatory and preparers are not required to provide answers. Any notices related

to these questions may be ignored.

T1 ReFILE Request

* Use this worksheet to amend your 2016 personal tax return

* ReFILE transmission requests cannot be used to change the following fields
- Address
- Name
- Social insurance number
- Date of birth
- Marital status
- Residency
- Elections Canada
- Alternate address
- Email address
- Information about spouse or common-law partner
- Direct deposit

Changes to these fields must be made by the taxpayer through the CRA "My Account” portal.
* The amended return must include the full return and all the schedules, not only the revised amounts.

* All schedules included in the return are as This means data from amended schedules will overlay the
previous data.

* To amend a T1 return, make sure you completed all the information on the tax return and answer the following questions:

SIN 555 555 556 i
Name Cosan, Maria B

Date of ReFILE  2017-11-17

Is this an amended tax retum? E§ Y

If you are changing any of the fields mentioned below, please select what is the reason of change. n

Field 245 - Why are you changing your RRSP contributions? (Please check all that apply)

a. You received an RRSP slip for contributions made in the first 60 days of the year following the tax year.

b. You received an RRSP contribution slip after filing your return

c.  You received an amended RRSP contribution slip.

d. The CRA published information (web pages, tax manuals, letters etc.) is not clear on how to report RRSP
contributions

I

Before completing the submission, you must update the T183 Form (as described in Chapter 4).
e Open the T183 used for the initial EFILE of the return:
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Canada Revenue Agence du revenu Information Return for Electronic Filing of
(577 EaCKRGY an Individual's Income Tax and Benefit Return

The information found on this form coresponds to the tax year indicated on the right.
Before you fill out this form, read the information and instructions on page 2.

The individual (or legal representative) identified in Part A must sign Part F. Part G s to be filled out by your electronic filer once the return.
Give the signed original of this form to your electronic filer and keep & copy for yoursel.

Part A - Identification and address as shown on your return
First name Last name Social insurance number

Maria Cosan 555 555 556
Waiing address: Apt no — Street no Street name POBox JRR City Prov/Terr | Postal code
12 Main St Anytown ON M4A 1A2

Part B - Declaration of amounts from your General Income Tax and Benefit Return (mandator
Enter the folowing amounts from your return, if applicable:

Total income (line 150) 11,921/00
Taxable income (ine 260) 11,921]00 | Refund (line 484) 1.215|04 i

or

Total federal non-refundable tax credits (ine 350 of Schedule 1) 1.991|39 [j] Baiance owing (ine 485) 0/00

» Want to go paperless? Give CRA your email address and your CRA mail will be delivered electronically in My
Account

Email Address (optional): |

lunderstand that by providing an email address, | am registering for onine mai and | accept the terms and conditions. For more information, refer to page 2.
To access online mail you must be registered for My Account.

) Want instant CRA assessment results and your Notice of Assessment faster? Tick this box: ll

1 understand that by ticking (x) the box above, | am allowing the CRA provide my
electronic filer (including @ discounter) named in Part E. For more information, refer to page 2.

'd my notice of assessment and reassessment to the

) Want to Pre-authorize CRA to withdraw a specified amount from your bank account? Fill in the info below:

| hereby authorize the reate th ! debit on my behalf. | authorize the CRA to funds from my bank t
s per the agreement details listed below. | adnowledge that | have read and understood the information about pre-authorized debit on page 2 of this form.
2017-10-08 I

Signature Year Month Day

e s -l | R e e

Branch No. Financial Institution No. ok account number
oRe e yo box: K
ur - e box above, | authorize the electronic filer i my amended T1 retumn.
Part D - Authorizing an el
No

e Tick the checkbox that asks Want to ReFILE like you EFILE? Note that this checkbox displays only
for tax year 2016 and later [l

e A letter “R” now displays in the Tax Year field indicating the form was referenced for the ReFILE =
This new designation is permanent and cannot be rescinded from the form

e Acquire a new sign-off from the client on the updated T183 form prior to your ReFILE attempt

e After the client signs the updated T183, click EFILE/ReFILE this return...

LU

R eetmerns.

Build T1 EFILE Online Batch...
EFILE Online Batch

Build TP1 NetFile...

TP1 Connect...

w1

Reports >
Print All ACKs

View Notice of Assessment (ENOA)

Set EFILE Password

AT

= {
M‘M)

e After the ReFILE process is successfully completed, ProFile will display a confirmation window

v 1l EFILE Session e

EFILE session starting on Tuesday Much 21,2017 at 1:07 PM
C\U: Ay ProFile Date\EFILEV201 671 NN T A<
C\Users\sNanl\anments\My ProFile Data\EFILEV2016T 1 N RESPTAX downloaded

The Canada Revenue Agency received the 2016 ReFILI

bmission fo
ol m will ot be

on on the EF e rther detail

P
nd documents for si se keep this cont

poy e
information sh firmation numb er ond EH U for

your records:

|EFILE session done.




Confirming the ReFILE submission

ProFile enters the ReFILE confirmation number on the /nfo form to the return. It matches the number displayed in
the ReFILE confirmation message.

@ 1.Info |ﬁj 2T | a3T4 \ (& 4.T2202/TL11 | 57 5. TIReFILE | 57 6.T183 |  +

IS reTUr Compietea unaer tne LKAS wientaily or pnysicaiy innrm¢

volunteer program? [—| Yes No Indian within the meaning of the Indian Act?
Were you confined to a prison or similar institution Is this an Early Filed or Elective deceased
for a period of 90 days or more during the year? return?

(Schedule 6. ON479 & GST / HST Credit) 0 Yes

xes
Yes

[ yes

A NO

No
Ono

v e

Subsection 104(13.4) election to have certain

No
If your province or territory of residence changed
in 2016, enter the date of your move yyyy-mm-dd
Is the home address the same as the

income taxed on the T1 return of the deceased
beneficiary, rather than on a T3 retumn
Language of correspondence English

Signingdate  2017-10-08
mailing address ? 0 Yes igning date

B ——

Ono

1 EFILE/ReFILE confirmation number: _ | - > ) |
™ _

T1135 EFILE confirmation number: [ |
T1013 EFILE confirmation number: [ | '
T1PAD confirmation number: I |

e You can also confirm the history of the submission by selecting Properties option under the File menu

Review the history of the return; the ReFILE displays as an “EFILE” with the date of the ReFILE
displayed in the “Date” field

Discounted? CRAErors 2139

Date

16112310
16711728 11
16711728 11
17/03/21 14
17/03/21 14
17/03/21 14

Freparer
SD
SD
SD

Action
Modified

T1 EFILE Ready to Transmit <f::
Modified
<

Elepsed

T1 EFILE Ready to Transmit
T1 EFILE Accepted
Modified

SD
SD

CLIENT COMMUNICATION

Gathering and disseminating client information used to be straightforward. When paper was the only option,

clients would stop by the tax preparer’s office to drop off their documents, and come back later to pick up their
completed tax returns.

Now, thanks to online tools, clients rarely visit their tax preparer’s office, oftentimes preferring to email their
documents. Email, though, comes with two inherent risks—privacy and efficiency. The fact is that regular email
is a bad idea for sending private and sensitive data. In addition, controlling the influx of emailed attachments,

especially during a very busy tax season, can lead to lost or misplaced documents, and erroneous or incomplete
tax returns.

What tax preparers need, then, is a safe and efficient method for sending information to and requesting documents
from their clients. And now, with Hub and Link, ProFile has that very thing built in.

Introducing Hub & Link

Hub is a document-management dashboard that helps you access customer information quickly and seamlessly.
Hub works effortlessly with Link, a user-friendly online portal that lets you collaborate more effectively with your
clients to gather their information. Together, Intuit Hub & Link will streamline document management in ProFile.
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Link makes data collection a breeze. As described in the paragraphs below, Link lets you simplify client data
collection, invite clients to collaborate, create customized client requests and track the status of all your requests.

Once logged-in, you are ready to use Hub and Link, ProFile’s latest online tools that make client communication
a breeze.

Using Hub

Hub is a dashboard within ProFile that gives you a bird’s eye view of your client documents and information.
You can access client contact information, check the status of a return and review any notes that may have been
added.

Within Hub you have access to document management sources, such as Link, to help you gather information from
your clients in one secure place.

And now, CRA’s Auto-fill my return is available through Hub.

To launch Hub:

e Click Go to and select Hub
e Click the Gear icon and choose Set Up

ProFile Hub

O CcuNT NAME FILE NAME INTUIT LINK CRAIMPORT COMMENTS

Tota it O Selected Chentsh 0 ProFe Hub Seice: Avsable

e Confirm whether your files are on a local drive or network server [
e Indicate the file location (=)

e  Click the Enable ProFile Hub checkbox =

e Click Read Files and ProFile will then index your tax files [

© Profile Hub Set Up X

ProFile Hub Set Up

To use ProFile HUB you will need to link to your clients’ files. During setup ProFile HUB will ready your files, so you may invite
and collaborate with your clients.

a ) Enable ProFile Hub

How are your ProFile client files stored?

- @) Local Server - only you can access

(O Network Server - shared server on the network

Where are your client files stored?

u User\Documents\My ProFile Data\2016 T1 Browse
Note: only T1/TP1 files from Tax Years 2015, 2016, and 2017 are compatible with Hub and
Link. Read files u




The Hub window, below, provides at-a-glance information for all your client tax files, including:
e A dropdown window to filter tax years
e Client name column with phone numbers readily displayed B
e Clickable file-name column for opening tax files =
e Intuit Link column (discussed later) [
e CRA Import column that displays the date of the import or the ability to import from CRA =
e A comments column for recording notes [l
e Status column
e Date the tax file was last saved [l

© ProFile Hub - o X
ProFile Hub
‘ Action | 2016 | S 2 client or a f ‘ @
Al years
[0 CLIENT NAME (2017 FILE NAME INTUIT LINK CRA IMPORT COMMENTS STATUS LAST SAVED
2016
O & 2015 @ % Invite Apr-19-2017 ©  Add Note Completed v Oct05,2017
Cosan, Jane
O & % Invite Run CRA Import Add Note Work In Progress v Oct 04,2017
Cosan, Maria
(m] ite Run CRA Import Add Note WAl Work In Progress Oct 04, 2017
Cosan, Jane Cosan, Javie
a & G invit Ru Add Note Work In Progress v Oct 04,2017
. Shrieve, Michael
O & B Invite Run CRA Import Add Note Work In Progress v Oct02,2017
Shrieve, Ralf
O @ shrieve, Ralt16T % Invite Run CRA Import Add Note Work In Progress v Oct02,2017
Taxpayer, Am)
O é& pay Y % Invite Run CRA Import Add Note Carried Forward v Oct01,2017
Total Client(s): 42 | Selected Client(s): 0 Profile Hub Senvice: Available

Using Link
Link is ProFile’s online portal that opens a communication channel to your clients. With Link, you can

personalize and electronically send client documentation such as questionnaires and checklists. With Link, your
clients can also send you their tax data in a timely and organized way. And with Link, you can personalize—with

your own logos—the documents you send to your clients.

Inviting your clients
For all this to work, it’s important to enter, on the Personal Information page, a valid email addresses for your
clients.

. 2016 Personal information |
£

Taxpayer personal information

s 444 444 442 your marital status on December 31, 2016
Title Ms artied 2 [ Living common-aw 3 [] Widowed
Firstname ___Jane

4[] oivorced 5[] Separated 6] single
Lastname __Cosan <0 5[ ser §0sng A
Last name changedin 20162 [Yes [X]No If tatus changed in 2016. enter date of change mm-dd
Do you want to change your address? [Wyes XMno | Were you maried or living common-law at any J
Care of time in this tax year? [OyYes [Ono
Street address _ 12 Main St Apt# T
£ (O Box Arviomn BRR Province of residence
)—‘Y—ONV‘ on 2016/12/31 Ontario
;‘""‘I” B A 12 Province of self-employment

ostal code ifyou became or ceased to be a Canadian resident in
Home phone _ (905) 555-1212 2016, enter date of entry mm-dd
Birth date 1971-04-30 BAge 45 R ... o0
Date of Death _yyyy-mm-dd
Gender O male [] Eemale
Province or territory where taxpayer resides if different from mailing | Are you a non-resident? Oyes Kuo
address Residency status Resident
By providing an email address, | understand S haribiCaa
R S Country (other than Canada)
Yes [JNo

claiming a principal residence exemption? Yes [X]No

"
oWing Terms and Conditiont []
{Email address:  jane@cosan ca

b
[X] Nothing L] Notice of Assessment and Refund [ ] N of A

L1 majing address ~ MKW‘W*J

Did you dispose of a property (or properties) in 2016 for which you ars}
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To launch Link:
e From Hub, click Invite, next to the desired client
e Confirm the email address, and click OK

[~
ProFile Hub

I Action v | IAllyears | Search a client or a file 0 | 33
[J CLIENT NAME FILE NAME INTUIT LINK CRA IMPORT
., Cosan, Jane Cosan, Javier
o) ! Cosan, Jane and
O & N @ G e S
(¢!
() E: Run CRA Import
5 Linkinvite will be sent to Cosan, Jane at the email address:
O & | = - Run CRA Import
S .
O L Invite Run CRA Import
., Taxpayer, Amy TaxPayer, Gavin T A .
O & @B . Tapaver 2 Invite Run CRA Import
Total Client(s): 42 | Selected Client(s): 0 ProFile Hub Service: Available
Click Get Started in the splash screen that opens
Welcome to Intuit Link X

Take Charge of Your Tax Season with Intuit Link

Extra Cost

O © ()

Manage Client Documents Track Document Collection Get a Virtual Assistant
Collect and organize multiple client Know when to have all the docs Set-up automated reminders so
documents all in one place you need to get started you can stop chasing clients

[J Do not show this again Learn Morg Get Started

S

From the window below, you can choose to:
o Edit the invitation email that your client will see

e View, edit or select to send ProFile’s default Engagement Letter, Questionnaire and Checklist (=)



Invite Clients To Use Link X

To: Jane Cosan

Customize your invitation email below:
Dear [CLIENTNAME],

>At [FIRMNAME], we know gathering tax info can be a pain. To make things easier, we're using Intuit
Link to build a custom checklist for you

- We'll guide you through some questions, the documents needed, and let you know when you're done
- It's much more secure than sending by email so your personal information is safe! 1
- Use your phone to snap photos of your documents much faster than using a scanner

Please sign up and get started

Regards,
[FIRMNAME]

Engagement Letter Questionnaire Checklist (6)
Edit Edit Edit

[J Do notinclude [J Do notinclude [J Do notinclude

To modify the default questionnaire template, in the window above, click Edit:
e Click Add New Question to insert a question in a new row
e Click 4dd to create your own document (=)

e Click Done to return to the invitation window (=)
e Then, from the invitation window (above), click Invite to send the selected documents to your client

Edit Questionnaire X
QUESTIONS TYPE ACTION
What is your current address? Open-Ended ~ @
Were there any changes in dependents? Yes or No 4 i
Did your marital status change before the end of last year? Yes or No - i
Canadian citizen? Yes or No - ]
Please list any questions or other concerns you might have Open-Ended ~ ]
Marital statusf? Open-Ended ~ i
Do you want to electronically file your tax return? Yes or No i i

Meanwhile back at Hub
A return visit to Hub reveals an Invite Pending status for that client, thereby keeping you up to date with all your
client requests.

123



© Profile Hub - [u] X

ProFile Hub

| Action I lAHyears | | Search a client or a file o | {§3

[J CLIENT NAME FILE NAME INTUIT LINK CRA IMPORT
_ Cosan, Jane

O & @ J(:ii-‘vcl(;:‘epa;d . Run CRA Import

g Cosan Mara [+ Jo Y Invite Run CRA Import

Total Client(s): 42 | Selected Client(s): 0 ProFile Hub Service: Available

What your client sees
Here is the email your client receives.
e Your client launches Link by clicking on Accept.

Msws OF8_OWA connect@e.connectintuit.com> 5:18 PM (0 minutes ago) [N
tome =

- e S @
no-reply@intuit.com
Important Tax Information
Dear Jane Cosan,
At we know gathering tax info can be a pain. To make things easier, we're using Intuit Link to build a custom checklist for you.
- We'll guide you through some questions, the documents needed, and let you know when you're done.
- It's much more secure than sending by email so your personal information is safe!
- Use your phone to snap photos of your documents much faster than using a scanner.
Please sign up and get started.
Reqards,
pE—
( Accept )
I you have already taken action and logged into Link, piease disregard.

infuit Link

Intuit respects your privacy. Privacy Statement
I your receive a suspicious email, please Report it
©2017 Intuit Inc. Al rights reserved. Trademarks.

After your client clicks Accept in the window above:

e Link opens a Sign up page where your client clicks on Continue
e Ifyour client has an Intuit account (QuickBooks or Mint, for example), she can use that account’s ID

and password [l
e Ifyour client has no Intuit account, she can set one up by clicking Create Account [

e You client then clicks Get Started B



Sign up

accountant.

INTWIT Link

Continue to create your Intuit Link account using the email address provided by your

[ —

Continue .

Or contact your accountant to use a different

Need help? Visit Support

By clicking *Continue”, | agree to Intuit's Terms of Service, and|

Link connects your tax ¢
accountant, simp

Sign in
Your Intuit Link sign-in is the same as what you've used with other Intuit products, such

as QuickBooks, Mint, and Quicken

Email or user ID

- —

Password

¥ Remember me

No thanks

Welcome to Link, Jane Cosan!

would like you to share your tax data.

Let's Get Started

You client now only needs to scroll through the documents and answer the questions that you sent.

e For example, you
e And then accept i

To Do

View questions

Engagement Letter:

Letter of We the

Documents  Profile Tax Year 2016 Log out

I forgot my user ID or password 3
New to Intuit? Create an account.

r client can view your Engagement Letter
t with just a click

n list

®, | Aska question or send a message about t

m [———

to work with you and advise you on i...

s request ®

Documents  Profile Tax Year2016 v Log out

Lotter of Engagement

We appreciate the opportunity to work with you and advise you on income tax matters. Canada Revenue Agency (CRA) impose penalties
upon taxpayers, and upon us as tax return preparers, for failure to observe ue care in reporting on your income tax retums. In order to
ensure an understanding of our mutual responsibilities, we ask all cients for whom we prepare tax returns to confirm the following
arrangements.

We wil prepare your personal income tax return based on information that you provide to us. We will not audit or otherwise verify the data
you submit, although we may ask you for clarification of some of the information.It is our responsiblity to prepare your tax return correctly
according to the law and the information that you have provided. It is your responsibility to provide us with all the information required to
prepare complete and accurate returns. You should retain all the documents, cancelled cheques and other data that form the basis of your
income and deductions. These may be necessary to prove the accuracy and completeness of the return to CRA. You have the fina!
responsibility for the income tax return and, therefore, you should review it carefully before you sign it

By signing this letter, you represent that you will provide us with accurate and complete information necessary to prepare your tax return. This

==

JANECOSAN

e Your client then cycles through and responds to your questionnaire
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ToDo @  Documents  Profile TaxYear2016 v

View questions in list

What is your current address?

1 Main Street

1487 characters left

ToDo @  Documents  Profile ToxYear2016 v ‘
) Aska question or send a message about this request. 0}
“ re there any changes in dependents?
Yos
O No

And all the while...

e Hub keeps track of your client’s Link status and updates you with the number of addressed questions
and accepted documents

© Profile Hub - o X

ProFile Hub

[ CLIENT NAME FILE NAME CRA IMPORT COMMENTS STATUS LAST SAVED
. Cosan, Jane Cosan, Javi and
o & _ - Run CRA Import Add Note Work I Progress octo7, 201
and

_ Cosan, Jane Cosan, Javie

o

Cosan, Maria
a

% Invite Run CRA Import Add Note Work In Progress Oct 06, 2017

[0 & Shrieve, Michael Shrieve Hertna B e Run CRA Import Add Note Work In rogress - oo, 20m
Tt Clnte 43 Seeced Centy O
e Plus, when you click on the progress number in the Intuit Link column, Link takes you to its online
tal wh i d lient’s submitted d t
portal where you can view responses and access your client’s submitted documents
& O @ @& NUTINCUS linkintitcom * ¥k L e
7 proconnect. Link = Client Details PIEmEERG
Tax Year 2016w Cosan, Jane 7 edit Client's last activity: 10/7/17 12:13 PM
Requests  Documents  Reminders v
) Download Responses (.csv file) £ Download All Files (.zip file]
TvPE ReQuEsT Resonse Y@ () pate. STATUS ACTIONS Client activity
D Tafom  EJane 4minutesago  Completed Message ©  Cosan, Jane is ready
your for review
employer png
(s)
®  Cosan, Jane updated 3
@  Please None. 8minutesago  Completed Message answers and 1
listany document request for
questions ™6
you ®  Cosan, Jane updated 3
might answers for TY16.
have.
@ Doyou Yes 8minutesago  Completed Message
. & Cosan, Jane has
electronically accepted your invite
file your
return?
(@ Didyour No 8minutesago  Completed Message
marital
change
before




e Click the Documents tab (window below) to view both sent and received documents
¢ Send your client additional documents by clicking on Upload to Client
e And click Notify Client to let them know that your submitted documents are waiting for them in Link

< O & |&m~urncus ik LRI

Client Details DiLauro CPA_CMA ¥

Tax Year 2016 v «Back To Overview TY16 Client Done

Y Cosan, Jane 7 edit Client’s last activity: 10/7
w Clients © shrieve4444@gmail.com 7
‘ © cier

Requests ~ Documents  Reminders

(UISERLYNN  Notify Client

From your client
DOCUMENT NAME DATE. Tvee

i Jane Cosan T4, 10717 T4

Shared by you
DOCUMENT NAME DATE. Tvee

W DiLauro Letterhead pages & 107117

One more thing
You can log into Link from any browser by visiting http://link.intuit.com/accountant

2 proconnect. Link

Signin

Email or user ID

Password
Get quick tips to save time
with Link.
Your new Learning Library is here. Tap into
your free short videos and simple step by
step guides.

sessecssesanssanene

v Remember me

Iforgot my user ID or password

BE= visit Link Learning Library (USA)

Bl Visit Link Learning Library (CAN) New to Intuit? Create an account.
Need help? Visit Support

By signing in, | agree to Intuit's Terms of Service, and the
See why clients Privacy Policy for this application

prefer using Link (1

min)

e Once logged in you can view and deal with all your client correspondence
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Clients

2 proconnect. Link

&8 Clients
: Invites.
Al clients accepted
NAME
Cosan, Jane
hrieved444@gmailco

TY16 PROGRESS

7/12

& INTUITING

it Link

Invites pending Invites declined

LASTACTIVITY

18 minutes ago

st | Previous

Y16 done

Add New Client

ACTIONS

Review

Next

Last

Dilauro CPA_CMA %

Client activity

© Cosan, Jane s ready for

®  Cosan, Jane updated 3
answers and 1 document
request for TY16 (0

®  Cosan, Jane updated 3
answers for Y1

& Cosan, Jane has accepted
your invite (44




Chapter 6 Quiz

Question 1: ProFile features a number of Online tools. These tools include:

Hub and Link
ProFile Review
Online backup
All the above

cawy

Correct answer is D

Question 2: ProFile’s toolbars include a dedicated set of icons for accessing online features

Correct answer is True

Question 3: The four online icons are:

Chat, Notifications, Online Settings, and Review
Chat, Explorer, Review and Bridge

Run, Synchronize, Archive and Bridge

None of the above

oCawy»

Correct answer is A

Question 4: True or False: You can use ProFile Review to view T1 returns online

Correct answer is True

Question S: True or False: With ProFile you can use CRA’s AutoFill My Return to download tax amounts to a
T1 file

Correct answer is True

Question 6: To use CRA’s AutoFill My Return, you must:

Register to become an approved electronic filer

Register in CRA’s Represent a Client program and have current and valid credentials
Have a signed T1013 Authorization form for each client

All the above

cawy

Correct answer is D
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Question 7: True or False: With AutoFill My Return, ProFile will be able to autofill all tax data including RRSP
contributions, medical expenses and charitable donations

Correct answer is False

Question 8: True or False: ReFile is a CRA service that lets you make adjustments to the same T1 return an
unlimited number of times

Correct answer is False

Question 9: What are the ReFile service limits:

You cannot change information such as marital status, address or direct deposit information
T1 ReFile lets adjust the same tax return up to nine times

You must make additional adjustments by paper-filing a T1-ADJ

All the above

cawy

Correct answer is D

Question 10: True or False: Before ReFiling a T1 on behalf of a client, you must first obtain an updated and
signed T183

Correct answer is True




Chapter 7: Mining data with ProFile’s Powerful Client Explorer

CHAPTER 7 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e What Client Explorer is and what information it provides
e How to use Client Explorer at a basic level
e How to use Client Explorer’s powerful reporting tools

INTRODUCING CLIENT EXPLORER

Client Explorer is a database, built into ProFile, that helps you view and manage your clients and their files. With
Client Explorer, you can create custom filters that let you open, carryforward and batch EFILE tax returns, and
export and print information on your client and their tax files.

The first time you save a new client file, Client Explorer automatically adds a record for that client to the
database. And whenever you make a change to a client file, ProFile updates the record for that client.

Client Explorer does not store all of the data found in each individual client file. Instead, it contains references to
the file location. However, you can still print reports and export files that include the data from those client files.
Also, you must use Client Explorer to print groups of returns or to file groups of returns by EFILE.

It’s important to note that, in addition to Client Explorer, ProFile offers a separate and functionally-different client
database called Classic Database. This booklet only covers Client Explorer.

Note: You can use either the Classic Database or Client Explorer — not both.

Client Explorer Advantages
The benefits of Client Explorer include:
e Faster network access: Client Explorer works on standalone workstations or small networks, and also
provides faster access for larger offices that share a database over a network.
e Client-centred records: Client Explorer groups files for the same client in a single client record,
regardless of the type or year of the file. You see all of a client's files and returns in one place.
e Customized views: You can set and personalize Client Explorer views and save those settings. You can
use filters to quickly and easily change how you view your files and which files you view.
¢ Intuitive batch functionality: Most multi-file-select actions work the same way as Microsoft
Windows®. You can use filters to view only the files you need, select all of the visible files, and then
select an action from the Database menu or from a right-click menu.
e Access to client details: You can use Client Explorer as an address book or contact list. You can change
client addresses in the Client Explorer without affecting previously-filed returns. And you can
customize the Details pane to include any fields from client returns.

Setting up
You must first setup Client Explorer, and the set-up options depend on whether the tax preparer works alone as a
sole practitioner, or works with other in a shared network environment.

Setting up Client Explorer for a Sole Practitioner
e Click Options -> Database
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e Select the Client Explorer radio button.
e Click Setup Wizard

Database / Client Explorer Options ?

(O None (®) Use Client Explorer (O Use Classic Database

Client Eplorer Options
ProFile Database Server to use

(®) Personal Server (Only you can use)

(O Shared Server
Database to use
Database Name Personal database folder
PROFILEDB \\Mac\Home\D ocuments\My ProFile Data\D atabase
Clear

Batch Options... Advanced >>

&) Setup Wizard 0K Cancel Help

e Click Use Client Explorer and in the following window, click No to indicate that you are a sole
practitioner
Client Explorer Setup wizard X
Client Explorer Setup wizard Do you work in an office where different people need to work on the same
tax returns or financial plans in ProFile?
You can set Client Explorer to be your de
_ _ you can continue using the classic datal O Yes ®No
Client Explorer Setup wizard
This version of ProFile contains a powerf © Use Clent Explorer
er. (O Use classic database

This tool helps you manage and, if you w|

information with other members of your of]

ProFile needs you to answes a few quest
up properly for your work enviconment.
Click the Next button to continue.,

Back Next Cancel Help
Back Next Cancel Hebp I

Back I Next Cancel Help

e Asasole practitioner, select the first radio button and click Next
e Finally, click Finish



ProFile searched your office network and found that no computers were sharing ProFile client
and file information

‘You have two options at this point. You can: Client Explorer Setup wizard X

© Work with a personal collection of client and file inforn ‘You've successfully configured ProFile to work with a personal database of client and file
This database of ProFile client and file information will only be acq  information.
by anyone on the network.

Click the Finish button to exit this wizard.

(O Make this computer a Shared Database Server
A Shared Database Server is used to share the same ProFile cheq

with other ProFile users connected to your network; it is
always on.

=

Back Finish I Cancel Help

Setting up Client Explorer for a Shared Database
e Go back the Setup Wizard, and click Yes at the prompt about working with different people
¢ In a following window, click the second radio button to make the computer a shared database

Client Explorer Setup wizard X

Do you work in an office where different people need to work on the same
tax returns or financial plans in ProFile?

@ Yes ONo

Client Explorer Setup wizard X

ProFile searched your office network and found that no computers were sharing ProFile client
and file information.

‘You have two options at this point. You can:

() Work with a personal collection of client and file information

This database of ProFile client and file information will only be accessible by you and not
by anyone on the network.

(® Make this computer a Shared Database Server
A Shared Database Server is used to share the same ProFile client and file information

with other ProFile users connected to your network; it is preferably on a computer that is
always on.

Back

Back E Cancel Help

e Name your shared database, click OK to accepts any Windows prompts (such as ProFile Privilege
Elevation), and click Finish to complete the process
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|Client Explorer Setup wizard X
‘What name would you like to give to the new Shared Database Server?

The name of the Shared Database Server will be visible to users and will make it easier for
them to configure ProFile to use this server.

PROFILESRY

Client Explorer Setup wizard X

‘You have successfully configured this computer to run a Shared Database Server. You and
other users of Profile can connect to this server and share ProFile chent and file information
with the Client Explorer.

Click the Finish button to exit this wizard.

Request for privilege elevation

o ProFile Privilege Elevation

- Windows ® is about to ask you to enter your administrator password,

Windows Vista requires privilege elevation in order to allow ProFile to
the ProFile Database Server. Without privilege elevation, ProFile will n:
able to setup the ProFile Database Server.

£ Don't show this again

Back Cancel Hep

Using Client Explorer

To open Client Explorer just press the F3 key. The first time it launches, Client Explorer displays an
empty window

e To load existing files, just click /ndex

b client Explore = [
View Al Clients v £ Save View - | 7 Fiter @
Details x| SearchBy  Clientname ~ Search Clear
Actions B A a b c d e f g h j k. 1. .m n o p g r s t u v w x y z 128
Selectall
Clients <<
Files << [%

Files total: 0

e Browse to the file location (usually My ProFile Data) and click Include subfolders

¢ Indicate how you want Client Explorer to handle password protected files =
e Click OK



Add Files To Client Explorer
Folder

|C:\Users\MichaeI\Documents\My ProFile Data

Include subfalders?

Advanced
Password Protected Files

(@ Skip password protected files
(O Prompt for passwords

(O Use this password

‘ []selectFile Types

oK

Cancel

Help

e After the indexing process is finished, Client Explorer displays all tax files stored in the designated

folder

D'allaire, Alfonse
Files

O @ 2013 ProFile: D'allaire, Alfonse.13T
Fredricks, Cindy
Files

O @ 2013 ProFile: Fredricks, Cindly.13t
Harp, Betty.
Files

O @ 2013 ProFile: Sharp, Andrew and Harp, E

<

Files total: 68

W crene
View All Clients v £ Save View - | 7 Fier Inlex
Details x| SearchBy Clientname v Search
Actions dl A a2 b c d e f g h i j k I m n o p g r s
Selectall Investor, Jane
Files Files
O & 2016 ProFile: NoName. 16T O & 2016 ProFile: Pensioner, Frank and Mary
Clients < T T T O [ 2016 ProFile: MASTER Pensioner, Fran!
Files O (& 2016 ProFile: MASTER Pensioner, Frant
0 B ProFile: MiscClients 155 O @ 2016 ProFile: Investor, Jane.16T
O (& 2016 ProFile: COPY Pensioner, Frank ar
Chartrand, Jeannine O W 2015 ProFile: Pensioner, Frank and Mary
Files O & 2015 ProFile: Investor, Jane. 15T
O @ 2016 ProFile: Bellivesu, Alan.16T O & 2014 ProFile: Pensioner, Frank and Mary
a 2013 ProFile: Chartrand, Jeannine. 13T O & 2014 ProFile: Investor, Jane TEST.14T
Files << O @ 2013 ProFile: Chartrand, Jeannine COPIE O @ 2014 ProFile: Investor, Jane.14T

O @ 2014 ProFile: Dividend, Jane.14T

O @ 2014 ProFile: Investor, JaneCOPY.14T
O & 2013 ProFile: Reynard, Serge.13T

O &l 2013 ProFile: Pensioner, Frank and Mary
O @ 2013 ProFile: Investor, Jane.13T

O @ 2013 ProFile: Investar, Jane NEW.13T

Jacobie, Sam
Files
O ke 2016 ProFile: Texpayer, Amy and TaxPe
O @ 2016 ProFile: Shamrockvilee, Fred 16T
O & 2016 ProFile: Jameson, James.16T
O & 2016 ProFile: Jacques, Savoie and Tren
O & 2016 ProFile: Jacobie. Sam.16T
O & 2016 ProFile: Copie Jacques, Savoie an
O W 2015 ProFile: Texpayer, Amy.15T
O @ 2015 ProFile: Shamrockvilee, Fred 15T
O Weo14 PruF\%Taxpayev, Any.14T
O Bl 2013 ProFile: Savoie, Jacques.13T
JoNESONS, HELEN
Files
O @ 2016 ProFile: Soleil Maurice & Marie. 161
JONESONS, LESLIE
Files
O & 2016 ProFile: Soleil Maurice & Marie.161
McDonald, Leslie
Files
O @ 2013 ProFile: McDonald, Leslie.13t

Pensioner, Fi
Files

O Waoier
O @aoier
O Waoer
O Waoier
O Waoier
O Waoier
O @aoisF
O @aoisF
[}

O @ao4r
O @aosF

Redresseme
Files

O @aoier

Reynard, Ma
Files

O @aosF
>

e By default, View is set for A/l Clients. To change that view, just click the dropdown
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' Save View

zntname v
T1-EFILE Eligible 3
T1 - EFILE Not Accepted ¢ o i g b 0
T1 - Camyforward to Current Year
T1 - Current Year - Ready to Print
TP1-EFILE Eligible I

b ProFile: NoName 16T

1394928 ONTARIO INC.

Files

O &3 ProFile: MiscClients. 15X !

Chartrand. Jeannine

Files
O @ 2016 ProFile: Belliveau, Alan 16T
[ |8 2013 ProFile: Chartrand, Jeannine.1

e The Contact View, for example, displays full contact information for all your clients
e Use the tabs to narrow your search parameters

yd Client Explore = [@ ]3]
View Contact View - f Save View . ~ Fit
SearchB i se

QA eb o4 ef gh i K omnoop or st u v ow o x y z
T

Chartrand, Jeannine.
SIN
565-555-556
Home Address
12 Main St
Otiawa, ON
KOATAD
Home Phone
(613) 555-5555

D'allaire, Alfonse
SIN
238948111
Home Address
6771 2dieme
Rosemant OC
H2R5E4
Home Phone
(514 555-4333

Files total: 68. Files visible: 2

e Client Explorer lets you customize views by setting filters
e Click Filter to open the bottom panel and customize the files that Client Explorer displays
e The Filters panel lets you select a wide range of parameters including, tax types, tax years, client and

file status, date-range and so on



_. Details

Search

L ‘ Client Explorer a
View Contact View v £F Save View
Search By Client name v
Al 'a b c d e f g h i j k | m n o
Chartrand. Jeannine
1394928 ONTARIO INC. i
Busi 555-655-556
usiness Number
869604231 Home Address
12 Main St
Ottawe, ON
KOA 140
Home Phone
(613) 555-5555

<

Files total: 68. Files visible: 26

Filters

T T2 T3 X

= ‘Years Client Status T1 EFILE Status

E “en? A & Unknown A MUnknown

F 206 M Caried forward & Not eligible
2015 ~ Work in process M Eligible
2014 M Waiting for client ~ Ready to transmit
2013 M In preparer review M Transmitted
Ma012 M In partner review M Accepted
~M2011 ~ Ready to print & Not accepted
2010 & Printed M Paperfiled
42009 v ¥ Completed o
M 2nnR M Nt filines

W <

TP1 EFILE Status
& Unknown
& Not eligible
M Eligible

~ Ready to transmit

M Transmit Failed
& Transmit OK

M Accepted

~ Not accepted
M Paper filed

Index

Clear

D'allaire. Alfonse
SIN
238-943-111
Home Address
6771 2dieme
Rosemont, QC
H2R 5E4
Home Phone
(514) 555-4333

SEND Status

&4 Unknown ~

&4 Not Eligible

M Eligible

& Ready to transmit
M Transmitted

& No debt

& Debtunder $10
& Debt over $10

& Prior claim

M Fl hengfit

Fredricks, Cindy
SIN
491-444-781
Home Address
2642 21 Ave Ne
Calgary
T2E5CS
Home Phone
(403) 999-9999

Show Spouse In List
Show Competitor's Files

2017/10/09 Discounted

No [ves
2017/10/09

P y

No [ves

E=E o =

Harp. Betty
SIN
474-441-565
Home Address
1963 19 StNe
Calgary. AB
T2E 4R5
Home Phone
(403)111-1112

Apply Filters X

Preparer I:J
[ ]

Partner

Advanced

e Once you create a view that suits your working style, in the window above, click Save View a
¢ In the dialog box that opens, name your customized view and click OK.

Save View As X

Please enter a name for your current
view,

|Current Corp Clients

==

Using Client Explorer to find files

e C(Client Explorer has a Search tool that helps you find a specific client file
e Use the dropdown field to select the search parameter
e Type the query term, click Search and Client Explorer will display all files matching your search query
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-

n Client Explorer

Yiew Contact View

SIN - |999999993

Business Number =
a b |Clientname i
Client Reference #
SIN
Trust Number k‘
Business Numbe
301411047
Mailing Address
1 Main Street

i k | m n o p q r s

()

Client Explorer as a Contact Manger
e You can easily use Client Explorer as a Contact Manager. Just select a file (by clicking into its

checkbox) and the left pane displays contact information for that client.

W Client Explorer

View All Clients ™ I Save View v
Details X Search By SIN v
Al ac df gh §j Kk mn op gr st uw

#41 Openfiles
3 Carry forward files.

Build EFILE...

Files

Printfiles...

- O & 2016 ProFile: NoName. 16T

Printforms in the files...
Clear selection 1394928 ONTARIO INC.
Selectall Files
O &3 ProFile: MiscClients. 15X
Chartrand, Jeannine
Files
O & 2016 ProFile: Belliveau, Alan 16T
O @ 2013 ProFile: Chartrand, Jeannine.13T

SIN

474-441-565
Home Address O @ 2013 ProFile: Chartrand, Jeannine COPIE
196319 StNe

D'allaire. Alfonse
Files
O & 2013 ProFile: D'allaire, Alfonse.13T

Calgary. AB

Fredricks. Cindy
Files
O 2013 ProFile: Fredricks, Cindy.13t
Harp. Betty
Files

Dave e seiecuon

| Files total: 68

Pestore file selectio

To carry out more actions, right-click a file to open a context-sensitive window that lets you, among

L]
others, Open, Carryforward or Print Files, as well as Export, Copy or Delete them.



n Client Explorer

View All Clients
Details X
Actions <<

#41 Openfiles
Carry forward files
Build EFILE..

¢y Printfiles

Printforms in the files...

Clear selection
Selectall

A
A

File <<

i NoName 16T

Save file selection

7 £ Save View 7 Filter

Search By SIN

Al ac df gh §j Kk mn

ESN Eo =%

]
]
op or st ouv wx yz 123

Investor, Jane

Files Files
1l 2018 ProFile: NoName. 16T O @2016Pn
1394328 ONTARIO INi - O i ams o
Files Open Files
O & ProFile: MiscClien| Carry Forward Files
Build EFILE File...

Chartrand. Jeannine
Files
O @ 2016 ProFile: Bell;
O @ 2013 ProFile: Cha
O & 2013 ProFile: Cha

D'allaire. Alfonse
Files
O @ 2013 ProFile: D'all

Fredricks, Cindy
Files
O &l 2013 ProFile: Fred

Harp. Betty
Files
[ @ 2013 ProFile: Sha

<

Files total: 68

Edit Client Details...

Print Files
Print Forms in File...
Print Mailing Labels...

Export...
Print Report...

Add files to Client Explorer...
Index Files...

Move Files...

Copy Files...

Delete Selected Items...

Clear Selections Ctrl+D
Select All Ctrl+A
Refresh F5
Apply Filters F6
Show Filter Panel

Show Details Panel

View >

EFILE WITH CLIENT EXPLORER

Chapter 4 introduced CRA’s EFILE system and described how a tax prepare uses EFILE to electronically file a

client’s T1. This section illustrates how you can use Client Explorer to EFILE multiple T1s at the same time.

Batch EFILE with Client Explorer

To create EFILE files for a group of returns:
e Press F3 to open Client Explorer

e In the client list pane, click the Select all tab (on the left)

n Client Explorer

View All Clients
Details X
Actions <<

4. Openfiles
Carry forward files...
Build EFILE...

Printfiles...
- Printforms in the files...

Selectall

A
A

=]

v £ Save View 7 Filter

e |

Search By SIN
Al ac df gh i Kk mn op gr st u wx yz 123
Investor, Jane
Files Files
L 2016 ProFile: NoName. 16T O Waoepn
1394928 ONTARIO INC. O Weotspn
- O WeotsPn
Files o@
O &3 ProFile: MiscClients. 15X 82016 Pn
O @eaoiepn

Chartrand. Jeannine

Files
RN -~ W - PP

O @eo1spPn
O @ao1spn
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In the View drop-down list, select the type of EFILE operation that you want to perform. ProFile filters the list to
display only files with the selected status.

e To view tax files eligible for EFILE, select 7/ — EFILE Eligible
e From the list of eligible files, select the files that you want to include in the next transmission =

e To prepare the files for submission, choose Build EFILE [l

n Client Explorer
View T1-EFILE Eligible v . I Save View Filter
Details X Search By Client name v
Actions << Al abh cd ef gh i j k |
4. Openfiles
3 Carry forward files...
Build EFILE... Chartrand. Jeannine

Printfiles Files
- Printfarms in the files... Lt 2016 ProFile: Belliveau, Alan 16T

Clear selection Investor, Jane
Selectall Files
_EJ 2016 ProFile: Investor, Jane 16T

2 client(s) selected <<

—~ v

2 file(s) selected <<
i Belliveau, Alan.16T
[ P v
Save file selection =
Files total: 69. Files visible: 2
DRSS SV NPT L PRI e VSIS bl

e Ifnecessary, in the Build window that opens, further specify the type of EFILE file to create (or the
Agency, Data Type and Slip Type when you are building an electronic media file for slips/relevés).
e Click OK when you're done

< (@ Build T1 EFILE On-Line Batch (O Build TP1 EFILE >
|| Client Name Filename
Chartrand, Jeannine C\Users\Michael\DocumentsiMy ProFile Datah2016T1\Belliveau, Alan. 16T
‘ Investar, Jane CiUsers\Michael\DocumentsiMy ProFile Datai2016T14Investor, Jane 16T
< >

Cancel Help

e ProFile reports progress on the selected returns as it builds them. A Successful build status should
appear next to each return
e Click Transmit Now to EFILE the batch



. (%3 Investor, Jane

Successful.
Successful.

R

Client: Investor, Jane

Status:  Successful.

| Transmit how |

File: C:A\UsershMichael\Documentsihy ProFile D atah2016T 15\ nvestor, Jane

Transmit later Cancel

For more details on transmitting T1 and TP1 returns that you prepared in this way, go to ProFile Help and
search for “Transmit a batch of EFILE Online files”

PRINTING AND EXPORTING WITH CLIENT EXPLORER

Export to Excel

Here’s how you can export data from Client Explorer to Microsoft Excel ™"

e From Client Explorer, select the files for the year and module you’d like to export

e Click the Database menu and select Export [e]

Edit Client Details..

Print File
Print Forms in File...
Print Mailing Labels...

Print Repor&

Move Files...
Copy Files...
Delete Selected Items...

Add files to Client Explorer...
Index Files...

Clear Selections

Select All

Show Filter Panel
~  Show Details Panel

View

4l PROFILE
File Database Goto Form Options EFILE Online Training Window Help

Open Files v vH v 7 ) 2 AH H i Search ‘ 8
= Carry Forward Files

Build EFILE File...

N [ Save View

ESHECE °x

7 Filter ] ‘ Index

Search By Clientname ~ ‘

] | Search l

Al ab cd ef gh §j Kk mn op q

 Files
[ W2016 ProFile: NoName 16T

Chartrand. Jeannine
Files

Ll 2016 ProFile: Belliveau, Alan. 16T
Investor. Jane
Ctrl+A Files
L4 2016 ProFile: Pensioner, Frank and Mary
L 2016 ProFile: MASTER Pensioner, Frant
5 L&l 2016 ProFile: MASTER: Pensioner, Frant
Ll 2016 ProFile: Investor, Jane.16T

Belliveau, Alan 16T

<
Save file selection

~
L&l 2016 ProFile: COPY Pensioner, Frank ar

Copie Jacques, Savoie and ,

> <
Files total: 69. Files visible: 26

s t u v w x y z 123

n Jacobie, Sam

Files
Wwone ProFile: Taxpayer, Amy and TexPe
L& 2016 ProFile: Shamrockvilee, Fred. 16T
Ll 2016 ProFile: Jameson, James.16T

E 2016 ProFile: Jacques, Savoie and Tren

L4 2016 ProFile: Jacobie, Sam 16T

ﬁ.i 2016 ProFile: Copie Jacques, Savoie an

JoNESONS. HELEN
Files
L& 2016 ProFile: Soleil Maurice & Merie. 167
JONESONS, LESLIE
Files
Ll 2016 ProFile: Soleil Maurice & Marie. 16T
>
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e From the Export Files dialog box, click Options

Export Files ? X
Define your export options and click the Export button to extract data from the client files
listed below.

ClientName Filename A
<No Name> CiUsersiMichaehDocumentsiMy ProFile Datal2016T1\NoName
Chartrand, Jeannine  CiUsers\Michael\DocumentsiMy ProFile Datal2016T1\Belliveat
Investar, Jane CiUsersiMichaehDocumentsiMy ProFile Datal2016T1A\COPY P¢
Investar, Jane CiUsers\MichaehDocumentsiMy ProFile Datal2016T 1\Investor,
Investar, Jane CiUsers\MichaehDocumentsiMy ProFile Datal2016 T1\MASTEF
Investar, Jane CiUsersi\MichaehDocumentsiMy ProFile Datal2016T1\MASTEF
Investar, Jane CiUsers\MichaehDocumentsiMy ProFile Datal2016T1\Pensione
Jacobie, Sam CiUsersi\MichaehDocumentsiMy ProFile Datal2016T1\Copie Je
Jacohie, Sam CiUsers\MichaehDocumentsiMy ProFile Datal2016T14Jacobie,
Jacohie, Sam CiUsers\MichaehDocumentsiMy ProFile Datal2016T1\Jacques
Jacobie, Sam CiUsers\MichaehDocumentsiMy ProFile Datal2016T1\Jamesot
Jacohie, Sam CiUsers\MichaehDocumentsiMy ProFile Datal2016T14Shamroc
Jacobie, Sam CiUsersi\MichaehDocumentsiMy ProFile Datal2016T1\Taxpaye
JoNESONS, HELEN CiUsers\MichaehDocumentsiMy ProFile Datal2016T1\Soleil M: +
< >

< Options ’ Cancel Help

The Fields tab of the Export Options window (below) is where you choose the fields code for the information that
you want to include in your export

e Click 4dd to begin selecting the fields you’d like to export
e Select the field to add in your export, then click OK =
e To include more fields, keep clicking Add

[y 4l Export Options ? X
Fields  Format
Export
ClientFirstName Add il select Field ? X
Clientl atName - PersonalInfo T1Jacket T1 Schedules Invoice
BalanceOwing
p—— Field Name Description
e elete Lined459 Line 459: Children's fithess tax credit
A Lined460 Line 460: Direct deposit - branch number
Lined61 Line 461: Direct deposit - institution number
L/ Line462 Line 462: Direct deposit - account number

Lined6s Line 465: Ontario Opportunities Fund

Line466 Line 466: Net refund

Lined68 Line 468: Supplies expensel

Lined69 Line 469: Eligible educator school supply tax credit

Lined?6 Line 476: Tax paid hy instalments

Lined79 Line 479: Provincial or territorial credits

Line4g2 Line 482: Total credits

(»- T >
< > Ok Cancel Help
Line466 Pick

Load Save Cancel Help

There are two files you need to create. One is the design of the export which indicates what information you need
to extract from the ProFile tax files. This file is saved as a .qex file and it is configured on the Fields tab of the
Export Options window above. The second file stores the actual information that will be used to import into

Excel. This second file is usually saved as a .txt or .csv file. You save this file on the Format tab of the Export
Options window above.



e To create and save the second file, navigate to the Format tab and click the Browse button to the right
of the Export to File field

e Type in a name for your file el

e Ifyou’re using a .csv extension, click the dropdown and select A/l files =

e Click Open =

|4l Export Options ? X
Fields Format
Export To File | = n
Export Type Tab Delimited ™ Export Character
[V Export Field Names d Open X
[JPut Double Quotes Around Exported Fields
™ > ThisPC > Documents > My Profile Data > Reports v O earch Report Ve
[JRecalculate Each File Before Exporting
Organize > New folder - m
2015T1 A Name Date modified Type
201513
2016FX
2016T1
201673
2017FX
2017T1
database
EFILE
Link
Options Pack:
Reports
V] [&
Load Save Cancel
File name: | RefVSBalDue.csv n All files (**) N
B-

ProFile will return to the Export Options window where you can finalize your setup options

e Note that the file is saved in MyProFile Data\Reports and it is here that you will browse to later to
import the data into Excel

e Choose the export type, Tab Delimited, for example =

e Check Export Field Names, which will put the field code at the top of each column in Excel B
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n Export Options

Fields Format

? X

Export Type Tahb Delimited

Export Field Names ﬂE
[JPut Double Quates Around Exported Fields

[CJRecalculate Each File Before Exporting

Load

Save

Export To File ‘C:\Users\MichaeI\Documents\My ProFile Data\ReporsiRefvYSBalDue.csv n:l =

n ™ Export Character

Cancel Help

e Go back to the Field tab and click Save

e ProFile will save the design of the report as a .qex file (=)

e Click Save once more to save the .qex file =

e Click OK, and you’ll be taken back to the main export window =

|y Export Options ? X
Fields  Format
Export
ClientFirstName Add
ClientLastName
Insert
BalanceOwing
Line466 Delete
&
i save s x
4 1 > ThisPC > Documents > My Profile Data > Reports v o »
Organize >  New folder ()
2016FX "~ Name
201611
201673
< 20176
201m
ClientFirstName
1 4 database
EFILE
Load Save Cancel tink
Options Packs
Save as type: | Export option files (*QEX)
A Hide Folders n Cancel
L]

created earlier

At the Export File window, click Export and the information will be sent to the

.csv file that you



Chartrand, Jeannine
Investar, Jane
Investar, Jane
Investar, Jane
Investor, Jane
Investor, Jane
Jacobie, Sam
Jacobie, Sam
Jacobie, Sam
Jacobie, Sam
Jacohie, Sam
Jacohie, Sam

<

Export Files ? X
Define your export options and click the Export button to extract data from the clientfiles
listed below.

Client Name Filename A
<No Name> CiUsers\MichaelDocumentsity ProFile Datah2016T1\NoName

JoNESONS, HELEN CiUsers\MichaehDocumentsiMy ProFile Datal2016T11Soleil Mz«

CiUsers\MichaelhDocumentsity ProFile Datay2016T1\Belliveat
ChUsers\MichaehDocumentsiMy ProFile Datal2016T14COPY Pe
ChUsersiMichaehDocumentsiMy ProFile Datal2016T 1 nvestor,
CiUsers\Michael\DocumentsiMy ProFile Datai2016T1\MASTEF
CiUsers\Michael\DocumentsiMy ProFile Datah2016T1\MASTEF
CiUsers\MichaelDocumentsiMy ProFile Datah2016T1\Pensiont
CiUsers\MichaelDocumentsiMy ProFile Datah2016T1\Copie Je
CiUsers\MichaelDocumentsiMy ProFile Datah2016T1\Jacohie,
CiUsers\MichaelDocumentsiMy ProFile Datah2016T 1\ Jacques
CiUsers\MichaeDocumentsity ProFile Datay2016T 1\ Jamesor
ChUsers\MichaehDocumentsiMy ProFile Datal2016T14Shamroc
ChUsers\MichaehDocumentsiMy ProFile Datal2016T 14 Taxpaye

>

Help

< Export > Cancel

e You are now ready to import the data to Excel, all you need to do is find the .csv file and open it in

Excel
Insert Page Layout Formulas Data Review View
- X, cut Calibri (Body) 12 A~ Av = | = | =9 Wrap Text Ge
Copy 3 - —
Paste Format B I U ] » & v = = = &= o= $
H31 N fx
A B C D E F G

1 ClientFirstName ClientLastName BalanceOwing Line466

2 Alan Belliveau 1839.47 0

3 |Jacques Savoie 10870.34 0

4 Emilie Leblanc 0 0.36

5 |Frank Pensioner 0 38371

6 Mary Pensioner 20374.68 0

7 Yvan Gravel 4981.93 0

8 |Anne Gravel 1700.78 0

9 |Jane Investor 1481.78 0

10 Sam Jacobie 0 0

11 Jacques Savoie 10870.34 0

12 Emilie Leblanc 0 0.36

13 |James Jameson 0 3540.86

14 |Frank Johnseson 31484.52 0

15 Mary Jones 3950.23 0

16 Frank Pensioner 0 38371

17 Mary Pensioner 20374.68 0

18 Frank Pensioner 1044.22 0

19 Mary Pensioner 14655.9 0

20 Frank Pensioner 647.72 0

21 Mary Pensioner 14838.94 0

22 Alex Redressement 350.71 0

23 |Fred ShamrockVilee 214.8 0

24 |LESLIE JONESONS 141131 0

25 HELEN JONESONS 12903.75 0

26 Amy Taxpayer 6613.69 0

Printing Reports
The steps for printing reports are similar to what you just learned for exporting data. As illustrated in the previous
example from Client Explorer, select the files to print from, and then click Database > Print Report

e In the Create Report window, click Options.
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Create Report ? X
The following returns will be ad[f}éd to the report.

Client Name Filename A
<No Name> CiUsers\MichaehDocuments\My ProFile Datah2016T1\NoName
Chartrand, Jeannine  Ci\Users\MichaelhDocuments\My ProFile Datah2016T14Bellivest
Investor, Jane CiUsers\MichaehDocumentsi\My ProFile Datah2016T14WCOPY Pe
Investor, Jane CiUsers\MichaehDocumentsi\My ProFile Datah2016T 14Investor,
Investor, Jane CiUsers\MichaehDocuments\My ProFile Datah2016T1\WMASTEF
Investor, Jane CiUsers\MichaehDocuments\My ProFile Datah2016T1\WMASTEF
Investor, Jane CiUsers\MichaehDocumentsi\My ProFile Datah2016T1\Pensione
Jacobie, Sam CiUsers\MichaehDocuments\My ProFile Datah2016T14Copie Je
Jacobhie, Sam CiUsers\MichaelhDocumentsi\My ProFile Datai2016T1YJacobie,
Jacohie, Sam CiUsers\MichaehDocuments\My ProFile Datai2016T1YJacques
Jacohie, Sam CiUsers\MichaehDocuments\My ProFile Datah2016T1YJamesor
Jacobie, Sam CiUsers\MichaehDocuments\My ProFile Datah2016T14Shamroc
Jacobhie, Sam CiUsers\MichaehDocuments\My ProFile Datah2016T 1\ Taxpaye
JoNESONS, HELEN CiUsers\MichaehDocuments\My ProFile Datah2016T1\Soleil Mz «
< >
‘ Print Cancel Help

e On the Header tab, select text that will appear on all pages. For example, to use today’s date, double-
click on Today

n Report Options ? X

Header Fields Footer Format

[0
([0

|Aria| v |||1l] v IH Auto FH‘ None FH B I U ’
% 1 2 3 4 5
{Today}

< >

Page
Copy
Part

CurrentTime

Load Save Cancel Help

e The top row of the Fields tab displays column headings. Select the first cell and then click Properties
o In the Title Cell Properties window, you can set up text formatting and enter the text for Title 1
e Click OK to close the window



il Report Options ? X
Header Fields Footer Fomat
Column: Add Insert Delete 8 Propetties
e ' ----- I o
[ - | Add
Insert
Delete Title Cell Properties ? X
Text
IFivst Name n ‘
Eont
T @uGothiclight A | color B Black o
It @Yu Gothic Medium
B @Yu Gothic Ul Style Bold
I @vu Gothic Ul Light E,kaﬁc
& @Yu Gothic Ul Semibo [ Undetine
Title 1 | Pk I @Yu Gothic Ul Semilgt
B Algerian
ot || soe [0 ] cwed || v e
Other Sample
CoumnWidh  [T5" 5 First Name
Row Height 02" =
n Apply Cancel Help

e You now need to input data for the report. Double-click the cell directly under First Name and choose
from a list of Field Codes.

e In the Select Field window, choose ClientFistName and click OK

w Report Options
Header Fields Footer Format
Column: Add Insert Delete 2N Properties
First Name Fow
Add
Incart
i select Field ? X
Personallnfo T1 Jacket T1Schedules Invoice
Field Name Description 2
ClientAddress Street address [%
ClientAge Age
ClientApt Apt. or unitno
ClientBithDate Birth date
ClientCareOf Care of
ClientCellPhone Cell phone
ClientCity City
ClientCountry Country (other than Canada)
£ Firstname - >
e
v
>

3 Ok Cancel Help

e Click 4Add and repeat the step above to add more fields. Once done, your report template will look like
this
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n Report Options ? X
Header Fields Footer Format
Column: Insert Delete £ || = Properties
First Name [ Last Name | Bal Due [ Refund Row
ClientFitstName ‘ ClientLastName | BalanceOwing II:I[V?‘}EE 7777777777777777 ' Add
Insert
Delete
A
Line466 Pick
Load Save Ok Cancel Help
[ ]

Use the Footer tab to set up footnotes that appear at the bottom of each page.

W Report Options

? X
Header Fields Footer Format
‘Arial V|||1U vm Auto HH None Iﬂ\B I H‘ E
b2 1 2 3 4 5
{Page}
< >

CurrentTime

Load Save Cancel Help

e Use the Format tab to set up other options such as the printer that will generate the report.



n Report Options ? X

Header Fields Footer Format

Printer

Microsoft Printto PDF v Properties
Margins

Left 05" 2 Top 05" Copies |1 2 [collate
Right  |o5" : Bottom  |ggv

[(IBlack and White Print Grid Lines [shade Altemate Rows

-
v
-
v

Load Save Cancel Help

e Save your setup options and click OK to open the Create Report window. Click Print to run the report.

Create Report ? X

The following returns will be added to the report.

Client Name Filename A
<No Name> ChUsers\Michaelh\Documentsi\My ProFile Datal2016T14NoName
Chartrand, Jeannine  Ci\Users\MichaehDocuments\My ProFile Data\2016T14Belliveat
Investor, Jane ChUsers\Michaelh\Documentsi\My ProFile Data\2016T14WCOPY P
Investor, Jane ChUsers\Michael\Documentsi\My ProFile Datal2016T 14nvestor,
Investor, Jane CiUsersiMichaeh\DocumentsiMy ProFile Datal2016T1\MASTEF
Investor, Jane ChUsers\MichaelhDocuments\My ProFile Data\2016T1\WMASTEF
Investar, Jane CiUsers\MichaehDocumentsiMy ProFile Datal2016T14\Pensione
Jacobie, Sam ChUsers\MichaelhDocuments\My ProFile Data\2016T14Copie Je
Jacobie, Sam ChUsers\Michaelh\Documentsi\My ProFile Data\2016T 1 Jacobie,
Jacohie, Sam CiUsers\MichaehDocumentsiMy ProFile Data\2016T1\Jacques
Jacobie, Sam ChUsers\MichaelhDocumentsi\My ProFile Data\2016T 1YJamesor
Jacohie, Sam ChUsers\MichaelhDocumentsi\My ProFile Datal2016T14Shamroc
Jacohie, Sam CiUsers\MichaehDocumentsiMy ProFile Data\2016T1\Taxpaye
JoNESONS, HELEN ChUsers\MichaehDocumentsiMy ProFile Datah2016T14Soleil M:
< >

e Here is your report
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Monday, October 9, 2017
First Name Last Name Bal Due Refund
0.00 0.00
Alan Belliveau 1,839.47 0.00
Mary Pensioner 20,374.68 0.00
Jane Investor 1,481.78 0.00
Mary Pensioner 20,374.68 0.00
Mary Pensioner 14,659.90 0.00
Mary Pensioner 14,838.94 0.00
Emilie Leblanc 0.00 0.36
Sam Jacobie 0.00 0.00
Emilie Leblanc 0.00 0.36
James Jameson 0.00 3,540.86
Fred ShamrockVilee 214.80 0.00
Amy Taxpayer 6,613.69 0.00
HELEN JONESONS 12,903.75 0.00
LESLIE JONESONS 1,411.31 0.00
Frank Pensioner 0.00 383.71
Frank Johnseson 31,484.52 0.00
Mary Jones 3,950.23 0.00
Frank Pensioner 0.00 383.71
Frank Pensioner 1,044.22 0.00
Frank Pensioner 647.72 0.00
Alex Redressement 350.71 0.00
Jacques Savoie 10,870.34 0.00
Jacques Savoie 10,870.34 0.00
Anne Gravel 1,700.78 0.00
Yvan Gravel 4,981.93 0.00
by

Creating Mailing Labels with Client Explorer

Before using Client Explorer to print labels, you will, of course, have to set up your mailing labels.

Go to the File menu and select Setup Mailing Labels

o

e Click a Module tab E]

e Click the dropdown to choose your label type (=)

e Ifyou’d like to format your own label, click New Label (ProFile will designate it as User Label 1) and
enter the label rows, columns on the right side of the window below. [

e Click ox®

Label Selection ? X
22016 T1/TP1 v|idam | & 42018 T3/TPe4E |

Label Type Label Details

New Label

Horizontal Pitch

Vertical Pitch

2160 Avery Addressing 2160 Avery Addressing
2160 Avery Addressing A
E 2162 Avery Addressing Labels Across 1 :
2163 Avery Address/Shipping - —
2164 Avery Shipping Labels Down 8
2180 Avery File Folder-Assorted : : —
2181 Avery File Folder-White Side Margin 0.81
2660 Avery Clear Address 5 == -
2662 Avery Clear Address v | | TopMagn 05 -
Label Width 263"
Label Height

a Continuous Feed

Cancel

Help




e To print mailing labels, follow these steps.

Note that when printing a group of labels, all files must be of the same module and tax year.

e Press F3 and from Client Explorer, choose just a few files for a test run

D j Client Explorer

View All Clients.
Details X
Actions <<

#41 Openfiles
Carry forward files
Build EFILE.

¢=y Printfiles

Printforms in the files

Clear selection
Selectall

Jacobie, Sam <<
SIN ~
999-999-998
Home Address
12 Main v
4file(s) selected P

Jacobie, Sam.16T

Jameson, James. 16T
ShamrackVilee, Fred. 16T
Taxpayer, Amy and TaxPayer, |

< >
Save file selection

b £f Save View

= e

* Filter Index

SearchBy | Clientname &

] | search

Al ab cd ef gh §j K mn op q

Files
O i 2016 ProFile: NoNare. 16T

1394928 ONTARIO INC.
Files
O &3 ProFile: MiscClients. 15X

Chartrand, Jeannine
Files

O &l 2016 ProFile: Belliveau, Alan.16T
Investor. Jane

Files

@

r st u v w x y z 123

JONESONS, LESLIE
Files
O & 2016 ProFile: Soleil Maurice & Marie. 16T

Pensioner. Frank

Files
O &l 2016 ProFile: Pensioner, Frank and Mary
O (&l 2016 ProFile: MASTER Pensioner, Frant
O (& 2016 ProFile: MASTER Pensioner, Fran
O [ 2016 ProFile: Jones, Mary.16T
O & 2016 ProFile: Johnseson, Frank 16T
O [ 2016 ProFile: COPY Pensianer, Frank ar

Redressement, Alex
Files

Afacobie. Sam
| Files
L 2016 ProFile: Texpayer, Amy and TexP:
Ll 2016 ProFile: ShamrockVilee, Fred. 16T
| Ll 2016 ProFile: Jamesan, James. 16T
W4 U 2016 ProFile; Jacobie, Sam. 16T

<
Files total: 69. Files visible: 20

O [ 2016 ProFile: Redressement Alex 16T

Sayoie. Jacques
Filds
B 2018 ProFile: Jacques, Savoie and Tren
O @ 2016 ProFile: Copie Jacques, Savoie an

e Click Database > Print Mailing labels
e Mailing labels for spousal returns will show both spouses’ names. To avoid printing two labels for each

spousal return, check the box marked Print only one label for coupled returns [e]

e Clickox B

Make sure to feed the correct labels into your printer, before starting the print job.
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Chapter 7 Quiz

Question 1: Client Explorer is a database that lets you:

View and manage your clients and their tax files

Create custom filters for selecting only certain types of files
Print or export customized reports

All the above

cawy

Correct answer is D

Question 2: True or False: ProFile has two different database tools: Client Explorer and Classic Database, and
you can use both at the same time

Correct answer is False

Question 3: The first time you launch Client Explorer you must:

Index the existing files

Copy files from the data folder and paste them into Client Explorer
Run the Synchronize and Archive feature

Ensure that all files are linked to each other

cawpy

Correct answer is A

Question 4: True or False: You cannot share a Client Explorer database with other tax preparers

Correct answer is False

Question 5: True or False: Client Explorer can only access files stored in one folder and its nested subfolders

Correct answer is True

Question 6: To use Client Explorer as a contact manager, you should:

Create a customized report and export it to Excel

Extract the names and addresses from within the T1 view

You cannot, in fact, use Client Explorer as a contact manager

Click the dropdown arrow in the View field and select Contact View

cawy

Correct answer is D




Question 7: True or False: You can create your own customized view options (called Filters) in Client Explorer

Correct answer is True

Question 8: True or False: You can use Client Explorer to prepare mailing labels

Correct answer is True

Question 9: Client explorer lets you:

Carry forward prior-year tax files
EFILE tax returns in a batch
Select and print tax files

All the above

oCawy»

Correct answer is D

Question 10: There are two special types of files Client Explorer prepares for print jobs and for exporting. The
file extensions of these two files are:

A. .qex and .qrp
B. .pdfand .atf
C. .gex and .csv
D. .gtl and .at2

Correct answer is A
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Chapter 8: Advanced Features

CHAPTER 8 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e The purpose of a file template
e The various ways to attach ancillary documents to a T1
e How to pay CRA using T1 PAD

FILE TEMPLATE

If you find that you are constantly checking the same boxes on ProFile’s Info page (for example, the Elections
Canada question), or if you find that most of your clients live in the same city or province, you can setup a file
template that automatically fills in certain fields with a uniform set of data. This capability is called a file template
and, once you’ve set it up, Profile automatically fills in the fields of any new tax as specified in that template.

In addition to pre-filling fields that you specified in the template, you can also set the forms (and the sequence of
forms) you want ProFile to open when you first create a new file. You can create a separate file template for each
ProFile module.

Note: When you carry forward prior-year files, information from the previous year will always overwrite any file
template data.

To create a file template:
e Create a new tax return.
e Enter data into any field on any form. The example below has data for City and Province, as well as
Canadian Resident, Elections Canada, and Language fields
e Open any forms that you want ProFile to open automatically when you create a new client file that is
based on this file template



[o]e =y

371013 | @451 | (85T3| (8 6T4| (8275 | @ & RRSP/PRPP |  +

0 g common-law at any
time in this tax year? r] Yes D No
Residency

Care of
Street address Apt #

IRR

Province of residence

on 2016/12/31 Ontario

M Province of self-employment

If you became or ceased to be a Canadian resident in

2016, enter date of: entry mm-dd
or departure  mm-dd

Birth date yyyy-mm-dd A 0
Date of Death _ yyyy-mm-dd

Gender |:| Male |:| Female

Province or territory where taxpayer resides if different from mailing
address:

By providing an email address, | understand

| am registering for online mail and accept

Are you a non-resident? D Yes No
™ Residency status Resident
Country (other than Canada)

R - Did you dispose of a property (or properties) in 2016 for which you ar
Gic f(.)llowmg VG ET Cariizms: ‘:l Yes D No claiming a principal residence exemption? |:| Yes No
Email address:
Use preparer address for:

Nothing |:| Notice of Assessment and Refund |:| Nof A
D T1 mailing address

EFILE this retum?
EFILE multiple years?

Authorization for efiler to represent taxpayer?
First time filer in 2016?

Method of contact for: P

in 2016 with a total cost of more than
CANS$100.000?

Contact preparer by mail L] Is taxpayer's income zero?

Contact client Claim disability amount?

Is return discounted? ﬂ Yes No If yes. is this a first year claim?

Is return completed under the CRA's Mentally or physically infirm?

volunteer program? |_| Yes No Indian within the meaning of the Indian Act?
Were you confined to a prison or similar institution Is this an Early Filed or Elective deceased

for a period of 90 days or more during the year? return?

(Schedule 6. ON479 & GST / HST Credit) D Yes No Subsection 104(13.4) election to have certain
If your province or territory of residence changed income taxed on the & hedaceased
in 2016, enter the date of your move. yyyy-mm-dd gwenerary, rather than on a T3 return

Language of correspondence English

e as the

.I‘sMom res
e Save the file. Name it something like 7/ Template

Wl Save 2016 T1/TP1 As ? X
1. NoName
NoName
Client Status: | 2. Work in process v [JLocked
EFILE Status: 1. Noteligible v
SEND Status: | 1. Not Eligible v
TP1 Status: | 1. Noteligible v
T1135 Status: | 1. Noteligible v
DCN: \ |
Invoice: \ | Time: [00:00:00 |

[]Discounted? [JCRAEmors 2139

File Name
[ne\Documents\My ProFile Date\Templates\T1_TEMPLATE 16T| | -
Online Backup Disable:

Conc

Help Advanced >>

e Go to the Options menu and select Module

e Click the Browse button beside the File Template field, search and select the T/ Template file on your
hard drive
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V4 Open X

A || « MyProFileData > Templates v ®/| | Search Templates »
Organize v New folder =~ W O
A Name ° Date modified Type
# Quick access
2017-10-094:10AM  ProFile 2016
B Desktop @ T1_TEMPLATE 1 10AM  ProFile 2016 T1
¥ Downloads
= Pictures
[ iCloud
. Dropbox
2016T1
Autosaved Capti
PendingCapture
Training Guides
& OneDrive
v < >
File name: | T1_TEMPLATE v| [2016ProFile 1 (167 v
Open Cancel
o Click OK
Module Options ? X
B 22016 T1/TP1 v|id 32052017 T2 v | 52016 T3/TPe4s v | [ 22017 P [
File Template
[PocumentsMy ProFile Data\Templates\T1_TEMPLATE.16T | | Browse

General DatalLocking Variance Disclaimer T1/TP1 Review

€ Carry forward files ||  Lenguage
Xl Cany forward slip descriptions @® English
[X] Carny forward donation descriptions OFrench
3] Carry forward free form notes
O Cany forward preparer initials
[ Cany forward partner initials
O Carry forward reviewer initials
Xl Carny forward authorization question
[ Cany forward Elections Canada question
[ Cany forward foreign property question
[ Cany forward files to same location as previous year
[ Camy forward invoice description of services —_—
O Carzfovward T1DD |n10rmat?on "
© RC59 online access default v ance!
< ed Help

e ProFile will use the default settings in this template file whenever you create a new file of the same
type. If you want to share the template with other users on a network, save the template into a shared
server folder.

¢ In Client Explorer, files display by client name or SIN. On a template, both these fields are blank, so,
when you look for your template on the Client Explorer, the template file appears as NoName.

e Select the NoName file in the database client list. Below it, you will see the file name you assigned,
such as T/ Template, in the file details area.

e Open the template when you need to modify the defaults for all your new clients.

HyPERDOCS

It may happen that you’d like to attach or link an electronic document to a tax file. You may, for example, want to
attach a PDF of a CRA document such as a tax ruling or an interpretation bulletin. Or you may want to link to an
image file itemizing details of charitable donations or medical receipts. With ProFile’s HyperDocs, you can do
exactly that. In other words, you can attach multiple documents, in any format, to a form or field of a T1 return.

It’s important to note that any HyperDocs document attached to a tax file will be stored for internal purposes only.
This means that no HyperDocs attachment will ever get transmitted to CRA.



Adding a HyperDocs document
You can choose to attach a HyperDocs to a tax file or to a specific form—or any line on a form—in a tax file.
e To add a new HyperDocs document to the tax file itself, go to File > HyperDocs and click the Add icon

(circled in the image below)
e A window will then open, letting you select the file you wish to add

| HyperDocs ? X
Attach or link documents to this return O [N x]

1. StLaurent Marianne

HyperDoc Size Outof.. DateLinked Date Modified Type  Fom ‘

Comments (for your reference)

i Select Files X
« v 1 @ > OneDrive > v o »
Organize ~  New folder - m

v s Quick access
@ Attachments

m Desktop  #
& Client Docs
& Downloads  #
& Pictures
@ Pictures A
< iCloud *

2016T1
Autosaved Captt

PendingCaptures

T2 Returns
> & OneDrive
= This PC v < >
File name: <| | AllFiles (%) s

e To attach a HyperDocs to a specific field on a client form, right-click on the field and select A¢tach
HyperDocs

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
When you come to a line on the return that applies to you, go to the line number in the guide for more information.
Employment income (box 14 of all T4 sips) 101] [EREF e
Commissions included on line 101 (box 42 of all T4 sips) [102] ojoo | Help Fl
Wage loss replacement contributions. B 14 6
(see lne 101 in the guide) 103 oloo § TR
Other employment income 104 U]
0Oid Age Security pension (box 18 of the T4A(OAS) slip) 113 0] Cut
CPP or QPP benefts (box 20 of the TA(P) slip) 114] o| Copy
Disabilty benefis included on line 114
(box 16 of the T4A(P) siip) [152] oloo § Copy field code
Other pensions and 115] of  Paste
Elected spit-pension amount (attach Form T1032) 116 0 ~
Override F2
Universal Chid Care Benefit (UCCB) 117
UCCB amount designated to a dependant 185 ojoo §f Attach memo F8
Employment insurance and other benefits (box 14 of the T4E siip) [119] 0 Attach tape Ctrl+F8
Taxable amount of dividends (eligible and other than eligible) from taxable Canadian Copy Memo/Tape
corporations (attach Schedule 4) Py P
Taxable amount of dividends other than eigible dividends,
included on line 120, from taxable Canadian corporations [180] oloo § Attach HyperDoc
Interest and other investment income (attach Schedule 4) 121 P — 5
Net partnership income: limited or non-active partners only 122 0
Close form Esc
Registered disabilty savings plan income 125] 0
Print form
Rental income Gross [160) oloo § Net[126 0 New window
Taxable capital gains (attach Schedule 3) 127 0.
Launch window
Support payments received Total[156] oloo § Taxable amount 128 0 Crente X
RRSP income (from all TARSP slips) 129 0 reste
Other income Specify: 130) 0 Create T3
Self-employment income Carry forward
Business income Gross [162] 0]00 Net[135] 0 Py e
Professional ncome Gross[164 0[oo Net[137 0 b
Commission income: Gross|166) 0/00 Net|139) 0 Show auditor Ctrl+F9
Farming income Gross [168] 0]o0 Net[141 0 i
Fishing income Gross|170) 0]o0 Net|143) 0

e After you select the file, ProFile asks whether to embed or link your document
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w4 HyperDocs ? X

(O Embed Document Copy
(® Link Document

e Embedded documents open as read-only and cannot be edited in ProFile

e Linked documents open from the source, so you can edit them directly in ProFile, and your changes
will be saved to the source document on your computer

Managing attached documents via HyperDocs

Whether you add a HyperDocs to the tax file in general or to a specific area of the tax file, you will find all
attached documents in the HyperDocs window. To view all attached documents:

e Goto File > HyperDocs

e All attached documents appear in the HyperDocs window along with any comments that you entered.
The HyperDocs window also lists key information that includes:

e The date the document was attached and/or modified

e The process you chose to attach the file (linked or embedded)

¢ And the form to which the document was attached

4 HyperDocs ? X

Attach or link documents to this return NN X

1. St Laurent, Marianne

HyperDoc Size Outof.. DateLinked Date Modified Type Form

|S]ProFile 2017 License.png 19KB  No 20171217 3:.07:38PM ~ 2017-10138:48.00AM  Embed. T1:10
IE] Uber.png 206KB  No 20171217 3.0214PM 20171117 550:30AM  Embed..  Tax Retun

Comments (for your reference)

Close Help

Removing a HyperDocs document

e Toremove a HyperDocs document, right-click on the document in the HyperDocs window and choose
Remove



vl HyperDocs ? X

Attach or link documents to this retum CH a
1. St Laurent, Marianne
HyperDoc Size Outof.. Date Linked Date Modified Type Form
|S]ProFile 2017 License.png 19KB  No 20171217 3.07:38PM ~ 2017-10138:48:004M  Embed..  T1:101
|S]idBer pna 206KB  No 20171217 3.0214PM  2017-1117550:30AM  Embed..  TaxRetum
Add Ctrl+D
Open embedded Ctrl+0
Open Source Ctrl+U

Synchronize Ly

Remove Ctrl+R

Go To Field

Icons

'  Details
Comments (for

Refresh F5

Close Help

Deleted forms

If you delete a form that had HyperDocs attached to it, the HyperDocs will also be deleted. Deleting a HyperDocs
document will only remove the link or embedded document from ProFile - it will not affect the source file stored
on your computer.

Opening attached documents

From the HyperDocs window, double click on the document. If the document is linked, ProFile opens it from its
source and saves any changes you make directly to the source file stored on your computer. If the document is
embedded, ProFile opens a read-only version.

You can keep HyperDocs documents open while you continue working in ProFile.

Synchronizing out-of-date documents via HyperDocs

If you alter a linked document outside of ProFile, may to synchronize the document so that ProFile has the latest
version of the file.

e Because embedded documents open as read-only, to make changes to an embedded file, you must edit
the source file and synchronize it in ProFile

® You can edit linked documents directly in ProFile, as they open from the source and your changes are
saved to the source file

Any out-of-date, or unsynchronized, documents are displayed in red in the HyperDocs window along with an
exclamation point icon.

e To synchronize an out-of-date file, right click the document and select Synchronize
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w4 HyperDocs

Attach or link documents to this retum

1. St Laurent, Marianne

HypeDoc

|E] ProFile 2017 License.png
%) Profit & Loss.xlsx

|EJ Uber.png

Comments (for your reference)

Size Outof .
19KB  No
9KB Yes
206KB  No

Date Linked

20171217 3.07:38 PM
20171217 3:2411 PM
20171217 3:02:14 PM

Date Modified

2017-10-13 8:48:00 &AM
2017-1216 2.32.05 PM
2017-11-17 5:50:30 AM

Type

Embed..

Linked
Embed

? : X
Form

T1:101
T1:104
Tax Retun

Close Help

e Once ProFile has synchronized the document, the exclamation point will disappear, and any red

lettering will revert to black font

VARIANCE AND SNAPSHOT

Variance is a feature that you use to highlight significant changes on a tax return. Variance lets you experiment
with different scenarios and quickly identify the impact of a change on many key fields. Variance is only
calculated for fields with CRA line numbers. So, not all fields (for example on worksheets) will be included in the
variance comparison. You activate the variance feature by taking a snapshot of the tax return.

To take a snapshot of your current return

e From the Audit menu, select Snapshot/variance and click the New button. This will take a picture of the

current contents of the tax return

e Give the snapshot a name that will remind you of the purpose of the scenario
o Select the Activate this snapshot option to have ProFile compare any changes you make in the file to

this snapshot and click OK

Active: None
Description
None

Preparer

Date

Take snapshot

Description:

i lWhat if scenario

Preparer:

[MDL

Activate this snapshot

Cancel

Delete
Close

Help




e Asyou make changes in the file, you can see the variance analysis on the Variance tab of the Active
Auditor

& Summary ® Wamings @ Notices « Sign-offs X lIssues Overrides Memos ¥ EFILE ¥ T1135 = Online ¢ | *
Variance T1 Line 101: Employment income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%) "~
Variance T1 Line 150: Total income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)

Variance T1 Line 234: Net income before adjustments - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)

Variance T1 Line 236: Net income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)

Variance T1 Line 260: Taxable Income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)

Variance S1 Line 323: Your tuition, education, and textbook amounts - What if scenario: $4,701.10 (increase of $6,806.90 / 144.8%)
Variance S1 Line 335: Unadjusted federal non-refundable tax credits - What if scenario: $18,421.00 (increase of $6,814.08 / 37.0%)

B O O

EFILE: Eligible |Balance/Refund  4,491.47 |GST Credit 32.35 |Combined bal...4,491.47 +

e And you can also view the changes in ‘fly-over’ messages when your cursor is over a yellow variance
field

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
When you come to a line on the return that applies to you, go to the line number in the guide for more information.

income (box 14 of all T4 slips) 101 44_322|OOIi \What if scenario: $18,421.00
c included on line 101 (box 42 of al T4 slips) 102 oloo § of §25,901.00/ 140.6%)

'Wage loss replacement contributions

(see line 101 in the guide) 103 0|00 i

Other employment income [104 m_!
0Id Age Security pension (box 18 of the T4A(OAS) slip) [113] 0[00
CPP or QPP benefits (box 20 of the T4A(P) slip) 11 ojoo |

Disabilty benefits included on line 114

Shelf-life of a snapshot

Snapshots may have a short self-life. For example, you may have created a snapshot last week using a client
RRSP contribution of $5000. This week you may want to evaluate the impact of reducing that contribution to
$3000.

However, if you also added a new T3 slip since taking the first snapshot, variance will detect the impact of both
the T3 and the RRSP contribution change. To best use variance, make sure you carefully manage which data
fields you've changed since taking a snapshot that you want to use for comparison.

Deleting a snapshot
If you change other data in the return, like adding income from a forgotten contract job, you will need to delete

your original snapshot and create a new one, reflecting the extra income, before comparing that scenario to
current data.
e On the Snapshot Variance dialog (go to the Audit menu and select Snapshot/variance, select a snapshot
that you no longer need and click the Delete button to remove that snapshot.

Snapshot / variance for St Laurent, Marianne X
Active What if scenario
Description Preparer Date
None
‘What if scenario MDL 2017-12117
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Previous year variance

ProFile includes several features to help you identify and analyze variances between two tax scenarios. If you
carry forward information from a previous year's return, you can use these variance features to find out how much
a field changed in comparison to the previous year.

To turn on previous year variance:
¢ Go to the Options menu and select Module
Click a module tab, for example, 201671
Click the Variance tab.
Select the Show previous year variance by default checkbox
Click OK

Module Options ? X

W 22016 T1/TP v] 320152017 T2 v | &l 52016 T3/TPe46 v | @ z2017Fx < |*
File Template

[ l Browse

General Datalocking Yariance Disclaimer T1/TP1 Review

Minimum Variance Language
Dollar ($) 500 2 @® English
Percentage = OFrench
Show previous year variance by default
Cancel
Help

When you carry forward a return and there is a difference between the previous and current year amounts, ProFile
highlights the changed fields with an orange background. Move your cursor over the field to see the message
associated with that field.

Variance thresholds

You can set variance thresholds to meet your own requirements. Go to the Options > Module and click the
Variance tab.

Set a minimum dollar value or percentage of change that will trigger a variance calculation. If you set both a
dollar and a percentage amount, ProFile calculates a variance only when the amount differs by more than the
dollar value and the minimum percentage.



Module Options ? X

22016 T1/TP1 v|l320152017 T2 w | & 52016 T3/TPe46 v | [&d 22017 Fx « | »
File Template
[ | Browse

General Datalocking Variance Disclaimer T1/TP1 Review

Minimum Variance Language

Dollar () 10000 = @® English
Percentage (%) 10 L OFrench

[[] Show previous year variance by default

Cancel

Help

T1PAD

Pre-authorized debit (PAD) is a secure, online, self-service payment option for individuals and businesses. This
option lets you set the payment amount you authorize CRA to withdraw from a Canadian chequing account to pay
taxes on a date, or multiple dates.

Due to the processes that must take place between the CRA and the financial institution, the selected payment
date must be at least five business-days from the date your PAD agreement is created or managed.

A PAD agreement can only be done online. Here’s how to do it in ProFile:

e Use Form Explorer to Open T/PAD
e Type Yes to set up PAD
e  Click the Pay in full checkbox
e Ifyou are already set up for Direct Deposit and you want to pay from that account, enter YES.
Otherwise enter NO and enter the bank transit info
\/4 2016 T1/TP1: TaxPayer, Gavin - Pre-Authorized Debits form oo ==

@1info |@2T1| 8374|8573 F6T8s 1.TIPAD | +

| Pre-Authorized Debits (PAD) |

Do you wish to set up Pre-Authorized Debits (PAD) for current year tax owing? Yes

Instructions

* Pre-authorized debit (PAD) is a secure, online, self-service payment option for individuals and businesses. This option lets you set the
payment amount you authorize the Canada Revenue Agency (CRA) to withdraw from your Canadian chequing account to pay your taxes on
a date you choose

* Only Payment on Filing (POF) for the current tax year will be allowed to create PAD agreement through T1 Efilers.

 To Efile PAD-Agreement: Go to the Efile Menu and select "Efile Pre-Authorized Debit for this TaxPayer”

[ First name ] Last name ] Social insurance number
[Gavin B raxPayer | 444 444 442

Total amount owing

7.830)41 i

Complete the banking information area below

Total amount you would like to pay through PAD (single one time payment)

Pay in full 7.830[41 |}

Do you want to use the same banking information entered in T1DD (Direct deposit) form? No
Branch number | Institution | Account number | Payment date ]
(5 digits) (3 digits) (maximum 12 digits) | (YYYY/MM/DD) |
[12334 016 123345554311 | 2017-12-31 |
T1PAD confirmation number. [ ]
Modified EFILE: Not eligible |Balance/Refund 7,830.41 | GST Credit 0.00 |Combined balan...13,803.35 +
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e Next, go to EFILE and select EFILE Pre-Authorized Debit for this Taxpayer
e Once EFILED, ProFile will record the TIPAD confirmation number in the yellow field above, and on
the INFO form as well

EFILE Online Training Window Help
EFILE/ReFILE this return... Ctrl+F11
EFILE Pre-authorized Debit for this taxpayer...
EFILE the T1013 for this taxpayer...
EFILE the T1135...
Build T1 EFILE Online Batch...
EFILE Online Batch
Build TP1 NetFile...
TP1 Connect...
Reports >
Print All ACKs
View Notice of Assessment (ENOA)
Set EFILE Password

Options...




Chapter 8 Quiz

Question 1: A file template is used to:

Ensure that all data is recorded properly

Create returns for various family members

Pre-select the fields and forms ProFile will set up on a new tax return
Verify the accuracy of the tax amounts

cawy

Correct answer is C

Question 2: True or False: A different file template can be set up for each ProFile module

Correct answer is True

Question 3: HyperDocs is designed to:

A. Link or embed an electronic file to a tax return

B. Add audit messages to a tax file

C. Link an amount on a tax return to the relevant information on CRA’s website
D. Create a hyperlink that can be emailed to a client

Correct answer is A

Question 4: True or False: You can use HyperDocs to send documents such as donations receipts to CRA

Correct answer is False

Question 5: True or False: HyperDocs lets you attach a document to either the tax return itself or to a line on the
return

Correct answer is True

Question 6: You synchronize a Hyperdocs file by clicking:

A. On the Synchronize command in the File menu

B. The source document in Windows Explorer

C. On the green Synchronize icon in the HyperDocs window
D. You cannot, in fact, synchronize a HyperDocs file

Correct answer is C
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Question 7: True or False: Once you attach a HyperDocs file to a tax return, you cannot remove it

Correct answer is False

Question 8: True or False: Profile uses a Snapshot to EFILE the tax return to CRA

Correct answer is False

Question 9: Select one reason you would use ProFile’s Variance feature:

To compare the difference between two spouses’ T1 files

To highlight significant changes between the prior and current year’s T1 files
To track the last time you opened a T1 file

To make sure all tax preparers are using the same version of the tax file

cawpy

Correct answer is B

Question 10: CRA’s T1 Pad is used to

Send an electronic payment to CRA

Keep track of all amounts already paid to CRA
Ensure that all client notes are saved in a notepad
Modify a file that you EFILED with CRA

cawpy

Correct answer is A




Appendix A: How to Get Help

Whether it’s online or by telephone, ProFile supports you in a whole bunch of ways. And with a vast selection of
webinars, videos and live training, ProFile’s got your back! The best place to start is from ProFile itself.

In-product Help
In-product “Help” provides an easy way to learn about forms, slips, schedules, ProFile’s functions, and many
other topics. Simply press the <F1> key, or click Help from the Menu bar.

lv4 PROFILE
File Edit Audit Goto Form Options EFILE Online Training Window Help
-3 '7 S H o Q P - - ProFile Help F1 -
What should we build next? .
QuickStart...
Support >

Live Chat

Live Community

Privacy Policy

Suspend Licenses
Configure Flexible Licensing

Manage Licenses

Send Feedback
About

Community and Support Site

The ProFile Community and Support Site has recently undergone a redesign in order to serve our customers more
effectively. You can now search both our support articles and forum questions at the same time, in order to return
the best possible answer to your product question. Available 24-hours a day, our Community and Support Site has
more than 800 articles designed to improve your ProFile experience.

https://profile-en.community.intuit.ca/profile-ca-en

B A @ proFie X 4+ v = [5) X|
&< > 0 a6 B intuitca Y = I e
O piofile B sanin

Browse questions by topic:

Using ProFile Software ProFile Discussion Topics Accountants and Pro Users Online and Mobile Apps

All Questions ~ Answered ~ Unanswered Sort: Latest Activity ~ « Announcements
This is a test

If I'm the only owner and employee of corporation, and if | pay myself L O

the entire corporation's revenue, do | have to pay federal/provincial Live Comunity
corporation tax on my salary? posted 1 month ago
Hello, so say | own a corporation and | am the only owner and employee of that corporation. if
the. View all >
bourget0914 -« 2 answers « last activity 1 day ago
how do | import from QuickBooks online ¥ Browse Tags
Live Chat

Inside the ProFile software (and on many of our support pages) you will find the “Live Chat” feature. This quick
and convenient tool lets you immediately begin speaking to one of our support representatives online, without
having to wait on the phone or interrupt your work. Available during our regular support hours. You can access
the Live Chat feature by selecting the “Live Chat” option under the “Help” menu in ProFile.
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B & @ profileChatSupport X + W

O o tants.intuit.com,

Live Chat - ProFile

Ask a live Support agent your product related
questions and get them answered now by clicking the
button below.

Training and Tutorials Site

Whether you are a new ProFile user or an experienced professional, you can enhance your skills with our training
resources, video tutorials, and “Tips & Tricks” site. Updated regularly, this site includes both core and advanced
information to help throughout the return preparation process.

http://profile.intuit.ca/professional-tax-software/training.jsp

Keep learning with ProFile

your skills with our

tutorials

Training videos & recorded webinars
Core Advanced Webinars

Choose a video categol Search for a particular topic:
gory P

Choose a category 5

Webinars Calendar

Keep learning with our informative webinars, held weekly throughout the year. Live webinars take you through
the finer points of ProFile, and if you have any questions, our experts are there online with you, ready to answer.
You can join an upcoming webinar through our online calendar:

http://profile.intuit.ca/professional-tax-software/webinars-events.jsp




ProFile Webinars & Events

<

ProFile Webinars
& Events

*
Webinars Events
Webinars
DECEMBER 2017 > Month | Lt
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QuICK REFERENCE CHART

Box numbers on common information slips and the related line numbers on the income tax and benefit return.

Slip Type | Box No. | Box Title Line No.
T4 Statement of Remuneration Paid
14 Employment income 101
16 Employee’s Canada Pension Plan contributions 308
17 Employee’s Quebec Pension Plan contributions 308
18 Employee’s employment insurance premiums 312
20 Registered pension plan contributions 207
22 Income tax deducted 437
Employee’s provincial parental insurance plan (PPIP)
55 . . . . 375
premiums (if province of employment is Quebec)
T4A Statement of Pension, Retirement, Annuity, and Other Income
016 Pension or superannuation 115 and 314
018 Lump-sum payments 130
020 Self-employed commissions 166 and 139
022 Income tax deducted 437
028 Other income Various
040 RESP accumulated income payments 130 and 418
042 RESP educational assistance payments 130
TS5 Statement of Investment Income
25 Taxable amount of eligible dividends 120
26 Dividend tax credit for eligible dividends 425
11 Taxable amount of dividends other than eligible dividends 180 and 120
12 Dividend tax credit for dividends other than eligible dividends 425
13 Interest from Canadian sources 121
14 Other income from Canadian sources 121
15 Foreign income 121
T4E Statement of Employment Insurance and Other Benefits
Repayment rate 235 and 422
14 Total benefits paid 119
20 Taxable tuition assistance not entered on
return
22 Income tax deducted 437
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